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Preface

This IBM® Redpaper examines the issue of Domino® Server Consolidation as a way to 
maximize your investment in Domino. 

Starting in the late 1980s, organizations began to invest heavily in distributed computing and 
client/server architectures. One key client/server environment that businesses deployed was 
Lotus® Notes® and Domino, which provided them with a robust messaging and collaboration 
environment. 

Over time, as businesses grew in size, adding staff through expansions, mergers, and 
acquisitions, greater demand was placed on the messaging and collaboration services that 
Domino provided. This equated to adding servers to handle the increased user load, often in 
remote offices so the servers hosting those services would be closer to the user. Domino also 
matured and evolved as a product over the years. New collaboration capabilities were added, 
such as support for Web-enabled mail and applications. Domino services were exposed so 
they could be accessed using other standard Internet protocols, such as LDAP, IMAP, IIOP, 
and Web services. These additional capabilities and services increased resource demands 
on individual Domino servers, often mandating additional hardware to redistribute and 
balance system loads.

In many businesses, these changes led to significant growth in the number of Domino servers 
over time. Servers are like children - they need attention, maintenance, and constant care.

Since the introduction of Domino 7, IBM/Lotus has been highlighting the capabilities of 
Domino to now do more with less - ultimately using Domino 7 more efficiently to better 
leverage existing investment - and ultimately reduce the Total Cost of Ownership (TCO). For 
many companies however, the key issue remains about how and where to begin with a 
consolidation effort, and what are the best practices and specific steps to get started with this 
effort. This Redpaper addresses these questions. 

The overall goal of Domino consolidation is to provide a better Return on Investment (ROI) for 
a business’ environment while maintaining or improving the system’s Quality of Service 
(QoS). Depending on the current condition of a company’s Domino environment, this goal 
might be reached in different ways.

Since there is no “one-size- fits-all” approach to Domino server consolidation, this Redpaper 
examines the issue from a best practices perspective. Specifically, it discusses Domino 
Server Consolidation in terms of the following topics:

� Reasons for consolidation: A detailed look at the benefits one should look for when 
planning or implementing a consolidation project.

� Approaches to consolidation: Examine various models and scenarios and give details 
about the architectural considerations and consolidation methodologies.

� Administration model: Define Domino administration models and give details about how 
those models impact consolidation decisions.

� General approach: Give details about techniques to define and execute and effective 
consolidation project

� Performing Server Consolidation: Step by step examples using a scenario based 
approach
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Chapter 1. Introduction to server 
consolidation

This chapter defines Domino server consolidation at a high level. If also defines the scope of 
this paper, and identifies the audience. The following topics are covered:

� Domino growth over time

� What is consolidation?

� Goals of this Redpaper

� Target audience

1

Note: This Redpaper has a companion Redpaper, Domino 7 Performance Tuning: Best 
Practices to Get the Most Out of Your Domino Infrastructure, REDP-4182, that you may 
wish to read as well. It is available at:

http://www.redbooks.ibm.com/redpieces/abstracts/redp4182.html
© Copyright IBM Corp. 2006. All rights reserved. 1

http://www.redbooks.ibm.com/redpieces/abstracts/redp4182.html


1.1  Domino growth over time

Starting in the late 1980s, organizations began to invest heavily in distributed computing and 
client/server architectures. One key client/server environment that businesses deployed was 
Lotus Notes and Domino, which provided them with a robust messaging and collaboration 
environment. 

Over time, as businesses grew in size, adding staff through expansions, mergers, and 
acquisitions, greater demand was placed on the messaging and collaboration services that 
Domino provided. This equated to adding servers to handle the increased user load, often in 
remote offices so the servers hosting those services would be closer to the user.

Domino also matured and evolved as a product over the years. New collaboration capabilities 
were added, such as support for Web-enabled mail and applications. Domino services were 
exposed so they could be accessed using other standard Internet protocols, such as LDAP, 
IMAP, IIOP, and Web services. These additional capabilities and services increased resource 
demands on individual Domino servers, often mandating additional hardware to redistribute 
and balance system loads.

In many businesses, these changes led to significant growth in the number of Domino servers 
over time. Some key growth factors included:

� Addition of servers to support larger user populations and increased demand for 
collaborative applications

� Integration of servers from other organizations as a result of mergers or acquisitions

� Distribution of servers to multiple locations or data centers to overcome geographic 
client/server networking constraints

� Separation of servers by function to optimized performance, and to reduce the potential for 
user impact

� Servers sized to support application or user loads for various Domino versions on specific 
operating systems

1.1.1  Cost impact of growth

Most companies view their Domino server infrastructure as overhead because it does not 
directly contribute to their financial bottom line, so cost containment is a critical business goal. 
Even for companies who sell Domino-based messaging or collaboration services to third 
parties, managing infrastructure and support costs is still crucial in order to maximize 
potential profits. These costs can include:

� Acquisition and maintenance of diverse hardware platforms and operating systems used 
to host Domino servers

� Additional hardware and network resources needed to route mail and perform replication 
among key system databases (admin4, Domino directory, and so on) among a large 
number of servers

� Supporting administrative expertise in multiple operating systems

� Server licensing and renewal for Domino, operating systems, and supporting products 
across a large number of physical servers

� Staff required to support Domino system administration and operation across a large or 
distributed server install base

� “Hidden costs” related to overall system complexity, and the difficulty for users to find or 
access the information they need
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Server hardware and operating systems technologies have evolved over time, becoming 
much more powerful, and allowing businesses to run larger user and processing loads with 
lower cost per transaction. Although there remain many areas in the world where wide-area 
network infrastructures are relatively weak or expensive, high-speed networking technologies 
have generally made it easier to bridge geographically dispersed locations cost effectively. 
Also, the scalability of Domino has improved over time, allowing a single Domino partition to 
support larger workloads. As a result, there is increasing pressure on Information Technology 
groups to consolidate the business’ Domino resources in order to contain costs.

1.2  What is consolidation?

The term consolidation has different meanings to different people. At a high level, the term 
can be used to denote one or more of the following models:

� Centralization: Moving geographically distributed servers to a central location

� Server consolidation: Replacing a number of smaller servers with a single large server 

� Storage consolidation: Combining data files from several servers to a shared enterprise 
storage medium, such as a Storage Area Network

� Data integration: Taking information from several different sources and merging it into 
single logical repository with a common format. 

� Application consolidation: Combining similar applications from different servers (such as 
Web-enabled Notes applications, or mail applications) onto a single application server

� Workload consolidation: Combining different application workload types on a single server

An overview of these models is shown in Figure 1-1.

Figure 1-1   Types of consolidation

Centralization, server consolidation, and storage consolidation all deal with making changes 
to the physical infrastructure components of a system’s architecture. Data integration, 
application consolidation, and workload consolidation deal with logically restructuring 
components of a system’s architecture.

Centralization

Server consolidation

Storage consolidation

Data Integration

Application consolidation

Workload consolidation

Physical consolidation

Logical consolidation
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1.2.1  Consolidation: a Domino perspective

In most cases, when a business considers a particular consolidation model, they must, as a 
matter of course, consider applying other consolidation models in order to meet their goals. 
For example, if a company wants to centralize Domino servers from several locations across 
a continent, they will likely need to take into account:

� Server consolidation: Installing larger servers in the central data center instead of simply 
moving small servers from the other geographic locations

� Storage consolidation: Providing an shared enterprise data store to simplify management 
of Domino resources 

� Data integration: Collapsing multiple Domino domains into a single domain to simplify mail 
routing and system administration

� Application integration: Co-locating mail or application files from multiple locations to a 
single server or a set of servers

1.3  Goals of this Redpaper

The overall goal of Domino consolidation is to provide a better Return on Investment (ROI) for 
a business’ environment while maintaining or improving the system’s Quality of Service 
(QoS). Depending on the current condition of a company’s Domino environment, this goal 
might be reached in different ways.

For example, a geographically dispersed company based entirely in North America might 
chose a centralization approach, given the relatively low cost of high speed networking. A 
similar company spread across the world might find it cost prohibitive to centralize servers in 
certain regions due to the lack of robust networking infrastructure or the complexity of 
inter-country communications regulations. 

Likewise, a company that had grown by acquisition might have a large number of Domino 
domains and sets of differing organizational certificates. Such a company would likely need to 
focus more on data integration issues when planning and performing their consolidations than 
would a company that had grown through expansion and had maintained a single domain and 
organizational certificate structure during their growth.

Since there is no “one-size- fits-all” approach to Domino server consolidation, we chose to 
examine the issue from a best practices perspective. Specifically, we wanted to look at:

� Reasons for consolidation: A detailed look at the benefits one should look for when 
planning or implementing a consolidation project.

� Approaches to consolidation: Examine various models and scenarios and give details on 
the architectural considerations and consolidation methodologies.

� Administration model: Define Domino administration models and give details on how those 
models impact consolidation decisions.

� General approach: Give details on techniques to define and execute and effective 
consolidation project.

Note: Domino server consolidation usually requires the client to combine more than one of 
the standard consolidation models in order to meet the business’ cost containment goals.
4 Domino 7 Server Consolidation: Best Practices to Get the Most Out of Your Domino Infrastructure



1.4  Target audience

This paper is focused primarily on providing best practices information about consolidation 
planning and techniques, rather that providing deep details on moving from one specific 
environment to another. It was written for professionals fulfilling the following roles:

� Information technology managers

� Consolidation project managers

� Domino system architects

� Domino system administrators
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Chapter 2. Reasons for consolidation

This chapter discusses various justifications for consolidating Domino servers. Examples are 
given of architectural, administrative, and cost benefits. It also compares the business view of 
cost management (ROI and QoS) with the technical view (TCO and SLAs). The following 
topics are covered:

� Advantages of server consolidation

� Common consolidation pitfalls

� Considerations and impacts

� Measuring costs and services

� Serviceability benefits

� Establishing baselines and measuring success

2
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2.1  Advantages of server consolidation

The proliferation of servers in Domino environments over time has led to a cost impact to 
many businesses. However, different businesses interpret those costs in different ways. While 
some want to exclusively focus on managing capital and operating cost, others also view the 
costs from a serviceability perspective. Thus, when businesses choose to execute a server 
consolidation strategy, they may select different measures for success depending on their 
consolidation goals.

Organizations matching the following profile generally make good candidates for server 
consolidation:

� Have a directive to reduce IT costs

� Have no control over their IT costs

� Find that they need to integrate their distributed systems

� Find it hard to retain system administration personnel

� Have server management issues

� Need to reduce staffing costs

� Have backup and recovery problems

� Have had mergers or acquisitions

� Have vital data scattered and unsecured

2.1.1  Domino growth in small businesses

Small businesses often have very limited IT budgets, which leads them to limit the number of 
servers and operational resources they are willing to dedicate to Domino services. Over time, 
many of these businesses may begin to leverage Domino to provide a common platform for 
e-mail and collaborative applications, as well as provide Internet based services to their user 
population or external clients and partners. 

Over time, issues related to Domino usage in small businesses display similar patterns:

� Very few production Domino domains.

� Domino servers located in a single office, sometimes tasked with multiple functions.

� Disparate hardware vendor platforms purchased over time.

� Servers sized to support workload profiles of older versions of Domino.

� Limited performance tuning and workload balancing due to over-tasking of administrator 
resources.

� Inability to manage orphaned or abandoned applications.

� Servers supporting both mail and application environments usually named mixed servers 
where load for each specific usage is difficult to predict. (Application usage and 
interactions with x-users is hard to size.)

Figure 2-1 on page 9 shows the typical Domino growth pattern in small businesses.
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Figure 2-1   Typical Domino growth pattern in small businesses

Small businesses can generally benefit most from consolidation by:

� Reducing the number of physical servers supported

� Standardizing on larger hardware from a single vendor

� Working through the consolidation process to identify and eliminate abandoned or 
redundant applications

� Re-architecting system interfaces and administrative processes to simplify replication, 
mail routing, and user management

2.1.2  Domino growth in large businesses

Large businesses are also cost conscious, but due to their size they are required to define 
complex Domino architectures to meet the need of their businesses. Domino services tend to 
be distributed across multiple sites, and in many cases consist of multiple domains. Domino 
administration tends to be a specialization, but this function also tends to be distributed, not 
only among different sites, but also across different Domino domains and organization 
hierarchies.

Over time, issues related to Domino usage in large businesses also display similar patterns:

� Multiple production Domino domains segregating specific functions, such as:

– Mail

– Notes applications

1990 2000

First enterprise 
e-mail infrastructure
One Domain, few users

Higher complexity
because of:
Building business applications 
on Domino
Extending the Domain due to 
more users
Building multiple administration 
units

Infrastructure growth by:
Enterprise expansion
Extending e-mail within the 
enterprise
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– Web applications

– Application testing and staging

– Internet gateway

– External application services

� Domino servers located in multiple locations, mostly segregated by task or function

� Disparate hardware vendor platforms purchased over time

� Inability to rapidly deploy new versions of or updated to Domino server software

� Differing cost-performance ratios at different locations due to workload imbalance

� Inefficient Domino administration and support due to excessive administrative role 
fragmentation

� Uncontrolled growth of Domino-based collaborative applications

� Difficulty responding to major organizational changes, such as acquisitions or divestitures

Figure 2-2 shows the typical Domino growth pattern in large businesses.

Figure 2-2   Typical Domino growth pattern in large businesses
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Infrastructure growth by
Enterprise expansion
Extending e-mail within
the enterprise

Extension to multiple
Domino domains
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administration
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Separating business units
to subsidiaries 

Today’s infrastructure
Multiple domains with 
separated administration 
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1990 2000
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Large businesses can generally benefit the most from consolidation by:

� Reducing the number of physical servers and the number of sites supported

� Upgrading server platforms to highly scalable systems, for example:

– 32-bit systems to 64-bit systems

– Workgroup server operating systems (such as 32-bit Windows or Linux) to enterprise 
operating systems (such as AIX®, Solaris, OS/400®, and so on)

� Implementing operational management processes for applications to fully control the 
deployment life cycle of application, including removing and archiving expired applications

� Reducing the number of Domino domains (especially mail domains) to simplify mail 
routing, replication, and systems management

� Reducing the fragmentation of administrative functions to allow better consistency and 
faster response to support requests

� Providing more effective system utilization of Domino resources through centralization and 
workload balancing

2.1.3  Reduction or control of IT costs

Controlling IT costs is the main reason most businesses give for consolidating servers. There 
are several dimensions that make up the total IT cost picture:

� Hardware costs: Reducing the number of server, storage devices, peripherals

� Software costs: Lowering software licensing and renewal costs for Domino, operating 
systems, and supporting software

� Support staff: Reducing the number of human resources needed to administer or manage 
the environment, as well as ongoing training costs

� Operational costs: Reducing costs of floor space, power consumption, cooling systems, 
and so on

� “Hidden costs”: Costs associated with inconsistent or incompatible hardware and 
supporting software, system failures, data loss, security exposures, and so on

2.1.4  Improved manageability and availability

Consolidation can help improve overall system control in the following ways:

� Enterprise management: Allow for a consistent tools, facilities, and systems management 
services through integrated operations.

� Continuous operations: Properly consolidated systems can provide businesses the ability 
to provide 27 x 7 access to mail and applications.

� Consistent performance: Systems consolidated onto similar hardware and operating 
system platforms are likely to have similar performance profiles, making it easier to 
perform workload balancing.

� Dependability: Problems related to distributed systems, such as frequency of outages or 
the need for manual intervention by remote support staff, can be reduced with 
consolidated systems.

� Minimize operational constraints: Increasing the number of servers and peripherals at 
multiple locations can strain a business’ ability to find sufficient floor space, power 
connections, and cooling capacity, especially in smaller offices.
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2.1.5  Improved data access and protection

Businesses can protect distributed data resources though consolidation:

� Reduce data duplication and fragmentation: Access problems can be reduced by 
consolidating distributed collaborative applications with similar data, or containing only 
subsets of data due to the application of selective replication formulas.

� Apply enterprise data security: While Domino has a robust application security model, 
consolidating applications, domains, and certification structures can improved overall 
security administration.

� Improve security of physical assets: Reducing the number of data center locations can 
restrict unwanted or unauthorized access to server hardware and help ensure a more 
secure environment.

� Centralized backup, recovery, and integrity management: Consolidating servers and 
storage to allow for the development of effective disaster recovery plans, minimize 
business disruption due to severe data loss, and allow for the effective implementation of 
data retention and management policies to conform with business requirements and 
regulatory bodies.

2.1.6  Leveraging existing investments

Consolidation can help businesses leverage existing investments where excess capacity 
exists:

� Expand existing servers: Add new capabilities to existing installations rather than deploy to 
new dedicated servers.

� Optimize capacity utilization: Since many businesses manage performance and have a 
level of acceptable, consistent response times by typically running servers at 50 to 60 
percent CPU utilization, consolidation can help minimize the number of underutilized 
servers. These underutilized servers are often found in a distributed environment and in 
those environments that use server platforms that cannot perform dynamic resource 
balancing across logical partitions

� Optimize skilled resources: Within distributed environments, Domino administration and 
management is often fragmented, with many remote resources only fulfilling part-time 
Domino support roles. Also, sites may implement different vendor architectures and 
applications, requiring differing skill sets at remote locations. Consolidation to standard 
hardware and software can allow dedicated experts with in-depth training to support the 
environment and manage ongoing systems and architectural changes.

2.1.7  Reduced technical complexity

Client-server systems are usually seen as a three-tiered logical architecture. As implemented, 
Domino architectures tend to become multi-tiers systems over time, with broad networks of 
local servers, replication hubs, and so on. Consolidation can help reduce this technical 
complexity by reducing or eliminating the need for hubs and gateways.
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2.1.8  Scalability and workload growth

Consolidation can help businesses handle scalability and workload growth issues in the 
following ways:

� System scalability: Centralization and server consolidation can make it more cost effective 
to:

– Implement failover solutions

– Provide the ability to manage peak usage without degraded performance

– Provide for upgrade paths while minimizing the impact on operations or users

� Granular upgrades: Consolidation can ease the ability to grow the number of users, 
applications, system service, or data supported without causing major disruptions to the 
production environment.

2.2  Common consolidation pitfalls

During a Domino consolidation project, the teams’ concentration usually remains on project 
tasks. It is possible for them to overlook some of the issues that may come up as part of 
consolidation activities. The following are a few pitfalls:

� Cutting over services from one system to another can lead to inadvertent user impacts, 
such as downtime due to cut over problems, and broken database or Web links that can 
have a significant impact on user and management satisfaction of the consolidation 
process. The consolidation team should develop a communications plan to identify and 
notify parties that could potentially be impacted by a particular cut over, and should 
provide for targeted support for those parties where possible.

� Network downtime and slow response have a huge effect on centralization. The effect 
should be clearly understood and expectations set appropriately. The consolidation team 
has to make sure the network infrastructure can provide the necessary bandwidth for the 
consolidated Domino environment.

� Changing the base operating system may have a significant impact on the behavior of 
custom Domino applications. Applications that access file system resources or call 
external libraries may break due to code that is written with assumptions related to file 
name conventions, operating system case sensitivity, or the names of external libraries on 
the target environment.

� A third-party application that is supported on one operating system and version might not 
be supported in the target environment. Even if the application is supported, there will 
possibly be changes in licensing costs (processor licensing restrictions, required 
upgrades, and so on) The consolidation team should inventory all third-party tools used on 
Domino servers, and develop related budgets, implementation/replacement plans, and 
contingency plans.

� Applications that are migrated from multiple servers to a single server must be compatible, 
and behave the same way in the target environment as they behaved before. It is a good 
idea to work with the software vendors and in-house developers to identify and resolve 
potential compatibility issues.

� A suitable development and test environment should be instituted to allow developers to 
revise and test all applications impacted by the consolidation effort. Rigorous change 
control should be implemented to ensure that any changes to application code are 
regression tested.

� Centralization can have a significant impact on user perception of the operational support 
model. Users who are accustomed to easy access to local support analysts or 
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administrators now have to deal with remote resources. Expectations about the new 
service model should be clearly communicated to the Domino user community.

� Moving servers to a location in a different time zone from that of the users can affect 
system availability and support availability, especially if there is a large separation 
between the location of the server and the location of users (for example, servers in 
Europe with users in East Asia). The operations support model and system maintenance 
policies should be reviewed and updated to ensure the consolidated system will meet the 
users’ service expectations.

� The regulatory requirements of different countries may impact Domino operations as well 
as data access and retention. These regulations are often based on the location of the 
user of the system, not the location of the data center the users are accessing. This may 
lead to confusing or conflicting demands on administrators. Care should be taken to 
identify and mitigate potential regulatory impacts early in the planning of the consolidation 
project.

2.3  Considerations and impacts

When an enterprise decides to consolidate servers, it has to analyze what the expected 
benefits of the operation are and what success factors are involved. The factors that influence 
the choice are:

� Costs to consolidate

� Staffing

� Time to implement

� Future business needs

� Risks and contingencies

2.3.1  Cost to consolidate

The main reason to consolidate is to reduce costs. However, consolation projects will incur 
cost from the time of inception to the time of deployment. Major costs include:

� Hardware costs

Consolidation usually mandates new servers, new storage, and new peripherals. 
Supporting infrastructure, such as network upgrades, may also need be included to 
provide a stable, scalable environment that meets user service expectations.

� Software costs

Software license costs for applications and operating systems are different for different 
systems and different capabilities. These should be understood properly. Software costs 
may initially increase as systems are run in parallel during the consolidation process, and 
then decrease as the process is finished. Consolidation might involve upgrading some of 
the software, which would involve additional costs

� Prototype cost

Depending on the size and complexity of the consolidation, there might be a need to set 
up and test a prototype solution to make sure the solution provides the benefits and 
business value expected of it. This is especially relevant if there are significant changes in 
the base infrastructure, such as moving to different vendor platforms or new operating 
systems.
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� Contractors, consultants, and IT staff

Consolidation usually involves the architecture, design, and implementation of a new 
infrastructure. It also involves a significant amount of analysis, testing, and 
cross-department coordination. Because the IT staff of the organization will be engaged in 
their current jobs, there is often the need for supplementary resources to execute the 
consolidation project. These may be contractors hired temporarily to supplement the IT 
staff, or consultants who may have specialized skills or consolidation expertise that is not 
available within the organization’s IT organization.

� Retention of old environment

While the end goal is to eliminate old or redundant systems, it may be necessary to retain 
and manage the original environment for a period of time as a backup to support the 
business-critical applications in the event anything goes wrong with the consolidation. This 
involves some costs, which need to be factored in to the overall consolidation effort. If the 
consolidation process is properly tested before deployment, this cost may be reduced.

� Disruption costs

Some business may be lost due to disruption of service during consolidation. The 
question, "How long will the business be impacted and to what extent?" needs to be 
answered and the implications understood.

Consolidation involves many changes: new technology, possibly new applications, new 
infrastructure, integrating existing applications, moving data, changing data formats, and 
changing existing applications. Because these changes have costs attached, they should 
be kept to a minimum.

Disruption costs depend on the consolidation solution:

– Centralization: Hardware is not available during the transfer.

– Server consolidation: Business processes can continue to run on the source platform, 
and workload is transferred when testing on the consolidated platform is completed 
and it becomes deployable. The disruption cost is proportional to the migration time.

– Data integration: Disruption cost is proportional to the data migration time.

– Application integration: The best plan is to continue to work on the old platforms until 
the new solution is implemented and fully tested. In this case, disruption costs are 
proportional to the applications' migration time.

2.3.2  Staffing

As stated previously, it may be necessary to augment a business’ IT staff with contractors and 
consultants to complete the consolidation effort. In addition, the roles and responsibilities of 
the IT staff in place will need to be modified to be ready to support the consolidated 
environment. The following are staff considerations:

� Re-tasking

In general, it is best to retain existing staff in administrative and support roles, given their 
institutional knowledge regarding the business and its organization structure and policies. 
However, consolidation projects often lead to a reduction in the number of resources 
needed to support the business’ Domino environment, especially with centralizations. This 
will likely lead to cost savings in the long term. However, if the staff feels that their jobs are 
threatened by the consolidation, they are likely to take pre-emptive action and search for 
another job. 
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To minimize potential impact to user support or consolidation tasks:

– Define the staffing model for the consolidated environment as early in the project as 
possible.

– Identify and select key administration and support resources to be retained upon 
completion of the consolidation.

– Identify those staff whose jobs are most likely to be impacted and determine whether it 
is possible for them to be reassigned to other roles upon completion of the 
consolidation.

– If possible, provide incentives to those impacted by the consolidation if they agree to 
remain until their role in the consolidation process is complete.

– Develop a contingency plan to backfill positions that become vacant prematurely.

� Retraining

There are likely to be significant architectural changes from the original environment to the 
new consolidated environment, such as a changes in hardware or operating system 
environments, or major upgrades to the Domino version. Accordingly, it will be necessary 
to train administrators and support staff in new technologies. The following are some key 
considerations when defining a training plan:

– Moving to a new server operating system is often the most difficult transition for 
administrators to make, and it may take a few months for them to develop sufficient 
competency if they have never been exposed to the platform before.

– Administrators may need to take vendor-specific hardware training to be able to 
intelligently deal with architecture and performance tuning issues in the new 
environment.

– A full-time Domino administrator will likely require little time to adapt to the features and 
functions available in new releases of Domino after completing training. Part-time 
administrators and support staff will likely require more time to come up to speed.

� Hiring new resources

It may be necessary to hire new resources and additional support staff to administer the 
larger, more centralized environment, especially for centralizations where there may not 
be enough skilled resources at the cetralized location to handle the additional 
administrative responsibilities.

� Supporting multiple environments

It is possible that the IT staff may need to support both the original Domino environment 
and the new consolidated environment.

2.3.3  Time to implement

The time it takes to implement a server consolidation solution will depend on the kind of 
consolidation put in place. In addition the to time required to architect, design, and implement 
the consolidation infrastructure, plans need to take into account the amount of time needed to 
cut over servers or facilities to the new system. The following items describe ways to look at 
time-to-implement for various consolidation models:

� Centralization: Implementation time is the time taken to transfer the hardware and get it up 
and running again.

Note: Retraining administrators and support staff is a critical success factor in the 
completion of a consolidation project.
16 Domino 7 Server Consolidation: Best Practices to Get the Most Out of Your Domino Infrastructure



� Server consolidation: The time it takes for setting up the infrastructure, servers, installing 
software, testing the applications, and migrating the applications from the source servers.

� Data integration: The implementation time is the time taken to deploy the solution and 
migrate the data.

� Application integration: The time taken to install the new software in a server, test it, and 
migrate the business processes to the new application.

Although implementation time is important, disruption time is equally important.

2.3.4  Future business needs

When planning consolidation, the future growth of the organization should be an important 
consideration. A consolidation plan should include the ability to scale the infrastructure to 
meet future business goals, and not simply replace the existing environment. Some key 
issues to consider include:

� User growth: Expected change in user population due to company growth, mergers and 
acquisitions, or expanding to currently unserved users 

� Application trends: Expected growth in the number of Domino-based applications or the 
amount of data stored in them

� Future services: Expected need to support access to Domino-based data and services 
from emerging technologies currently on the business’ planning horizon

2.3.5  Risks and contingencies

Server consolidation projects are huge undertakings. As with any project, there are risks 
associated with it. You should prepare risk management and contingency plans to identify 
and deal with these project risks. The following are a few key risks associated with 
consolidation projects:

� Single point of failure

Consolidation is moving workloads from multiple systems to a single system. A failure in 
the consolidated system means all the applications running in that environment fail. 
Although new technology has many features that reduce hardware failure, care must be 
taken to avoid any human errors that might result in the server failure. To meet business 
availability requirements, it may be necessary to design and implement a high-availability 
solution, which might include the following:

– Server redundancy

– Network redundancy

– Domino or Web clustering

� Failures immediately after deployment

Due to human errors and the maturity of the solution, it is possible that there will be 
failures in the first few months of the deployment of a consolidation solution. If required, 
the current environment must be retained as a backup to keep the business running while 
the failures are addressed.

Note: Planning for future business needs should go three to four years into the future. It is 
usually impractical to try to accurately anticipate the business’ IT needs more than four to 
five years out.
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� Time for backup

As the data from many servers are consolidated to a single server or storage systems, 
more data needs to be backed up on a daily basis. If it is not taken care of appropriately 
during deployment, backup time might overlap with the regular operational time of the 
server, which can dramatically affect performance. The capabilities of the backup software 
should be reviewed and tested to determine if the time allocated is sufficient.

2.4  Measuring costs and services

One of the challenges with IT projects is that there is often a disconnect between the 
business and IT regarding how costs and services are measured or communicated. It is 
important for a consolidation team to understand how these measures compare to one 
another. In this section, we will look at the following topics: 

� Return on Investment (ROI) and Total Cost of Ownership (TCO)

� Quality of Service (QoS) and Service Level Agreement (SLA)

� Bridging business and IT metrics

2.4.1  Return on Investment and Total Cost of Ownership

TCO is a key financial measure with the goal of providing IT and business managers with 
estimates of direct and indirect costs on technology investments, such as hardware and 
software leases and purchases. It includes:

� Hardware costs: Lease or purchase, system upgrades, and vendor maintenance

� Software costs: Operating system, application, and user licensing and renewal

� Operational costs: Electricity, cooling, and floorspace

� Networking costs: Bandwidth charges, router/switch ports, cabling, and external access

� System administrators: Hiring, salaries and benefits, and re-training

� Support costs: Backups and offsite storage

TCO is usually calculated over at least a three year period in order to get a full understanding 
of the costs associated with implementing a new system. However, it is often important to 
calculate TCO on shorter cycles (for example, on an annual or semi-annual basis) for budget 
and planning purposes, and for use in calculating ROI.

ROI is a financial benefit analysis used to determine the value to the business of a particular 
investment of capital. It is calculated as a ratio of the amount of value gained or lost from the 
acquisition and use of an asset relative to its base cost. In its simplest form, ROI can be 
calculated as follows:

Note: TCO is an average cost over time. For example, one system may have high initial 
acquisition cost, but low on-going maintenance and support costs over time. It may have 
the same TCO over time as a system with low initial acquisition costs, but high on-going 
maintenance and support costs. 

ROI Value Investment–
Investment

-------------------------------------------------------=
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Elements to consider when determining the business value of the use of a system include:

� User productivity

� Profitability

� Operational efficiency

Figure 2-3 compares ROI and TCO.

Figure 2-3   Comparison of ROI and TCO

2.4.2  Quality of Service and Service Level Agreement

Many business institute SLAs within their IT organizations to define an agreement between 
the administrators of a system and the consumers of that system’s services. SLAs should 
include the following:

� A clear definition of the client’s needs or expectations

� Services to be delivered to meet those needs

� Metrics used to measure the performance of that delivery

� Processes for dealing with problem management and resolution

� Processes for resolving disputes between the service provider and consumer

� Responsibilities and duties of the consumer

� Issues related to security and confidentiality

� Incentives for meeting service levels

� Penalties for not meeting service levels

Note: The difference between TCO and ROI can be summarized as follows: 

� TCO: What does it cost to install and run a system over time?

� ROI: Is it worth the cost to run the system now, and if so, when will it become 
unprofitable?
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Does not provide a means to compare 
IT initiatives against other capital 
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An SLA is usually defined for a specific component or set of related components. For 
example, a Domino mail system may have its own SLA defining the level of services to users, 
which may be completely independent of the SLA defining network availability and bandwidth. 

QoS is a term adapted from the network engineering field. In essence, it looks at service from 
an user’s perspective. Users view technology as a service chain rather than as individual 
components. The following are service chain measures related to QoS:

� Accessibility

� Transaction speed

� Availability

� Connectivity

� System resilience

� Functional alignment

IT is often faced with the disconnect between users’ QoS expectations and component SLAs. 
For example, a Domino system may have an SLA that defines a specific availability high 
target. At the same time, there may be various network SLAs with similar availability targets. It 
is possible for all of the component systems to meet their availability targets, but fail to meet 
users’ QoS expectations due to availability failures occurring at different times for different 
components. From the consumers’ point of view, the failure is with the application they are 
ultimately attempting to access, rather than with chain of supporting components or 
subsystems that make up the business solution they are accessing.

Figure 2-4 compares QoS and SLA.

Figure 2-4   Comparison of QoS and SLA
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2.4.3  Bridging business and IT metrics

Often there is a significant disconnect between the metrics used by the business and IT to 
measure costs and services. In order to resolve these issues, each group needs to make 
efforts to bridge the gap by defining common measurement baselines that map to both the 
business metrics (ROI and QoS) and IT metrics (TCO and SLA).

Business managers should look at the following:

� Identify business requirements with and map to the service chain.

� Define baseline QoS measurements.

� Set and measure project IT ROI.

IT organizations should look at the following:

� Connect component SLAs to meet/exceed service chain QoS baselines.

� Identify and implement cost effective solutions to meet user service requirements.

Figure 2-5 shows the bridging between business and IT metrics.

Figure 2-5   Bridging business and IT metrics

2.4.4  Taking advantage of cost benefits

Here we discuss the advantages of cost benefits.

Lowering administrative overhead
Centralization and domain consolidation can yield tangible administrative cost reductions. 
With centralization, cost savings are realized by reducing the number of resources needed to 
monitor and maintain a large number physical servers. This can include reducing the number 
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of remote administrators needed to support the system, or reducing the licensing costs 
associated with system administration software installed on distributed servers.

With domain consolidation, cost savings are realized by reducing the amount of time spent by 
administrators managing the complexities of multiple logical systems. Simplifying 
administrative tasks, such as system monitoring, user registration and recertification, and 
server task management, can allow a business to reduce the number of administrators 
needed to support the overall enterprise.

Lowering asset maintenance and operational costs
By reducing the number of servers needed to support Domino, businesses can reduce the 
overall costs related to hardware and software maintenance, and can also reduce costs 
associated with running those servers, including:

� Hardware upgrades

� Hardware vendor maintenance agreements

� Licensing and renewals of operating system, Domino, and support software

� Electrical power conditioning, floorspace lease, and cooling systems at multiple locations

Lowering troubleshooting costs
Consolidation can provide the opportunity for businesses to implement and enforce standards 
related to hardware platforms, server operating system, and Domino versions. This can help 
the business lower costs by reducing the:

� Training costs for administrators to maintain skills across multiple platforms

� Productivity costs associated with assembling a large team to work on problems in large 
businesses with distributed support organizations, such as separate Windows and UNIX® 
support teams

2.5  Serviceability benefits

Consolidation can provide certain many serviceability benefits. While these have cost savings 
associated with them related to improvements in efficiencies, they are most directly seen as 
tangible benefits to users and IT staff.

� Reducing complexity

� Enforcing standardization

� Simplifying administration

� Improving performance

� Simplifying systems management

Note: Most administrative staff reductions with consolidation activities are realized by 
eliminating the need for part-time administrators or software at remote sites, or in 
eliminating redundant activities and functions performed by dedicated domain 
administrators.

Note: Centralization can lead to an increase in the costs associated with network 
utilization as more users access Domino services across a business’ WAN instead of 
accessing them locally. It is important to balance these costs increases against cost 
savings in other areas.
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2.5.1  Reducing complexity

Architectural complexity can have a significant impact on an IT organization’s ability to identify 
and respond to problems. As the number of components, remote site, interconnected nodes 
and applications that make up a system increases, if becomes significantly more difficult to 
manage the environment and ensure SLA targets are met. Problems caused by excessive 
complexity include:

� Inability to meet service chain (QoS) targets

� Difficulty identifying root causes of problems

� Extended lead times to resolve issues

� Administration and support failures due to missing, overlapping, or conflicting areas of 
responsibility

� Difficulty applying system updates due to subsystem interdependencies

� Difficulty identifying the potential impact of proposed architectural changes

Figure 2-6 shows an extreme example of architectural complexity.

Figure 2-6   An extreme example of architectural complexity

One of the key goals of consolidation should be to simplify a system’s implementation model. 
In a Domino environment, considerations should include consolidation of:

� Physical servers and partitions

� Domino domains

� Organizational certificate hierarchies

� Common data sources used by Notes/Domino applications
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2.5.2  Enforce standardization

Standardization of environments can become a serious issue as a business’ Domino 
environment grows over time. This is especially true with highly distributed organizations, or 
those that have grown through acquisition and have integrated what were once external data 
centers. Key problems related to a lack of standardization can include:

� Need to support multivendor hardware

� Administrator skills needed in multiple operating systems

� Issues related to third-party product compatibility with different Domino versions

By standardizing on a common platform during the consolidation effort, IT can improve the 
overall serviceability of the environment:

� Infrastructure standards simplify later upgrades to hardware, operating systems, and 
Domino.

� Consistent systems simplify problem determination and resolution processes.

� Analysis of performance data across platforms become more consistent, allowing for 
comparative analysis of workload across Domino systems.

2.5.3  Simplifying administration

Organizations with multiple domains and different certificate structures are unable to fully 
leverage the administrative benefits of Domino across their enterprise for the following 
reasons:

� Since different Domino domains require separate Public Address Books, which become 
the focal point for administration, multiple domains increase the number of touch points for 
administrators to manage users, server, connections, security, and so on.

� Domino’s policy based administration is easiest to manage if based on the organizational 
components of a user or server ID.

Consolidating Domino domains and recertifying users and servers to use a common 
organizational root can greatly reduce the administrator’s workload.

2.5.4  Improving performance

Organizations with a large number of smaller servers, and those with widely distributed 
systems, can have difficulty providing a consistent level of server to users. Also, the greater 
the number and diversity of server platforms in use becomes, the more difficultly 
administrators have determining the root cause of performance problems.

While consolidation by itself does not necessarily provide performance improvements, a 
properly consolidated system can allow for:

� More effective workload balancing

� Simplified system-wide bottleneck analysis and tuning

� Better fault tolerance, reducing mean time between failures

Note: Care should be taken to ensure that consolidation of these resources does not lead 
to such issues as reduced service levels caused by single points of failure.
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� On demand redistribution of infrastructure resources (such as processor and memory) on 
enterprise servers

2.5.5  Simplifying system management

Managing a large, diverse, or distributed infrastructure that supports a business’ Domino 
environment can be an extremely daunting task. System administrators in such environments 
have difficulty:

� Ensuring the integrity of backups on a system-wide basis

� Managing the distribution and application of hardware and software updates

� Managing system availability in remote sites with shared, part-time on-site administrators

� Ensuring all central and remote administration resources share the same base Domino 
administration skill set

Physical consolidation can help simplify management of a business’ Domino environment by:

� Centralizing backup and recovery operations

� Reducing the time and effort associated with implementing system updates

� Reducing the logistical planning and effort required to train remote administrators

2.6  Measuring success

Finally, while we have thoroughly reasoned out the potential benefits for consolidation, the 
issue still remains about how to measure success in a server consolidation effort. Success 
will be defined differently for each organization, but it essential to first establish a proper 
baseline, prior to implementing changes associated with the server consolidation. Keep in 
mind, you will be measuring against baselines in the following areas:

� 2.4.1, “Return on Investment and Total Cost of Ownership” on page 18

� 2.4.2, “Quality of Service and Service Level Agreement” on page 19

� 2.5.1, “Reducing complexity” on page 23

� 2.5.2, “Enforce standardization” on page 24

� 2.5.3, “Simplifying administration” on page 24

� 2.5.4, “Improving performance” on page 24

� 2.5.5, “Simplifying system management” on page 25

2.6.1  Define pre-consolidation baselines

In order to understand the impact of change, and to measure its impact toward a more 
efficient, easily managed infrastructure, we must work from an established baseline of data 
and statistics. 

The importance of historical data
Domino administrators understand the value of gathering statistics regularly to monitor their 
systems’ activity and platform usage. The analysis of server logs and events can be 
particularly useful for identifying and resolving issues that might occur on a daily basis. 
However, in the long run, it is the collection, retention, and analysis of Domino historical 
statistics gathered by the Statistics Collector task that gives Domino administrators the ability 
to identify trends in the behavior and usage of servers in their domain.
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While statistical data is necessary for daily troubleshooting and bottleneck analysis, 
maintaining a collection of long-term statistical data is also critical to validating decisions 
related to performance management, system-wide load balancing, and capacity planning.

Maintaining a collection of historical data can help administrators directly address 
comparative analysis questions, such as:

� What are the performance characteristics of our system under user normals load as 
opposed to heavy load days?

� How have the operational characteristics of our system changed over time?

� What has been the impact of user and application growth on our Domino environment?

� What is the potential impact of adding additional users or applications, assuming a similar 
usage profile?

� Do we have the excess capacity on any given servers to better balance mail users or 
collaborative applications?

� How fast are my servers consuming system resources, such as memory or disk storage, 
and when might we need to consider upgrades?

� What impact have we seen as the result of recent system tuning or upgrades?

By effectively leveraging historical statistical data, administrators can better project when and 
where performance problems might occur, and provide quantitative justification for the 
execution of proactive plans to address potential issues before they become problems visible 
to users and management.

Limits of historical data
Capturing and analyzing long-term statistics can be very beneficial when performing 
performance analysis, capacity planning, and system re-architecture. However, there are 
limits to the viability of historical data.

It is important to remember that any given set of statistics have to be taken within the context 
of the specific system load and configuration that existed at the time that those statistics were 
gathered. Thus, it is critical to maintain a separate, detailed chronology of major system 
changes to be used by the Domino administrator as a part of their overall analysis of the 
statistics.

Creating baselines for infrastructure analysis and performance tuning
From the point of view of infrastructure analysis and performance analysis, historical statistics 
are valuable as baseline information, both for making tuning decisions, and for analyzing the 
results of changes in the infrastructure or tuning events. Having a set of baseline historical 
data provides a Domino administrator with:

� A complete view of the infrastructure’s performance

� The means to compare the benefits of potential tuning with its implementation costs

� A set of quantitative data points against which the results of the tuning event can be 
measured

� A sampling that can be used as the basis for long term trend analysis

Important: Avoid making assumptions when analyzing historical statistics. Make sure you 
know what system changes occurred, and when they occurred, so you can properly 
interpret the statistic.
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Baselines performance data is not a simple snapshot of a system before a tuning event takes 
place. It should:

� Be representative of normal system loads

� Be a sampling for a set period of time (at least one week, preferably more)

� Not include data from periods with unusual events (system failures, high usage volumes, 
and so on)

� Include descriptions of what components or services were running on individual servers

Baseline data is a specific subset of the full collection of historical statistical data, and should 
be saved separately from the full collection. This baseline data can be saved as:

� An archived subset of data in Notes database

� A spreadsheet export from a period of the historical data

A new set of baseline statistics should be saved after the infrastructure has stabilized upon 
the completion of every major tuning change or system upgrade.

2.6.2  Map service targets against actuals

Given that one of the key goals of server consolidation is to improve service targets, it is 
critical to have agreements in place that identify the current Service Level Agreements 
(SLAs), as well as the targeted SLAs going forward. The SLA defines an agreement between 
the administrators of a system and the consumers of that system’s services. Please refer to 
2.4.2, “Quality of Service and Service Level Agreement” on page 19 to review what is covered 
in an SLA and Quality of Service Agreement. 

As the server consolidation is implemented, review actual statistics and metrics regularly to 
monitor any changes and to track progress toward the against improved targets. 

2.6.3  Perform user satisfaction surveys

Finally, solicit user feedback with structured user satisfaction surveys to monitor user 
perception and, if necessary, address any unexpected side effects of the server consolidation 
effort. 

Note: For additional information about establishing baselines and managing historical 
data, please refer to the Redpaper Domino 7 Performance Tuning, REDP-4182 at:

http://www.redbooks.ibm.com/redpieces/abstracts/redp4182.html
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Chapter 3. Approaches to consolidation

This chapter focuses on finding the right approach for Domino infrastructure consolidation as 
well as covering important dependencies to consider when starting consolidation planning. 

Within the following pages, we begin by describing a generic Lotus Domino architecture 
topology, concentrating on both the fundamental infrastructural building blocks, as well as 
non-technical factors influencing this infrastructure.

Based on this model, we will cover four different approaches and techniques for consolidation 
and outline technical and organizational issues and impacts to consider. By transforming the 
most applicable techniques and models to your current Lotus Domino infrastructure, this will 
help you define the right focus and scope for your individual consolidation purposes, knowing 
the most important things to consider.

This chapter covers the following topics, all aimed at helping you identify the most applicable 
consolidation approach to your organization’s specific needs:

� We begin by presenting a generic Lotus Domino architecture topology to use as a basis to 
step into different consolidation techniques.

� Building upon a generic foundation, we highlight different approaches for Domino server 
consolidation.

� Finally, we provide specific tips and techniques for Domino domain consolidation.

Ultimately, the goal is to enable you to tailor each consolidation approach to best meet your 
organizations’ needs, without losing focus on business and delivery related influences and 
dependencies.

3
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3.1  Domino architecture topologies

As already mentioned in the introduction of this Redpaper, your current Lotus Domino 
infrastructure most likely performs vital business functionality, both in terms of hosting 
technical implementations, as well as providing services based upon your business 
requirements. It also most likely represents a topology that has grown and expanded over 
time, and through various new business demands. 

Figure 3-1 shows a basic framework of such an infrastructure. We will use this framework to 
step into different consolidation approaches. 

Figure 3-1   Generic Lotus Domino architecture and component model as framework for consolidation approaches

� First (reading from bottom to top), it shows your infrastructure based upon a foundation of 
one or more locations (data centers) having an enterprise data network and hosting a 
number of servers with various operating systems (represented by Marker # 1).

� Your Domino infrastructure rests on this foundation providing e-mail, workflow, or other 
Domino related services on the application level, some as dedicated servers for e-mail or 
applications, some as mixed ones. These Domino servers are interacting within one or 
more Domino Domains, partly overlapping different sites, organizational units, or even 
across countries (represented by Marker # 2).

Important: This diagram (Figure 3-1) is fundamental to the discussion in this chapter. 
Specific consolidation approaches relate back to this, so it is worth understanding it. 
Throughout the chapter, we refer to specific blocks contained in this diagram as “building 
blocks”. 
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� There are different tools required to manage this environment, for example, user 
administration, backup and recovery, or virus scanning (represented by Marker # 3).

� Finally, the top layer of the Domino Infrastructure represents users accessing this 
infrastructure via Lotus Notes client or an Internet browser (represented by Marker # 4).

The technical Lotus Domino Infrastructure is also influenced by non-technical items divided 
into business related drivers and influencing factors (see Figure 3-2). These include:

� Company’s business drivers and strategies, as well as special requirements to the 
messaging and collaboration infrastructure, like performance and availability

� Legal aspects or other external influences

Figure 3-2   Business related building blocks

Finally, delivery related areas also having an influence (see Figure 3-3) include:

� Enterprise or department specific standards, policies, and guidelines, such as security, 
compliance and Business Contingency Planning (BCP)

� Support and administration models

� Service level agreements (SLA) to be fulfilled

Figure 3-3   Delivery related building blocks

All those building blocks, technical and non-technical, may be in or out of scope of your 
consolidation project. But even if they are out of scope, they may have an impact on your 
consolidation project. 

While your current infrastructure may look more or less complex, we can use this conceptual 
illustration (Figure 3-1 on page 30) particularly the building blocks shown in the diagram - to 
focus on different types and techniques of server and domain consolidation. 

In the next sections, we will outline different approaches, things to cover, and limitations to 
incorporate in your planning. As stated at the beginning of this Redpaper, server and domain 
consolidation does not only mean to put more users on one machine to reduce redundancies. 
It is also an overall process to centralize services across locations, geographic borders, or 

Important: When speaking of consolidation, these non-technical items must be 
considered in your planning, design, and project execution phases. They will have a direct 
impact in the feasibility and success of any consolidation activity.
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domains. Regardless of the scope, all consolidation approaches will have an impact on your 
Lotus Domino architecture.

3.1.1  Consolidation models presented in this chapter 

Building from the basic conceptual Domino infrastructure highlighted in Figure 3-1 on 
page 30, this chapter describes both Server Consolidation approaches and Domain 
Consolidation approaches. The approach is not to cover each permutation exhaustively, but 
to outline four basic approaches and bring out the key issues. From this, readers and 
administrators can map these approaches to their infrastructure and extrapolate the proper 
approach. 

Server Consolidation approaches include:

� “Approach 1 - Consolidating servers within one location” on page 32

� “Approach 2 - Consolidating servers across two or more locations” on page 39

Domain Consolidation approaches include:

� “Approach 3 - Domain consolidation by consolidating servers across domains” on page 44

� “Approach 4 - Consolidating Domino domains by moving whole servers” on page 49

3.2  Server consolidation models and techniques

By using the following models, we will make examples of the different server consolidation 
techniques. For those building blocks that are relevant in these models, we will outline 
important steps to perform or issues to consider.

The approaches to consolidation are divided into two key approaches:

� Consolidating servers within one location

� Consolidating servers across two or more locations

Consolidation approaches having an impact on more than one domain are covered in 3.3, 
“Domino domain consolidation models and techniques” on page 43. 

Depending on your consolidation targets, you may merge the different approaches and 
techniques according to your requirements. 

3.2.1  Approach 1 - Consolidating servers within one location

Based on the background covered in Chapter 2, “Reasons for consolidation” on page 7, you 
may have identified several potential opportunities to consolidate your Lotus Domino servers 
within one Domino domain and locate these servers in the same location. 

Key point: Server and domain consolidation means more than simply putting more users 
on one machine to reduce redundancies. Server and Domain consolidation is also an 
overall process to centralize services across locations, geographic borders, or domains.

Attention: The definition for consolidating servers within one location is as follows: 

Reducing the number of server instances that exist within a single Domino Domain, 
assuming all servers are already within a single location (site).
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This particular technique touches only a couple of our building blocks (see 3.1, “Domino 
architecture topologies” on page 30). Nevertheless, there are a side effects to consider. 

We will outline these with the help of the architectural model shown in Figure 3-4.

Figure 3-4   Scope of server consolidation within one location and one Lotus Domino domain

Impacts on hosting site and asset management
Based on the fact that we focus on machines hosted in the same location, there are only 
minor impacts on your site related to asset management when consolidating several servers 
on new hardware. Required footprints, network, and other resources have to be available 
during consolidation phases. Once the original machines are decommissioned, there might 
be more resources available.

Impacts on enterprise network infrastructure
Your server consolidation may require changes in special network segments when 
concentrating the network load on fewer machines.

You can find recommendations to tune your Lotus Domino network performance in the IBM 
Redpaper Domino 7 Performance Tuning - Best Practices, REDP-4182.
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Impacts on system hardware and Lotus Domino servers
In general, there are two appropriate ways to consolidate Domino Servers, regardless if they 
are clustered or not:

1. Lotus Domino Server consolidation by moving data (user mail files and application 
databases) from multiple machines to other existing machines because of released 
system resources, for example, after upgrading to Lotus Domino R7 (see Figure 3-5).

Figure 3-5   Consolidating servers to one existing machine

2. Lotus Domino Server consolidation by moving data from multiple machines to one, newly 
built, big sized machine (see Figure 3-6).

Figure 3-6   Consolidating servers to one new machine

Each consolidation technique has its pros and cons and depends on your explicit 
requirements, preconditions, and best-suited environment. We will outline advantages and 
limitations to take into account for each technique.
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Server consolidation by moving data to already existing machines
When moving Domino applications or user mail files from one or several machines to one 
already existing machine within your domain, you have to note the following considerations:

� Is the target machine able to cover the additional load and already has the appropriate 
sizing in the areas of:

– Network traffic

– CPU and Memory load

– Storage

– Backup facilities

� Are the machine’s maintenance time slots long enough to perform all the required tasks, 
such as backup, compact, or fixup, even after putting additional load on them?

� If a huge amount of data is being moved onto existing machines, verify that the Domino 
backup solution will still cope with the load.

� The Domino transaction logging solution and the effects of additional server load on the 
logging and the backups of the logs.

� If you perform cross operating system platform migration of Domino data, are there any 
application specific requirements to take into account, for example:

– Operating system related program libraries

– Hardcoded server names, links, directory paths, and so on

� How to include the target machine into a special monitoring during migration to react 
quickly on sizing or other issues.

The consolidation of servers to already available machines suggests a couple of advantages:

� No additional cost for new machines, even not during the consolidation phase.

� Consolidation activities take place on already running machines; therefore, there is no 
additional hardware to build, configure, and operate during the migration phase.

� No additional Domino server installation, configuration, and maintenance is required.

Server consolidation by moving data to a newly built machine
Consolidating your servers to one newly built machine adds a lot of flexibility to your 
consolidation approach. But there are also a lot of things to cover when choosing this 
approach:

� Do you have enough resources to cover this additional machine, for example:

– Data center footprint (physical space requirements/accommodations)

– Administration staff

– Network, storage (for example, SAN, if applied), and backup availability

� Include shipping and installation lead time for new hardware in your schedule

� Sizing your new system according to your requirements

� Choosing the right operating system platform for the new machine by considering:

– Available skills for administration and maintenance

– Lotus Domino R7 operating system requirements

– Domino applications and system tools platform requirements
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Advantages when migrating to a new machine:

� More flexibility on system and platform scaling

� More consolidation capacity due to scaling flexibility

� Better performance improvements due to new hardware with newer technology

� Less dependencies on other productive systems during the project’s lifetime

You may find the Lotus Domino hardware requirements specifications in the Domino 7 
release notes at:

http://www.lotus.com/ldd/doc/uafiles.nsf/docs/relnote70/$File/readme.pdf

and information about Lotus Domino 7 performance on different platforms in this 
developerWorks® article:

http://www.ibm.com/developerworks/lotus/library/domino7-enterprise-performance

User impact during server consolidation
Moving user mail files, applications, or other databases between servers will certainly impact 
your Lotus Notes users. To keep this impact to a minimum, you should consider the following 
aspects:

� For user mail-file database moves

There is an available administration process called Move mail file for moving mail files 
between servers within one Domino domain. Details of this process can be found in your 
Lotus Domino Administrator 7 Help.

You may find also instructions about moving mail file archives, mail files for roaming users, 
or for shared mail installations in your Lotus Domino Administrator 7 Help.

If you prefer to move mail files manually, please consider the following:

– Unless recommended otherwise, encrypted mail files (server replicas) need to be 
unencrypted. As an administrator, by default you cannot compare the document count 
between the source and target server and you also cannot change the ACL (unless you 
can do this via Full Administration rights, but even then, this is dependant on the level 
of encryption on the mail file).

– Validate the connection documents and ACL adjustments (access for new server, 
change of administration server, and so on) when creating replicas on the target 
server.

– Verify that the mail files do not have replication disabled.

– Check the selective replication settings on the source mail files as there are:

• Partial document replication (change to full documents).

• Deletions replication should be enabled to assure a match between source and 
target mail files.

– Check if quotas are enabled on the mail file and its status. Being over quota may badly 
affect successful replication in clustered (target) environments and can also affect 
standard one to one replication. Disable quotas during migration and re-enable them 
after a successful migration.

– Verify if mail files have mail forwarding enabled. It may be that certain mail files do not 
need to be migrated. If mail forwarding is required, it may affect the sequence of 
migrations. You will not impact the same user more than once if the migration of the 
forwarding mail file and the mail file forwarded to will be migrated at the same time.

– Ensure that scheduled replication is working between the source and target servers.
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– Change the user’s personal record in Server Names & Address Book to point to the 
new mail server to enable mail routing via the target machine.

– Change the user’s Lotus Notes client location settings to new mail server and ensure 
that user has access to the new server. Remember that there maybe be more than one 
location document pointing to the original server.

– Change the user replication settings to replicate local replicas with the target server (if 
you are using a local replica).

– Remove the source server icon on the user’s workspace (if you are not using a local 
replica).

– Add a target server icon on the user’s workspace (if you are not using a local replica).

– If the user has an Out of Office agent, or other agents running, check whether you 
should keep the original replica until the user is back or resign the agent with a generic 
ID on the target server.

– Create any cluster replicas on cluster servers (and enable them in the clusync.nsf 
database).

– Set Quotas on the target server to match the source server (after migration is 
complete).

– Exchange Unread Marks so that the source and target servers are identical.

� For Domino applications and other databases

There are also instructions included in your Lotus Domino Administrator 7 Help that 
support moves of application databases. You may find different approaches using the 
administration process or by using the description of manual steps under the keyword 
Moving Databases. 
If you prefer to move databases manually, please consider the following:

– Check whether the number of replicas can be reduced during consolidation.

– Ensure connection documents and ACL adjustments (access for new server, change of 
administration server, and so on) when creating replicas on the target server. Check 
whether replicas of databases already exist.

– Check the agents that are required to run within each application and validate their 
signatures and settings, for example:

• To reassign agents on the target server with the appropriate ID

• For applications originally deployed in previous versions of Domino, the default 
agent settings would have been different.

• Agents may have been assigned to run on a specific server instead of any server or 
agents may have been set to run on a specific server to prevent it from running on 
multiple servers and therefore creating replication/save conflicts.

– Disable replication and replace the source replica with a database (using the same 
path and file name) linked to the target server replica, including a script to update the 
user’s bookmarks.

– If an application uses Readers/Authors fields and users have local replicas, the 
migration process will not match documents between the source and target servers 
(until all users have replicated with the target server). This means that you will have to 
communicate with the users on how to do this task.

– Due to Readers fields, it may be that the target server cannot see all the documents.

– Update any mail-in documents to point to target server.
Chapter 3. Approaches to consolidation 37



– Create any cluster replicas on cluster servers (and enable them in the clusync.nsf 
database).

– Check that the ACL groups are available in the target domain (if the move is 
cross-domain, see 3.3.1, “Approach 3 - Domain consolidation by consolidating servers 
across domains” on page 44).

– Change the user replication settings to replicate local replicas with the target server.

– Check for any profile documents or lookup documents in the database to be updated 
after migration.

– Check whether any third-party software changes need to be implemented at same time 
as migration, for example, LEI, DB2®, ConnectDirect, and so on.

– Verify if the database developers need any migration agents run at migration time

– Exchange Unread Marks to verify that source and target servers are identical.

– Assess any Full Text Indexes on the source server to create them on the target server 
after migration.

– Set Quotas on the target server to match the source server.

– Ensure that workspace/bookmarks are updated correctly to point to the target server to 
prevent users losing access to databases.

– Consider updating catalog.nsf after the migrations to automatically point users to the 
new database location without needing to use workspace/bookmark updates.

– Ensure that your Change Management system includes making your Help Desk aware 
of the source and target locations of all databases and when they are migrated.

– Investigate whether applications can be migrated during the day / evening / weekend. 
Centralizing into a few sites may mean you are also centralizing across time zones.

– Update the Rooms and Resource databases, if appropriate.

More details for consolidating applications are available in Chapter 5, “Project planning 
overview for performing server consolidation” on page 101.

Impacts on delivery building blocks
The act of consolidating your servers means that you will need to perform changes in your 
production environment. Accordingly, any unforeseen event or problem may directly impact 
your ability to conduct business. To mitigate any business impacts, proper change 
management is mandatory.

Change management activities include:

� Change scheduling aligned to business hours and availability needs

� Risk management and risk mitigation

� Approval processes

� Documentation of changes

� Change review and verification
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We will cover these aspects in Chapter 5, “Project planning overview for performing server 
consolidation” on page 101.

3.2.2  Approach 2 - Consolidating servers across two or more locations

In addition to any geographically centralization of machines by only moving hardware 
between data centers without impacting the Domino infrastructure, there are techniques to 
consolidate Lotus Domino servers across locations. 

Important: Minimizing your number of servers by consolidation and increasing the number 
of users or applications hosted on one machine automatically increases the business 
impact during any downtime of this machine during future operations.

Therefore, it is important to include the following activities in your consolidation project 
schedule to prepare any infrastructure and processes around these topics:

� Business Contingency Planning (BCP)

� Service Level Agreements (SLA) considerations

� Backup and Recovery planning

� Domino clustering

Attention: The definition for consolidating servers across two or more location is as 
follows:

Reducing the number of physical servers or server instances that exist within a single 
Domino Domain, which are placed across multiple locations.

Note: This section covers items to take into consideration for cross location server 
consolidation. The items discussed in 3.2.1, “Approach 1 - Consolidating servers within 
one location” on page 32 must also be observed.
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Figure 3-7 shows the scope of server consolidation across two or more locations.

Figure 3-7   Scope of server consolidation across two or more locations

Impacts on hosting site and asset management
Consolidating Lotus Domino servers across locations impacts, of course, the hosting sites 
affected by this approach. If the consolidation is aligned with adding additional resources at 
the target site, the required footprints and data center related resources have to be available.

The factors for this approach include not only the reduction of Domino instances (easier 
administration) and standardization of your infrastructure, but also the desire to minimize your 
TCO on the following items:

� Real estate operations

� Full-time-equivalent (FTE) costs 

– Facility management

– Security personnel

– Data center maintenance

– Server operating

– Domino operating

� IT Infrastructure costs

– Network infrastructure and back end

– Backup and storage systems 

– Uninterruptable power supply (UPS) facilities

– Cooling systems
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Impacts on enterprise network infrastructure
Any Lotus Domino server consolidation is heavily dependent on your enterprise network’s 
capacities. By moving Domino databases like mail files or applications away from the user, 
your Wide Area Network (WAN) must handle this additional load as well as your network 
architecture to provide the required availability and stability.

By using Domino related functionalities and strategies, you may support your network 
infrastructure to handle these consolidation impacts. Possible options are:

� Domino network compression.

Valuable if no other network compression is in place, for example, on Microsoft's Remote 
Access Service (RAS) on WANs, which includes built-in compression. If point to point 
communications in the WAN is Domino to Domino traffic only (NRPC), then Domino 
compression should be used, as it is more effective than standard network compression.

Information how to enable Lotus Domino Network compression can be found in the Lotus 
Domino Administrator 7 Help.

� Enforcing users to work in replication mode, using local mail files on their client machines.

By providing local replicas of mail files and selective applications on users’ client 
machines, this helps to significantly reduce bandwidth load instead of working directly on 
the server.

� Consider the usage of a hub or hubs to handle the mail routing and replication between 
sites.

To limit the impact on the network, in a multi site setup, the usage of a hub to handle the 
mail routing and replication between sites is recommended. In this way, you can control 
how much load you are adding to the network (as opposed to a mesh topology, where 
every server can add load to the network when routing mail or replicating).

However, today’s global network capacities and availability of broadband services offers new 
opportunities for server consolidation, which are mostly less expensive than operating 
multiple delivery sites.

Impacts on system hardware and domino servers
From a server perspective, there are mostly the same aspects to consider as in 3.2.1, 
“Approach 1 - Consolidating servers within one location” on page 32 regarding impacts on 
system hardware and Domino servers. 

Note: In the case of following larger site consolidation approaches, these activities should 
be tracked in a separate project.
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Again, you may consolidate by moving databases to an already existing machine in your 
target location or consolidating on a newly built server (see Figure 3-8).

When consolidating your mail files, application databases, and so on, you must ensure that 
users are still able to access them after migration, especially when the target servers are in a 
new location. 

Figure 3-8   Server consolidation methods across two or more locations

User impact during server consolidation
In addition to the recommendations regarding user impact in 3.2.1, “Approach 1 - 
Consolidating servers within one location” on page 32, your users may have some concerns 
about performance losses and connectivity issues after a location change.

Depending on your network infrastructure, running connectivity tests with the users may help 
determine whether additional network routes, Lotus Notes connection documents, or similar 
items are required.

Impacts on delivery building blocks
Because there are impacts to your delivery site when consolidating servers across two or 
more locations, there is a potential impact to your delivery organization regarding support and 
the administration model, as well as the service levels you are required to meet.

If you are centralizing your support and administration, you also need to consider the effect of 
time zones on the SLA and core support hours. If you are supporting servers and users 
across multiple time zones, the SLA may force the centralized support teams to work different 
hours than what they were normally do.

By having several Domino administration teams throughout the locations, the server 
consolidation will create redundancies that have to be managed. On the other hand, your 
target location administration staff may have additional workload come out of the 
consolidation. 

The effects on your administration model are covered in Chapter 4, “Administration models” 
on page 53.
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Your service level agreements must be adapted and revised due to new prerequisites and 
higher dependencies on fewer machines.

Impacts on business related entities
Before consolidating a server across locations, some business related issues must be 
covered. 

� Are there any business drivers and strategies that require local availability of Domino 
servers because of:

– Special availability requirements that may be affected

– Business critical information that require dedicated hosting

– Needs of local support and administration (see Chapter 4, “Administration models” on 
page 53)

� Are there any legal guidelines or licensing requirements and orders that force local hosting 
or administration of data and services, such as:

– Particular export regulations (for example, in US export regulations)

– Particular financial laws (for example, in Japan, Switzerland, or Luxembourg)

– Specific security regulations (like the Italian data security act that forces all people that 
have access to Italian data, wherever it is stored, to change their passwords every 90 
days)

3.3  Domino domain consolidation models and techniques

Domino domain consolidation not only offers you TCO reduction by minimizing the number of 
servers to operate, it also minimizes the administration effort that is required to maintain a 
complete Domino domain. 

There are two key approaches to consolidate Domino domains:

� Domain consolidation by consolidating servers across domains

� Consolidating Domino domains by moving whole servers

Depending on your consolidation targets, you may again merge the different approaches and 
techniques according to your requirements.

Consolidating Lotus Domino domains requires a detailed planning and design phase. These 
methods seem to be the most complex, but give the most consolidation and technical 
benefits.
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If we take a look at our architecture and component model (Figure 3-9), we will recognize that 
all building blocks are affected by these consolidation approaches. By consolidating Domino 
domains, your complete e-mail and collaboration infrastructure and delivery will be affected. 
The next sections will figure out what kind of effect this may be.

Figure 3-9   Consolidating servers across two or more Domino domains

3.3.1  Approach 3 - Domain consolidation by consolidating servers across 
domains

As in 3.2.1, “Approach 1 - Consolidating servers within one location” on page 32, there are 
two ways to consolidate servers and domains at the same time. 

1. You can do Lotus Domino server and domain consolidation by moving data (users, mail 
files, and application databases) from multiple machines to other existing machines 
located in other, already existing Domino domains (see Figure 3-10 on page 45).

2. You can do Lotus Domino server and domain consolidation by moving data from multiple 
machines to fewer, newly installed machines within a newly created consolidation domain 
(see Figure 3-11 on page 45).
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Attention: The definition for consolidating Domino domains by consolidating servers 
across domains is as follows: 

Reducing the number of physical servers or server instances that exist in multiple Domino 
domains by reducing the number of Domino domains at the same time.
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Figure 3-10   Server and domain consolidation by moving data to existing domains and servers

Figure 3-11   Server and domain consolidation by moving data into a new domain with new servers

Impacts on hosting site, asset management, and enterprise network
infrastructure
The impacts on hosting sites, asset management, and network infrastructure caused by 
consolidating servers across domains depends mostly on if you consolidate across locations. 
In the case where you are building a new domain with new servers, you have to add additional 
resources into your delivery site.

See 3.2, “Server consolidation models and techniques” on page 32 for more information. 

Databases on Server C

Domino Domain B

Databases on Server B

Databases on Server A

C1 C2A1 A2

B1 B2

B1 B2

Domino Domain A

A1 A2

B1 B2

C1 C2

Databases on Server C

Domino Domain B

Databases on Server A

C1 C2A1 A2

Databases on Server B

B1 B2

Domino Domain A

Databases on Server D

Domino Domain C
Chapter 3. Approaches to consolidation 45



Impacts on system hardware and Domino servers
Beside checking available resources on your target machines when moving data to already 
existing machines across domains or sizing new hardware to be built in a new domain, there 
are a couple of things to consider.

Due to a cross domain move of your mail users, applications, and other databases, you must 
ensure that any accessibility, serviceability, and manageability is still possible. For example:

� Domino directory related

– Server access due to different certification hierarchies in target domain

– Tighter security restrictions, like public key checking or other policies

– Missing cross-certifications and certifier documents

– Mail routing issues due to changing domain names

– Access and mail groups requirements for mail, administration, and application access

– Required connection documents and replication schedule

– Domain documents

– Directory assistance and external address books

– Cluster settings

– Client related additional fields in Domino directory

� Domino directory synchronization

Extended directory catalogs and directory catalogs can be negatively affected during 
migration and transformation activities. This in turn may have a performance impact on the 
production services, as re-indexing of large directories is very CPU intensive. Careful 
planning is required to avoid duplication during transition activities.

� User administration

– Creation, change, and deletion processes of person records and ID files

– Processes and tools for user mail file and application database handling

� User mail service requirements

– Emergency/user help desk access control

– Template handling

– Signing policies

– Quota standards

– Out of Office continuation

– Web mail, DWA, and so on

– Mobile devices access and replication

– Delegation access during and after migration into a new domain

– Rooms and resources migration

– Server to server access during a migration period to ensure cross-domain free time 
lookup

� Application requirements

– Backup

– Agent runtimes

– Web access and DNA aliases
46 Domino 7 Server Consolidation: Best Practices to Get the Most Out of Your Domino Infrastructure



– Load balancing

– Hardcoded values, server and domain names, and specific platform requirements

Impacts on Domino domain model
When starting domain consolidation projects, you should be aware of your currently 
maintained domains as well as be aware of each domain’s role within your enterprise 
infrastructure. 

Domain consolidation by moving data to existing domains and servers
Consolidating Domino domains by migrating users and application into already existing 
domains has an impact on your replication, mail routing, and connectivity topology, as shown 
in “Impacts on system hardware and Domino servers” on page 46.

Be aware of other domains connecting to your domain, which is a focus of decommission, 
such as pass-through domains, SMTP routing related domains, or dedicated replication 
domains to mitigate risks.

Domain consolidation by moving data into a new domain with new servers
In an infrastructure with multiple domains, grown in the past due to business expansion or 
based on former user restrictions within Domino, there may be a big value in consolidating 
your domains in one new domain built from scratch.

Consolidating servers on new machines with the latest technology and joining them to an 
untouched domain will probably result in the most benefits of consolidation. Lotus Domino 7 
and former releases have a couple of new features that are simple to implement when 
starting from the beginning than including them into existing infrastructures. You may migrate 
your users and applications bit by bit into this infrastructure.

Benefits of this approach:

� Taking advantage of a enterprise wide, transparent Lotus Domino policy and Execution 
Control List (ECL) implementation to improve serviceability, standardization, and security

� Replacing obsolete certification hierarchies by calculating new organizational certifiers 
based on the latest technology, for example, 128-bit keys or using Certificate Authority 
(CA) processes

� Replace former design customizations that are outdated to minimize development costs

� Redesign complex architectures and topologies

� Replace or improve inefficient processes impacting your enterprise’s infrastructure 
maintenance

Impacts on Domino infrastructure tools
Each Domino domain within your infrastructure may have several maintenance or security 
related tools running. These may be, for example:

� Tools for user administration

� Tools for database administration

� Monitoring tools

� Reporting collectors

� Virus scanning tools

� Mail retention solutions

� Disclaimer functionalities
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� Application or business specific tools

You must assess which tools are required in the target domain or how these services are 
covered in the future. Additionally, you should assess which costs may occur when migrating 
or adapting dedicated tools into the target environment to strike the right path.

User impact during server consolidation
Moving a user’s mail files or applications between domains must happen in co-operation with 
your users. Changing mail routes and moving person records between domains impacts 
Internet e-mail availability during the migration. To update local Lotus Notes client settings like 
location information, mail server and domain settings, bookmarks, and so on, user interaction 
cannot be avoided. It is important to inform your users about the upcoming change in 
advance, during, and after the change to have their full attention and acceptance. 

If applicable, you can minimize the impact on the daily business by migrating users based on 
a random selection and not per department or organizational unit. Keep your Help Desk up to 
date so that they can expect additional calls.

For moves into domains with different certification hierarchies or tighter security restrictions 
like public key checking, you have to ensure that required cross-certifications and certificate 
documents are available, as well as making sure the public key in the user’s ID file matches 
the one stored in the directory.

In addition, ECL updates to users workstations may be needed if the IDs are different 
between domains. The migration also needs to update the personal documents (Notes 
domain field) in the user's local names.nsf that points to users in domains that are migrated to 
a new domain.

Impacts on delivery building blocks
The consolidation of Domino domains, often combined with site and administration unit 
consolidations, mostly requires a reorganization of your delivery units and a rebuild of your 
administration model (see Chapter 4, “Administration models” on page 53).

Also, your support structures may be affected due to consolidation or shared responsibilities 
like local on-site support and centralized back office support structures.

It is important to include your delivery organization in your project planning. Ensure that all 
kinds of services will constantly remain during your project phases.

Impacts on business related entities
Business related interests and strategies must be in line with any consolidation approach, 
especially when it comes to domain consolidation followed by changing the administration 
model or when rebuilding the complete infrastructure. Additionally, reducing TCO for your 
e-mail and collaboration infrastructure is, in most cases, a driver of business as well.

For some infrastructure components, there will be a need to host them in a separate domain, 
whether business related due to outsourcing intentions or based on legal restrictions or 
security needs.

However, do not undervalue the impact on the company structure. Multiple domains may exist 
within companies because of decentralized company models or because of mergers. When 
merging domains, it also means the company structure is changing (from an IT perspective). 
The user population must be kept informed during such activities to manage user 
expectations and to avoid negative feelings about the new solution. User perception during 
domain consolidation can be critical to the success of the changing company/support 
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structure and morale. Negative feelings can quickly turn into negative perceptions of a new 
solution.

3.3.2  Approach 4 - Consolidating Domino domains by moving whole servers

If we focus on consolidating Domino domains without reducing the amount of servers (for 
example, because of required regional availability), there is the possibility to move complete 
servers from one domain to another. 

The business driver for this approach is to reduce the administrative cost spent in maintaining 
multiple domains.

Figure 3-12 shows the transfer of a complete Domino server from domain A to domain B. This 
means that we do not move on a per database level, but logically switch the Domino server’s 
identity into the other domain.

Figure 3-12   Domain consolidation by switching the server’s identity into another domain

Impacts on hosting site, asset management, and network infrastructure
Since this approach covers only logical, Lotus Domino internal changes, there are no impacts 
on your hosting site, asset management, or enterprise network.

Impacts on system hardware and domino servers
Moving a complete Domino server instance from one domain into another requires a couple 
of changes on your system as well as the preparations listed in “Impacts on system hardware 
and Domino servers” on page 46.

Attention: The definition for consolidating Domino domains by moving whole servers is as 
follows: 

Reducing the number of Domino domains by moving Domino servers from one domain to 
another without reducing the number of servers or server instances.

Domino Domain B

Databases on Server A

A1 A2 B1 B2

Databases on Server B

Databases on Server B

B1 B2

Domino Domain A
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Additionally, when moving, you should:

� Copy server documents and program documents into the target domain and update the 
server document’s domain field

� Copy configuration documents, cross-certifications, and certifier documents

� Add required domains

� Copy person documents (the domain change will be carried out on the cut-over date)

� Verify that mail and access groups are unique and then copy them into the new domain

� Add required resources into the target domain

� Analyze the agents required and ensure the security settings are according to the agent 
signature in the target domain

� Update any third-party connections, for example, LEI, DB2, and ConnectDirect

In the case of renaming your servers during the domain move, you should:

� Create new server IDs

� Extend cluster documents in both domains by adding new server names to existing 
clusters of source servers

� Update mail file, application, and system ACLs (not replicated within domain) by adding 
new server names

� Add a DNS alias for a new Domino server name, if applicable

On the cutover date, the following steps must be covered:

� Shutdown of server

� Replacement of system databases, server names, and address book

� Deployment of domain specific templates

� Adaptation of server’s notes.ini by changing respective values, such as:

– ServerKeyFilename= (If the server is being renamed.)

– ServerName= (If the server is being renamed.)

– ServerNameNative= (If the server is being renamed.)

– ServerTasks= (If the changes are mandatory within the new domain.)

– Domain= (TargetDomain)

– Names= (File name of target Server Names and Address Book)

� Change of Domain name in person records, mail-in databases, and resources to switch 
mail routing

� Sent mail to users to enforce an update of location documents, local replication settings, 
and bookmark update

� Reassign enabled out-of-office and other agents

In the case of renaming your servers during the domain move, you should:

� Deploy new server IDs

� Change administration server name in ACLs

Impacts on Domino domain model and infrastructure tools
For all domain consolidation approaches, it is important to review all possible dependencies 
and interfaces affected by decommissioning a domain. 
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Based on the fact, that you are going to move complete servers between domains, your 
replication and mail routing topology will become smarter. Therefore, some replication 
documents and Domino Named Network (DNN) settings may be obsolete.

User impact during server consolidation
Note that moving large groups of users and applications grouped by complete servers has a 
bigger impact on your users than if you move users in smaller, discreet groups. But if you only 
want to consolidate domains, this will be an applicable approach. As part of your project 
planning, acceptable downtimes and move schedules must be agreed upon in advance. You 
have to be aware of different user access restrictions between the source and target domain 
to ensure that users may access their mail files and application after the move. If you have 
Domino policies in place, their impact due to the domain change must be assessed.

Impacts on delivery building blocks and business related entities
Delivery and business related items covered in “Impacts on delivery building blocks” on 
page 48 and “Impacts on business related entities” on page 48 will also apply here.
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Chapter 4. Administration models

This chapter focuses on the administration model for the Domino environment and discusses 
the relationship between Server Consolidation activities and the implications for the 
Administration Model. Whether you are consolidating across domains, or consolidating to 
reduce the number of physical servers, the administration model used within your Domino 
environment is of great importance. As soon as you have more than a few administrators or 
locations in your company, you should ask the question whether the model under which you 
manage your Domino infrastructure best fits the needs of the company.

In this chapter, we address the following:

� We present the key concepts for either a centralized administration model or a distributed 
administration model.

� We describe five of the most typical administration models, presenting the pros and cons 
for each, and explain the key issues that make each model successful. 

� We describe the key supporting administrative processes required when undergoing a 
server consolidation. This reinforces the linkage between server consolidation and 
understanding/selecting the most appropriate administration model.

� We discuss the factors to ultimately help you select the best administration model for your 
organization’s needs.

� Finally, we have an in-depth discussion of the extended ACL (xACL) in which we explain 
how to use this feature to take more effective, granular control of the Domino directory. 

4
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4.1  Importance of the administration model

Many companies have a distributed administration model where the administrators are 
physically placed in different locations. The locations might even be spread across borders or 
continents. In those situations, the use of different administrative teams is often a necessity, 
thereby presenting the challenge of different administrative rights and responsibilities. 

With multiple administrators, you might not want to have them to all operate the directory with 
the same level of access rights. You might want to restrict the administrator to a certain 
geographical region or a structure within the hierarchical naming scheme of Domino.

Why limit the access to certain parts of the Domino directory? That often occurs when new 
administrators are introduced or you have administrators only responsible for certain parts of 
the directory. In those cases, you want to make sure that they are not deleting or altering 
documents outside of their responsibilities.

Having administrators in different locations or geographies often results in different methods 
of administration and procedures within the same company. There is also the aspect of trust 
between administrators in different locations/regions where regions or locations are run 
independently as possible. Neither scenario is acceptable from the perspective of a company. 
A standardized administration model is required and it must fit the company’s needs.

Undertaking the steps of consolidation calls for the right model of administration to match 
your organization and your consolidation goals. It is important to understand that there is no 
single, simple formula that determines the right model and that it is up to your company to 
evaluate what is appropriate. We will outline the different administrative models and highlight 
the pros and cons of each. 

4.2  Linking the importance of administration model to server 
consolidation

Before discussing details of an administration model, we want to establish a clear foundation 
explaining the relationship between the administration model and consolidation goals. 

Why is the administration model important and why is this worth re-examining within the 
context of a consolidation effort?

� A consolidation effort will ultimately represent a change in the Domino infrastructure. 
Given the close relationship between the infrastructure and the administration 
requirements to support it, a consolidation effort presents a logical time to re-examine the 
overall administration model. 

� The goal of a consolidation is to arrive at a more efficient/optimized Domino infrastructure. 
Simultaneously, changes to the administration model can also help create more efficient 
management. 

� Finally, 4.5, “Supporting processes” on page 64 discusses the processes involved with a 
consolidation effort. Prior to beginning a consolidation effort, it is very important to 
examine the current administration model in your organization and make sure that it is 
most effective for carrying out these supporting processes. 
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4.3  Defining administration models

The Domino infrastructure can be seen as a service layer within your company, transparent to 
the organizational chart. Accordingly, there is no need to have administrators and servers in 
the same physical locations. The servers can be placed in data centers and only need the 
attention of a technician if maintenance is required. 

The same applies when discussing the administration model. With this more transparent 
approach, the design of the consolidated Domino infrastructure can be de-coupled from the 
typical setup of having administrators physically located on site, next to the servers. 

There are two primary administration models that will be discussed in further detail: 

� Distributed administration model

� Centralized administration model

Both models can then be sub-grouped into different variants, with the intention that each 
different variant highlights strengths and weaknesses of the approach, and ultimately 
provides key points for considering your best solution. 

4.3.1  Distributed administration model defined

The distributed administration model is based on more than one location for your servers in 
your Domino infrastructure, and having multiple administrators working within the various 
locations. This model calls for distributed administration and responsibilities, which in some 
cases does not mean optimal administration. A distributed model can range from merely two 
distinct locations, to having administrators residing in different countries.

A distributed administration model calls for well-defined responsibilities between the 
locations, as well as very clear guidelines and processes.

As an example, the handling of Domino certifiers always become an issue when having a 
distributed model and questions, such as though the local administrators are:

� Allowed to only create users

� Allowed to also delete users/documents in the Directory

� Given general access to Directory and parts that are out of their location

4.3.2  Centralized administration model defined

The centralized administration model is based on having the administrators working out of 
one location. The benefits of having an administrative team working closely together in one 
location can be realized through greater efficiency and greater adherence to corporate 
standards and the ability to address technical issues. 

Note that within an centralized administrative model, the administrators do not need to be in 
the same physical location as the servers. The benefit is derived through placing the team 
together and leveraging a greater comprehensive knowledge of the system. This is a big 
advantage realized both in terms of efficient administration, as well as reducing the TCO of 
the overall infrastructure.

Attention: A distributed administration model calls for well defined responsibilities 
between the locations, as well as very clear guidelines, processes, and clear channels of 
communication.
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4.4  Examples of typical administration models

Below you will find different administration models. To accommodate the transparency and 
responsibilities within these models, two layers are presented. Specifically, we are 
differentiating between:

� Domino Administrator responsibilities

� Data Center responsibilities

The idea is to show that when we are talking about Domino administrators, we are not 
necessarily talking about the same people who are also responsible for the physical servers. 
This responsibility can obviously belong to two different organizations within your company. 
This approach/mindset to clearly define and differentiate between responsibilities is also what 
you have seen in Chapter 3, “Approaches to consolidation” on page 29.

It is very important to distinguish between responsibilities in these models. The Domino 
administrator primarily addresses the Domino administration, and the people dealing with the 
data center administration have another focus.

� Domino administrator responsibilities:

– Domino server configurations

– User handling

– Architectural thinking

� Data center responsibilities:

– HW maintenance

– Operating system maintenance

– Backup recovery

– System management

Dividing the responsibilities, as above, gives clear lines within the IT organization. 
Furthermore, this gives you the flexibility to work with just the right administration model that 
suits your organization.

The number of Domino Domains you are administering is not as important a factor when 
determining the most appropriate administration model. The reason for this is based upon the 
transparency between the physical server locations and the actual locations where 
administrators are located. Accordingly, you must distinguish between: 

1. The locations from where the servers are physically placed

2. The locations where the administration team is situated

Domino Domains must be treated as transparent to the physical locations.

The administration models presented in the upcoming section are the ones that we consider 
to be representative of the main stream. From those presented, you can extrapolate variants 
that best suit your organizations’ specific needs. 
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4.4.1  Model - one location with one or multiple administrator(s)

The one location model has the administrators in one place and then deals with all servers 
within that single location. This represents the most simple and straightforward model of the 
ones presented. 

Figure 4-1 shows the one location with one or multiple administrators model.

Figure 4-1   One Location, one or multiple administrator(s)

4.4.2  Model - one location with one or multiple administrator(s) with different 
responsibilities

This model represents one location, and is very similar to the first one presented, but the 
administrators now have different responsibilities. Implementing this model successfully calls 
for different approaches for handling the administration strategy for an administrator (or 
several administrators) who individually have fewer rights.
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Figure 4-2 shows the one location with one or multiple administrator(s) with different 
responsibilities model.

Figure 4-2   One location with one or multiple administrator(s) with different responsibilities

Defining the responsibility
There are three key approaches to consider within this scenario, which can help define 
specific responsibilities.

Mutual trust
The administrator has exactly the same rights in the Domino Directory as other 
administrators, but there exists an agreement that he is only administering a certain part of 
the hierarchical naming schema.

Advantages
The absolute advantage within a mutual trust scenario is the minimal administration effort 
with this setup. There are not extra settings that need to be implemented in the directory.

Disadvantages
There are three obvious disadvantages with this model:

� The first is that you will almost always find administrators who will not respect this 
agreement and still implement users/groups or server based settings on their own. 

� The other issue, for example, is that an administrator with limited access could mistakenly 
delete many of the users in the directory due to a procedural error or simply as the result 
of less knowledge about proper Domino administration. This presents a severe risk and 
vulnerability. 

� Limited access through group hierarchy.
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Through a granularly defined group and document level access hierarchy, the administrator 
has only access to those documents that are within the defined hierarchical naming schema.

Advantages
The advantage of this model is that you have efficiently controlled the administrator's access 
and you can trust that he will only be able to modify the documents he is supposed to.

Disadvantages
The disadvantage is the effort to create the model and implement it as well as maintaining it 
for future changes within your Domino directory.

Implementing Extended Access Control List (xACL)
Finally, the third option for successfully implementing this scenario involves implementing the 
extended ACL (xACL), which enables you to easily control administrators and is the 
recommended method over the above described group hierarchy approach. As mentioned 
above, the limited group hierarchy approach requires more maintenance than an approach 
based on xACL. For further xACL details, please refer to 4.7, “Implementing extended ACL” 
on page 66.

4.4.3  Model - two locations with multiple administrators and isolated 
administration tasks

With this model, we now introduce the decentralized model where the Domino Domain is 
spread across two locations, while also having administrators in both locations to administer 
the system. Note that in this model all administrators have the same rights for administering 
the directory.

Important: In this scenario, we emphasize that the administrators must have clear 
guidelines of operating the environment. If a mistake occurs in one location, there is a very 
high chance that this change will be replicated to the other locations and vice versa.
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Figure 4-3 illustrates a conceptual model of this approach to administration. While this model 
is quite typical due to the multiple locations of Domino servers within a single domain and the 
decision to have administrators on site in the same location as these servers, this 
Administration Model contains inherent risks and requires clear communication and 
guidelines. 

Figure 4-3   Two locations with multiple administrators and isolated administration tasks

As seen in many organizations, this approach to administration often leads to a belief over 
time that administrators are now working well together and accordingly, they eventually see 
each location as their own. While this may seem to represent an efficient mode of operation, 
this is not necessarily an advantage to the overall infrastructure. The primary risk lies in 
communication; local dependencies and conditions are not always communicated to the other 
side.

Compared to a centralized administrative model, the administrative effort in this decentralized 
model usually has additional overhead. Furthermore, the synergy and potential 
communication between the two locations probably could be better if the administrators were 
brought together.

Again, this presents a case where effective use of the Extended ACL feature (xACL) provides 
more granular control in the Domino directory. As for the methods to control the access of the 
administrators, refer to 4.7, “Implementing extended ACL” on page 66.
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Attention: A distributed administration model calls for well-defined responsibilities 
between the locations, as well as very clear guidelines, processes, and clear channels of 
communication.
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4.4.4  Model - two locations with multiple administrators and cross 
administration tasks

This decentralized model is based upon multiple administrators within two locations, each 
with cross referencing administration tasks and responsibilities. The conceptual illustration of 
this model is shown in Figure 4-4.

Figure 4-4   Two locations with multiple administrators and cross administration tasks

The administrative structure is again only to control specific rights and access for a 
decentralized structure, as described in 4.3.1, “Distributed administration model defined” on 
page 55. In terms of overall TCO, this approach presents a less attractive solution.

The foundation (namely the clearly defined roles, responsibilities, and channels of 
communication) from which the administrators are administering the Domino directory is 
crucial to the success of managing the overall infrastructure. When studying Figure 4-4, the 
risks become apparent when you consider how each individual administrator is involved with 
many servers. Many shortcuts can be made here, so there is less transparency for other 
administrators.

As for the methods to control the access of the administrators, please refer to 4.7, 
“Implementing extended ACL” on page 66.
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Attention: A distributed administration model calls for well-defined responsibilities 
between the locations, as well as very clear guidelines, processes, and clear channels of 
communication.
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Finally, Figure 4-5 illustrates a slight variant to the one shown in Figure 4-4 on page 61; 
however, the key issues at stake do not really change. In this case, we just have a local 
administrator handling his specific site while the overall administration task resides in the 
other location.

In terms of access to the infrastructure, the method is not different from the one mentioned 
above. The considerations of how to set up the access rights and define which segments of 
the hierarchical naming schema to administer are the same. Defining and setting up the 
hierarchical naming schema is the real challenge if one does want to limit access for some 
administrators.

Figure 4-5   Two locations with multiple administrators and cross administration tasks

4.4.5  Model - two locations with multiple administrators and centralized 
administration tasks

The final administration model presented in Figure 4-6 on page 63 is the fully centralized 
model where the administration is done from within one location. All administrators are placed 
within this location and they will have the synergy of working together as well as clear lines of 
communication.

Again, the granularity of administrator access must be considered, and can be effectively 
implemented using xACL, but at least you will not have the risk of administrators creating 
solutions for their location without proper communication. 

Concentrating the administrators in one place calls for an appropriate support model and 
becomes especially important when considering a scenario of multiple time zones covered by 
the centralized administration team. Help desk functionality as well as requests for new users 
must be handled and the supporting processes set up to support this model.

In terms of TCO, and effectively managing an infrastructure based on clear communication, 
guidelines, and roles/responsibility, this is the most optimal model. Keep in mind, however, 
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that the supporting processes must support this model in order to take advantage of the 
benefits.

Figure 4-6   Two locations with multiple administrators and centralized administration tasks

Considerations for multiple time zones, geographical issues, and
dependencies
Implementing an administration model across multiple time zones obviously calls for 
supporting processes. It may not be realistic to have a centralized European based 
administrator team without also being able to support users in Asia during their office hours, 
which differ from Europe. 

Using the model described in 4.4.5, “Model - two locations with multiple administrators and 
centralized administration tasks” on page 62, we provide some alternate approaches to 
consider:

� Switch the centralized administrative team to an Asia based team, and later on back to the 
European based administrators when administrating after office hours.

– During the administrative transition from one team to the other, clear and consistent 
communication about the current issues is absolutely crucial for success.

– The Local Help Desk in Asia would initially take user calls and pass those on to the 
European based administrators that they cannot solve themselves.

– This transition could make the response time longer for the users. Is this an acceptable 
solution in terms of user satisfaction, and are any SLAs in place?

– Additionally, an important component to discuss is whether the Help Desk function is 
capable of actually handling these calls or if they are always passing on the tickets to 
the other administrative team?
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� Alternatively, your company may be very well served with one centralized administrative 
model, based on the European business hours. The company is willing to accept the risk, 
or does not see a problem with having no administrative support for other region’s office 
hours outside of the centralized European business hours. 

4.5  Supporting processes

There is a whole suite of processes that need to be considered and in place when undergoing 
a server consolidation. You must consider the future surrounding environment that supports 
the Domino infrastructure.

Domino engineering
� Domino server support.

� Maintain and update Domino server and add on products.

� Install and test Domino server and new software releases.

� Determination of thresholds (Domino related).

General Domino / Notes administration
� Domino server support.

� Maintain and update Domino server and add on products.

� Install and test Domino server and new software releases.

� Monitor Domino mail routing.

� Check the Domino server log (log.nsf), statistic databases, and replication.

� Install, run, and monitor Domino mail virus protection.

� Run and monitor SMTP and Fax gateway services.

� Capacity management of Domino data partition.

� Perform Domino application disaster recovery tests.

� Adjustment of Domino directory and configurations.

� Notes system database administration.

� Determination of thresholds (Domino related).

� Qualify and solve problems or assign tickets.

� Provide on-call duty.

Help desk
� Lotus Notes user support.

� User management.

� Qualify and solve problems or assign tickets.

� Creating statistics on reported user errors.

Operations
� 24 x 7 monitoring of Domino applications.

� Operating and error handling of Domino server.

� Monitor capacity of Domino partitions on SAN.

� Platform Domino service restart.
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� Perform system dump in case of Domino application error.

� Perform Domino application disaster recovery tests.

� Determination of thresholds (Server related).

� Operate backup.

The supporting processes and their underlying importance are magnified when having all 
administrators in one location compared with multiple locations. In the distributed model, the 
users tend to contact the local administrator and get the problem fixed locally. In the case that 
the ‘local administrator’ is part of a centralized team, the user needs a method of contacting 
the administration team.

4.6  How to select an administration model

Although we have presented several examples of typical administration models, there is 
unfortunately not an easy decision support matrix that supports you in the selection of a 
model that suits your needs. There are multiple factors that influence the selection of the 
administration model.

Many companies have, at the outset of their investment in Domino, implemented a model of 
administration and have not really worked with the concept of a model and trying to identify 
the strength and weaknesses of their current model. It has simply just grown along with the 
infrastructure and in some cases become very hard to handle and administer.

When undergoing a server consolidation, it is important to also review the model of 
administration to see whether it will fit the consolidated infrastructure or needs a rework.

Also, try to identify whether your current model is actually optimal for the current environment 
and evaluate the impact a consolidation will have.

4.6.1  Factors influencing choice of appropriate Administration Model

Factors influencing the selection are:

� Support organization to handle user requests.

� Are you covering more than one time zone?

– Is it necessary to have administrators on duty for multiple time zones?

– Is it enough that the help desk handles support calls?

� Do your administrators have to handle support calls?

– Is this feasible or is it better to have an dedicated help desk?

� Do you have clear responsibilities?

– Domino administrators handle the Domino infrastructure.

– Data center administrators handles the physical hardware.

Tip: Is your company spread over a wide geographic base? If so, a centralized 
administration needs processes to handle the above issues, preferably through a 
centralized database. Due to different time zones, a centralized database for handling 
these requests is a good way to manage and track requests, as well as making them in 
advance.
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� Are the surrounding processes in place?

– How do you register users?

• Third-party tool with connection to HR system.

• Manually by done by Domino administrators, and the user is informed through 
e-mail or database or other means of communication.

� Do you want to reduce the overall TCO?

– Reducing servers.

– Reducing administrators.

– Reducing / optimizing number of databases.

• Remove redundancy and databases not in use anymore

� Does the size of the company have an influence?

This is actually a very interesting question to consider. Many companies will have the view 
that a large global organization requires a decentralized model, with administrators in 
each continent, closer to the users and geographically based groups of users.

The final factor concerns bandwidth and your Wide Area Network: 

To what extent does the Wide Area Network support the user population accessing centrally 
managed servers out of one location? This is a pure bandwidth and latency issue but many 
companies with these issues are working in replication mode and do not work directly on the 
servers. Choosing the option of having servers in all continents does not mean that you need 
administrators at the same location. They can still be centralized out of one location as long 
as the supporting processes are in place.

Therefore, the model of administration and also the degree to which you want to consolidate 
your environment is made up of many factors that need to be addressed by you internally and 
then optionally confirmed through proof of concepts to ensure that you are on the right track.

The different server consolidation approaches presented in the previous section, together 
with the underlying support processes, will influence you administration model. Therefore, 
having selected the consolidation approach that fits your company, it is time to choose the 
right administration model to be able to continue the consolidation work and actually execute 
the project. With these two elements decided, you can begin to plan the concrete steps for a 
consolidation project. 

For more information about the steps for planning and managing the phases of the 
consolidation project, please refer to Chapter 5, “Project planning overview for performing 
server consolidation” on page 101.

4.7  Implementing extended ACL

With the Domino feature extended ACL (xACL), you can build a granular administration model 
that delegates the proper responsibilities through delegation of Person (and Group) 
Document management based upon a specific hierarchy. 
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4.7.1  Overview of extended ACL

The extended ACL controls give enterprises the ability to delegate administration to regional 
administrators without giving them manager access. You can configure these regional 
administrators to allow them to administer only directory objects within their own 
organizational units.

An extended access control list is an optional directory access-control feature available for a 
directory created from the PUBNAMES.NTF template, namely either a:

� Domino Directory

� Extended Directory Catalog

Functionality of extended ACL 
An extended ACL is tied to the database ACL, and you can access it through the Access 
Control List dialog box using a Notes 7 or Domino Administrator 7 client. You use an extended 
ACL to apply restrictions to the overall access to the database ACL. You cannot use it to 
increase the access the database ACL allows. 

Use an extended ACL to set access to: 

� All documents with hierarchical names at a particular location in the directory name 
hierarchy. For example, all documents whose names end in OU=AM/O=ITSO_Org1. 

� All documents of a specific type. For example, all personal documents.

� A specific field within a specific type of document.

� A specific document.

An extended ACL allows you to:

� Delegate your Domino administration, for example, allow a group of administrators to 
manage only documents named under a particular organizational unit. 

� Set access to precise portions of the directory contents.

� Set access to documents and fields easily and globally at one source, rather than 
requiring you to control access through features such as multiple Readers and Authors 
fields.

� Control the access of users who access the directory through any supported protocol: 
Notes (NRPC), Web (HTTP), LDAP, POP3, and IMAP.

4.7.2  Understanding the elements of an extended ACL

To set up an extended ACL, use the "Extended Access at target" dialog box, which you open 
from the database Access Control List dialog box. The elements of an extended ACL are: 

� Access settings: The allowed access

� Subjects: The users and groups whose access you control

� Targets: Categories of documents or specific documents to which access settings apply

Important: Extended ACL is used to apply restrictions to the overall access of the 
database ACL. You cannot use it to increase the access the database ACL allows. 
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4.7.3  Understanding the levels of access - using Administer access

This section will help you understand who is affected by restrictions within an extended ACL, 
or for the sake of administering access, who can grant access or modify access settings at an 
extended ACL target.

� An extended ACL cannot restrict the access of a user with Manager database access or 
an administrator with "Full Access administrators" access to a server. (This is controlled 
through the Server document in the Domino Directory.) 

� An extended ACL also cannot prevent a user with Designer or Manager database access 
from modifying the directory design. 

To allow someone with Designer or Editor access in the database ACL to modify access 
settings at an extended ACL target, grant Administer access.

Someone with Manager access in the database ACL can modify an extended ACL without 
having Administer access. 

Grant Administer access to allow someone to manage access to documents under a target 
category without granting the person Manager access in the database ACL. 

A user with Editor or Designer access in the database ACL does not have the Administer 
access by default; you must grant the user that access explicitly. You grant someone 
Administer access to a target category and not to a specific document.

4.7.4  Plan the extended ACL

We strongly recommend that prior to implementing a change in the working environment, you 
thoroughly plan an extended ACL on paper before you implement it. 

After you have planned the extended ACL on paper, test it in a non-production environment 
before deploying it. When planning an extended ACL, use a sparse access control model that 
minimizes the number of extended ACL subjects you specify: 

� Use categories as targets, / (root) or subcategories below / (root), rather than individual 
documents. To subcategorize documents below / (root), you may have to give some 
documents, for example, Group documents, hierarchical names manually.

� As a general rule, use the default target scope "This container and all descendants" as the 
target scope to extend subjects' access to target subcategories. 

� Use names that represent groups of users (Self, groups, wildcard subjects, -Default-) as 
subjects rather than the names of individuals. 

When you use a sparse access control model, Domino can check extended ACL access 
settings quickly and you can manage extended ACL access settings easily. 

Extended ACL at the Organizational level
To ease the understanding of xACL, Figure 4-7 on page 69 explains the level set at the 
Organizational level within the directory hierarchy.

Note: You can give a Domino 7 server Administer access to a selected target category. 
This access enables the server to be an extended administration server whose 
Administration Process manages documents below the selected target category. Please 
see 4.8, “Using an extended administration server” on page 95 for more information.
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Figure 4-7   xACL set at the Organizational level

Extended ACL at the Organizational Unit level
To ease the understanding of xACL, Figure 4-8 explains the level set at the Organizational 
Unit level within the directory hierarchy.

Figure 4-8   xACL set at the Organizational Unit level

Database ACL

Root

O=ITSO_ORG1

OU=AM OU=AP

CN=User 1

CN=User 2

CN=User 3

CN=User 4

CN=User 1

CN=User 2

CN=User 3

CN=User 4

xACL is in this example
set at the O=ITSO_ORG1
level.

Database ACL

Root

O=ITSO_ORG1

OU=AM OU=AP

CN=User 1

CN=User 2

CN=User 3

CN=User 4

CN=User 1

CN=User 2

CN=User 3

CN=User 4

xACL is in this example
set at the OU=AP
level.
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Extended ACL at the Organizational Unit Container level
To ease the understanding of xACL, Figure 4-9 explains the level set at the Organizational 
Unit Container level within the directory hierarchy.

Figure 4-9   xACL set at the Organizational Unit Container level.

4.7.5  Extended ACL access settings

There are several access settings you can use to control a subject's access to an extended 
ACL target. For each access setting, you choose Allow or Deny. You can leave an access 
setting unchecked, but if you do, other subjects in the extended ACL or database ACL 
determine whether the subject is allowed or denied the access. It is better to select Allow or 
Deny to help ensure you get the access control results you expect. 

Access settings apply to existing documents at a selected target. If the selected target is a 
category of documents, access settings also apply to documents added to the category in the 
future. 

An extended ACL cannot restrict the access of a user with Manager database access or an 
administrator with "Full Access administrators" access to a server (controlled through the 
Server document in the Domino Directory.) An extended ACL also cannot prevent a user with 
Designer or Manager database access from modifying the directory design. 

The access settings shown in Table 4-1 control access to a document as a whole.

Table 4-1   Document access settings

Database ACL

Root

O=ITSO_ORG1

OU=AM OU=AP

CN=User 1

CN=User 2

CN=User 3

CN=User 4

CN=User 1

CN=User 2

CN=User 3

CN=User 4

xACL is in this example
set at the OU=AP
Container level.

Note: For ease of reading, this topic uses the terms document, field, and form. If an 
extended ACL will control LDAP access, apply the LDAP equivalent terms instead: entry, 
attribute, and object class.

Access setting Tasks allowed

Browse Allows a user to access a document.

Create Allows a user to create a document.

Delete Allows a user to delete a document.
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The access settings shown in Table 4-2 control access to a field within a document.

Table 4-2   Field access settings

When more than one type of document uses a particular field, you control access to the field 
separately for each type of document. 

Example 1: Deny users the ability to view all documents in the directory
Figure 4-10 shows the scenario where you, the administrator, through the use of xACL, have 
denied the users in the ITSO_ORG1 Organization Unit “AM” the ability to see the documents 
in the other “AP” Organizational Unit within the same Domino directory. 

Figure 4-10   Deny users in AM the ability to view all documents in AP

Access setting Tasks allowed

Read Allows a user to read a field. The user must also 
have Browse access to the document.

Write Allows a user to modify a field.

Database ACL

Root

O=ITSO_ORG1

OU=AM OU=AP

CN=User 1

CN=User 2

CN=User 3

CN=User 4

CN=User 1

CN=User 2

CN=User 3

CN=User 4

Subject: */AM/ITSO_ORG1
Access: 

Browse: Deny

Default: Reader

Deny users in AM the ability to view all documents in AP
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Example 2: Enable administrator to operate within an OU
Figure 4-11 shows the scenario where you, through xACL, have enabled the administrators in 
the ITSO_ORG1 Organization Unit “AP” to also administer documents within that OU. 

Figure 4-11   Enable AP administrators to create and modify AP person documents

This can be used in geographical dispersed organizations who need local or regional 
administration and a certain set of control so that the administrators are not altering 
documents out of their OU level.

If you are controlling the access of Notes and Web users, be aware of the following issues: 

� If you deny a Notes or Web user access to a field in a document, when the user opens the 
document, the document does not show the field and the text (TRUNCATED) shows in the 
tab of the document. In addition, the user is unable to edit the document, even if the user 
has write access to the fields in it.

� If you deny a Notes or Web user access to a field in a document that a view uses to sort 
the document, the name of the document is blank in the view. The user can still select the 
document to open it.

� To delete a document, a Notes or Web user must be able to see the document in a view. 
To see a document requires Browse access to the document.

� To create a document, a Notes or Web user or a Notes application must have Create 
access to the document as well as Write access to the fields to which the user/application 
will add values.

Note: These issues do not apply to access through other means, such as LDAP access or 
Notes application access, except where indicated. 

Database ACL

Root

O=ITSO_ORG1

OU=AM OU=AP

CN=User 1

CN=User 2

CN=User 3

CN=User 4

CN=User 1

CN=User 2

CN=User 3

CN=User 4

Default: Reader
AM_admins: Editor
AP_admins: Editor

Subject: Default
Access: 

Create: Deny
Write: Deny

Subject: AP_admins
Form: Person
Access: 

Create: Allow
Write: Allow

Enable AP administrators to create and modify AP person documents
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4.7.6  Database security features and extended ACL

The access set for a user in an extended ACL can never exceed the access that the database 
ACL, including the database ACL privileges and roles, allows the user. 

For example, if the database ACL allows a user only Reader access, you cannot use the 
extended ACL to allow Write access. Or if a user is omitted from the database ACL User 
Creator role, you cannot use the extended ACL to allow the user Create access to Person 
documents.

Access set through a security feature in the database design also restricts the access you 
can specify in an extended ACL. For example, if a Readers field on a particular form prevents 
a user from reading fields in documents created with that form, giving a user Browse access 
to the form in the extended ACL does not override the access specified in the Readers field.

4.7.7  Group naming scheme and extended ACL

When working with extended ACL you must follow the following simple naming rules to make 
it work properly.

You can use any of these characters for the group name:

1. Letters A through Z

2. Numbers 0 through 9

3. Ampersand ( & )

4. Dash ( - )

5. Period ( . ) (please see comment / notes below)

6. Underscore ( _ )

7. Apostrophe ( ' )

Please note that:

1. You must not use a backslash ( \ ) or any other characters not included in the list above, 
because they can cause unexpected results. 

2. A Group name can be a maximum of 64 characters in length.

3. For easier administration, use a name without spaces. Do not use a name that is in use as 
the name of an organizational unit in the hierarchical name scheme.

4. While the use of the period ( . ) is not prevented, it may be advisable to avoid its use, in 
consideration of possible future conflicts with Internet addressing. At this time, though, 
there are no known issues relative to using the period in Group names.

5. Use of the "#" (pound sign / hash) character in Group names is not recommended by IBM. 
A client may not have a problem in Domino, but issues could emerge as the client 
implements other collaborations.

6. With the introduction of Notes Domino 6, the forward slash ( / ) is not only acceptable, but 
is necessary for some xACL functionality.
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4.7.8  Implementing an extended ACL for a Domino Directory

To set up an extended ACL for a Domino Directory or Extended Directory Catalog, you must 
enable extended access for the database. 

Important: Before you enable extended access to the Domino Directory, make sure you 
understand the implications of doing so:

� Enabling extended access may take a few minutes on a very large directory database. 
The Notes or Domino Administrator client is unavailable for other purposes during this 
process.

� To ensure that the database replicates properly, extended access requires use of the 
advanced database ACL option "Enforce a consistent Access Control List across all 
replicas." 

� After you enable extended access, you cannot make changes to the database on a 
server running an earlier release because the changes cannot replicate to a Domino 6 
or later server. If you enable extended access, you must make directory changes only 
to a replica on a Domino 6 or later server.

� Enabling extended access enforces the database ACL, extended ACL, and Readers 
and Authors fields for Notes clients looking up names in the directory. For example, if 
you enable extended access, then Notes users who are addressing mail must have at 
least Reader access in the database ACL to use type-ahead addressing or F9 address 
resolution against the directory, or a Notes application that calls NAMELookup functions 
to search the directory must have the necessary database access to carry out the 
operation. 

� Enabling extended access enforces the database ACL and extended ACL for 
anonymous LDAP searches of the directory. Enabling extended access removes the 
anonymous LDAP access settings from the domain Configuration Settings document, 
and they remain removed unless you disable extended access at a later point. By 
default, the directory database ACL gives Anonymous users No Access, so if you want 
LDAP users to search the directory anonymously, you must change the access for the 
Anonymous entry if you enable extended access.

Important: Do not enable extended access if you have any uncertainty about doing so.
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Steps for enabling extended access for Domino Directory or Extended
Directory Catalog
To enable extended access for a Domino Directory or Extended Directory Catalog:

1. Select the database, right-click it, and select Database → Access Control, as shown in 
Figure 4-12.

Figure 4-12   Choose Database - Access Control
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2. Ensure that the administrative users have Manager access in the Domino directory’s ACL, 
as shown in Figure 4-13.

Figure 4-13   Ensuring administrative users Manager rights on Directory
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3. Click the Advanced button, and then select Enable Extended Access, as shown in 
Figure 4-14.

Figure 4-14   Enabling extended access
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4. Click Yes to continue, as shown in Figure 4-15.

Figure 4-15   Enabling extended access prompt to accept

5. If your Domino directory does not have the "Enforce a consistent Access Control List 
across all replicas" enabled, you will be prompted, as shown in Figure 4-16 on page 79, to 
enable this feature. Click Yes to enable it.

Important: Consistent access control must be enabled to use xACL.
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Figure 4-16   Enabling Consistent Access Control

Tip: If Consistent Access Control is already enabled, you will not see the prompt in 
Figure 4-14 when enabling extended access control on the directory.
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6. If your organization has more than one administrator managing the extended access 
control for the directory, you should enable document locking on the directory to avoid 
document conflicts. The prompt displayed after accepting Consistent Access Control 
(Figure 4-17) urges you to not forget this feature when you have multiple administrators.

Figure 4-17   Document locking notification prompt
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7. Click OK in the Access Control List dialog box (Figure 4-18) to accept the changes made.

Figure 4-18   Accepting the changes made in the ACL dialog box
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8. At the "Enabling extended access control restrictions. This may take a while." prompt, click 
OK, as shown in Figure 4-19. 

Figure 4-19   Prompt “Enabling extended access control restrictions. This may take a while.”
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9. To validate the process, you should take a look at the status bar of your client (see 
Figure 4-20).

Figure 4-20   Client status bar
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10. To validate whether document locking is enabled or not, right-click the directory and 
select Database → Access Control, as shown in Figure 4-21. 

Figure 4-21   Selecting directory database properties

11. The database properties dialog box is displayed and the box “Allow document locking” 
must be enabled, since we have multiple administrators in the organization. Enable 
document locking by selecting the check mark box, as shown in Figure 4-22 on page 85.
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Figure 4-22   Enabling document locking

4.7.9  Validate (Log) changes made to the extended ACL

For verification/validation of any changes made, you can display a log of all changes made to 
an extended ACL and to the database ACL. Each entry in the list shows: 

� When the change occurred

� Who made the change

� What element was changed

To perform this validation through the log files, perform the following steps:

1. Open the database that uses the extended ACL, and select File → Database → Access 
Control.

– Do one of the following:

• Click Log from the Access Control List dialog box.

• Click Extended Access and then click Log from the "Extended Access at target" 
box.

Important: Document locking ensures that only one administrator can modify the 
extended ACL at a time. 
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2. Select a line of log history. To see the complete text of the log history, look in the field at 
the bottom of the dialog box, as shown in Figure 4-23. 

Figure 4-23   Capturing of Log changes

4.7.10  Setting a subject's access to an extended ACL target 

An extended ACL subject is a name for which you are setting access to a selected extended 
ACL target like a specific OU within your directory.

To set a subject's access to an extended ACL target in a Domino Directory or an Extended 
Directory Catalog, follow these steps:

1. Make sure you have enabled extended access for the directory.

2. Select File → Database → Access Control to open the Access Control List dialog box. 
Make sure you have one of the following:

a. Manager access.

b. Editor or Designer access and the Administer extended ACL access to the target for 
which you are setting the subject's access. 

Note: If you use a Macintosh client, you cannot copy the content from the log into Notepad, 
which is an option in Figure 4-23 by using the Copy button.
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i. Either a database manager or someone with Administer access to the target must 
give you this access, as shown in Figure 4-24.

Figure 4-24   Ensuring Manager access to directory
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3. With Basics selected, click the Extended Access button, as shown in Figure 4-25.

Figure 4-25   Extended Access at:/ dialog box
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4. In the Target box at the left of the "Extended Access at target" dialog box, expand the 
target categories as necessary and select the target, as shown in Figure 4-26.

Figure 4-26   Expansion of directory tree

Tip: Below the Target box, deselect Show only containers to show the documents under 
each target category. Select the option to show only the target categories. You can choose 
a single document as a target, but doing so is discouraged. 
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Further expansion of the directory tree is necessary to see the next level, as shown in 
Figure 4-27.

Figure 4-27   Further expansion of the directory tree

5. Next to "People, Servers, Groups" below the Access List box, select one:

a. Show Modified: To show only those subjects whose access to the selected target is set 
at the target.

b. Show All: (default) To show subjects whose access to the selected target is set at a 
higher target using the "This container and all descendants" scope, as well as to show 
subjects whose access to the selected target is set at the target.

6. To add the subject for which you are setting access to the selected target, do one of the 
following:

a. Select Add → Name and type or select a subject name, then click OK (see 
Figure 4-28 on page 91). If the subject is a user, server, or group that is not in the 
directory for which you are controlling access, this prompt appears: "Subject cannot be 
found in the directory. To continue, please specify the subject's type: Person, Server, 
Group." Select one of the options presented, then click OK.

b. Select Add → Default to add the subject -Default-.

c. Select Add → Self to add the subject Self. 

d. Select Add → Anonymous to add the subject Anonymous.
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If a subject's access to the selected target is set at a higher target through the scope "This 
container and all descendants" and you add the subject to the selected target with new 
access settings, the new access settings then control the subject's access to the selected 
target.

Figure 4-28   Selecting the target
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After selecting the target, the subject is added, as shown in Figure 4-29.

Figure 4-29   Target linked with Subject

7. Below the Scope of Target box at the top, and right of the "Extended Access at target" box, 
select one of the following to specify the scope of the subject's access at the selected 
target. 

a. This container and all descendants (default). This applies the subject's access to the 
selected target and to all targets subcategorized below it.

b. This container only. This applies the subject's access to the selected target only and 
not to targets subcategorized below it.

8. Below the Attributes section at the right of the "Extended Access at target" box, for each of 
the following, select Allow or Deny to set the selected subject's default access to the 
selected target, as shown in Figure 4-30 on page 93:

– Browse

– Create

– Delete

Note: If you selected a single document as a target, the "This container and all 
descendants" option is not available.
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– Read

– Write

– Administer

Figure 4-30   Selecting rights for the Subject Default

Types of allowed Subjects
You can specify any of the following as subjects in an extended ACL: 

� Individual user or server

� Group

� Wildcard that represents documents at a specific location in the directory name hierarchy, 
for example, */Users/ITSO_ORG1

� Anonymous

� -Default-

� Self

With the exception of Self, these are the same types of entries that are acceptable in a 
database ACL. 
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You specify more than one subject at a target to give each subject its own access to the 
target. For example, the group Admins/AM/ITSO_ORG1 and the group 
Admins/EU/ITSO_ORG1 might each have access set at the / (root) target. You can also add 
the same subject at multiple targets, to give the subject different access to each target. 

If the database ACL and an extended ACL both list a particular subject, Administration 
Process requests can rename or delete the subject in the extended ACL, as well as in the 
database ACL. 

Anonymous as subject
As in the database ACL, the subject Anonymous controls the access of all users and servers 
that access a server without first authenticating. Anonymous access applies to access via all 
the supported protocols.

Self as a subject
The subject Self is available only for an extended ACL and not the database ACL. As a target 
category only, you can use Self to define the access that all users have to their own 
documents that fall under the target category. A user's own document is one with a 
distinguished name that matches a distinguished name presented by the user. Use Self so 
that you can use one subject to control all users' access to their own documents at a target 
category.

-Default- as a subject
Adding and setting access for the -Default- subject at a target is optional. If you set access for 
-Default- at a target, all users and servers whose access is not determined by another subject 
at the selected target get the access set for -Default-. If you add the -Default- subject to a 
target and you want some users to have different access to the target than the -Default- 
access, add a subject or subjects that represent those users to the target with the desired 
access.

Lotus Domino 7 servers as subjects 
In general, an extended ACL cannot restrict access to a Domino 6 server. The exception is 
granting a Domino 7 server Administer access to a target category that represents a 
particular location in the directory name hierarchy. Doing so allows the server to be an 
extended administration server that can carry out Administration Process requests for 
documents under the selected target category. For more detailed information, please see 4.8, 
“Using an extended administration server” on page 95.

Advantages to using subjects that represent a group of users
When possible, use subjects that represent groups of users (-Default-, Self, groups, and 
wildcard subjects) rather than use individual users as subjects. For example, set access for 
the group Admins/ITSO_ORG1, rather than setting access for ITSO_ORG1 administrators 
individually. When you use subjects that represent groups of users, you minimize the number 
of subjects in the extended ACL to add and manage and you optimize access-checking 
performance.

Final steps for implementing extended ACL
1. (Optional) Set form-specific access to make exceptions to the default access.

2. Click OK to save the extended ACL changes and close the "Extended Access at target" 
box.
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4.8  Using an extended administration server

An extended administration server is an administration server that processes Domino 
Directory administration requests. The target documents in the Domino Directory are added 
to, modified, or deleted only if they belong to a particular namespace within the Domino 
Directory. A namespace is defined by a certification hierarchy, for example, 
OU=Sales/ITSO_ORG1, where the organization is ITSO_ORG1 and the organizational unit is 
Sales. You can specify the organization or one or more organizational units as a namespace 
for which an extended administration server is used to process administration requests. 

You can designate extended administration servers for one Domino Directory by selecting a 
namespace in the Domino Directory's extended access interface and designating a particular 
server as an administrator for that namespace. The new interface allows you to specify the 
exact namespace that an individual administration server is responsible for. This is shown in 
4.7.10, “Setting a subject's access to an extended ACL target” on page 86. In this case, the 
Subject is the extended administration server.

The extended administration server distributes the administration responsibilities across 
multiple servers, which is especially useful for remote administration of servers that are 
geographically dispersed. The concept of the extended administration server was developed 
in order to make remote administration available to administrators.

In a decentralized Domino environment (see 4.4.3, “Model - two locations with multiple 
administrators and isolated administration tasks” on page 59 and 4.4.4, “Model - two locations 
with multiple administrators and cross administration tasks” on page 61), there is the option to 
use multiple servers to maintain the Domino Directory. 

If your domain is geographically dispersed, having a single administration server for the 
Domino Directory means all administration requests for Domino Directory changes have to 
replicate to this one server and the resultant changes have to replicate back. 

If your company is organized hierarchically, that is, it is composed of multiple organizations 
and organizational units, extended administration servers can be assigned to maintain the 
directory documents associated with people, groups, and servers whose names have that 
organization or organizational unit component. 

This method supports decentralized administration and responsibilities ensuring that 
administrators can only work within their part of the hierarchical namespace they are granted 
access rights to.

Attention: The traditional administration server modifies all of the target documents in the 
Domino Directory that either do not belong to any namespace or to which an extended 
administration server has not been assigned.

Important: All of the Domino servers in the domain must be Lotus Domino 7 servers or 
newer to use the extended administration server feature.
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4.8.1  Example 1: Extended ACL organizational segregation

With this very simple example, we will introduce the extended ACL to our ITSO organization 
where we want to separate two OUs within the same directory.

The ITSO organization uses the following name hierarchy within its Domino directory:

� O=ITSO_ORG1 (Organization)

� OU=AP (Organizational unit)

� OU=EU (Organizational unit)

The ITSO organization’s goal it to prevent users registered under OU=AP from accessing 
documents within OU=EU, and to prevent users registered under OU=EU from accessing 
documents within OU=AP. 

ITSO does the following to accomplish these security goals:

1. Sets the -Default- access in the Domino Directory database ACL to Reader.

2. Denies the subject */AP/ITSO_ORG1 all access to the target OU=EU.

3. Denies the subject */EU/ITSO_ORG1 all access to the target OU=AP.

4.8.2  Example 2: Extended ACL and administrator delegation

With this example, we get into an area where it is more interesting in terms of server 
consolidation and administration models. Here the distributed model is introduced based on 
administrators having different responsibilities and again, as described in 4.4, “Examples of 
typical administration models” on page 56, it can be applied on whatever setup your company 
wants to implement.

The ITSO organization uses the following name hierarchy within its Domino directory:

� O=ITSO_ORG1 (Organization)

� OU=AP (Organizational unit)

� OU=EU (Organizational unit)

The directory includes the following administrator groups:

� The Admins/ITSO_ORG1 group

– Responsible for managing documents throughout the directory

� The Admins/AM/ITSO_ORG1 group

– Responsible for managing documents that fall under OU=AM and that have names 
ending in AM/ITSO_ORG1

� The Admins/EU/ITSO_ORG1 group

– Responsible for managing documents that fall under OU=EU and that have names 
ending in EU/ITSO_ORG1

The mission of the ITSO organization with this setup is to establish the following rules: 

1. Allow members of the Admins/ITSO_ORG1 group to:

– Have full access to all documents in the directory 

– Manage access at any target in the extended ACL

2. Allow members of the Admins/AM/ITSO_ORG1 group to:

– Read all fields in all documents in the directory
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– Create, modify, and delete only documents that fall under OU=AM 

– Manage the extended ACL at the OU=AM target

3. Allow members of the Admins/EU/ITSO_ORG1 group to:

– Read all fields in all documents in the directory

– Create, modify, and delete only documents that fall under the OU=EU

– Manage the extended ACL for the OU=EU target. 

4. Allow authenticated users not in any of the administration groups to browse and read only 
Person, Group, and Resource documents throughout the database but not other 
documents, and prevent these users from creating, deleting, and modifying any 
documents. 

5. Prevent anonymous users from accessing the directory. 

Table 4-3 through Table 4-6 on page 98 describe how the ITSO sets up the Domino directory 
database ACL and the extended ACL to accomplish its mission.

Database ACL
Table 4-3   Database ACL

Subject Access Description

-Default- Reader Required to allow 
non-administrators to browse 
and read Person, Group, and 
Resource documents.

Admins/ITSO_ORG1 � Manager
� Delete 
� All administration roles

Allows members of 
Admins/Acme to manage all 
documents and the entire 
extended ACL; no extended 
ACL settings needed.

Admins/AM/ITSO_ORG � Editor
� Create, Delete 
� All administration roles

Required to allow members of 
Admins/West/Acme to create, 
modify, delete, and manage the 
extended ACL for West/Acme 
documents.

Admins/EU/ITSO_ORG1 � Editor
� Create, Delete 
� All administration roles

Required to allow members 
Admins/East/Acme to create, 
modify, delete, and manage the 
extended ACL for East/Acme 
documents.

Anonymous No Access Prevents anonymous users 
from accessing any information 
in the directory. No extended 
ACL settings are needed.
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/ (root) target in extended ACL
Table 4-4   /root target

OU=AM target in extended ACL
Table 4-5   AM target

OU=EU target in extended ACL
Table 4-6   EU target

Subject Access This container and all 
descendants?

Description

-Default- Default: 
� Deny: all Person, 

Group, and 
Resources

� Allow: Browse, 
Read 

� Deny: Create, 
Delete, Write, 
Administer

Yes Allows 
non-administrators to 
read only Person, 
Group, and Resource 
documents. 

Admins/AM/ITSO_
ORG

Default:
� Allow: Browse, 

Read
� Deny: Create, 

Delete, Write, 
Administer

Yes Prevents members of 
the 
Admins/AM/ITSO_OR
G1 group from 
modifying documents 
at the / (root) and 
O=ITSO targets.

Admins/EU/ITSO_
ORG1

Default: 
� Allow: Browse, 

Read
� Deny: Create, 

Delete, Write, 
Administer

Yes Prevents members of 
the 
Admins/EU/ITSO_OR
G1 group from 
modifying documents 
at the / (root) and 
O=ITSO targets.

Subject Access This container and all 
descendants?

Description

Admins/AM/ITSO_
ORG

Default:
� Allow all

Yes Allows members of 
Admins/AM/ITSO_OR
G1 to have full access 
to documents under 
OU=AM.

Subject Access This container and all 
descendants?

Description

Admins/EU/ITSO_
ORG

Default:
� Allow all

Yes Allows members of 
Admins/EUITSO_OR
G1 to have full access 
to documents under 
OU=EU.
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4.8.3  Disabling extended ACL

Disabling extended access takes effect immediately and irreversibly removes any extended 
ACL restrictions that have been set and so will alter security checking for the database. 

You will remove all restrictions set on forms and fields, and the database ACL will no longer 
be restricted by extended ACL access settings. 

In addition, the database ACL will no longer be enforced for Notes client lookups to the 
directory, and the domain Configuration Settings will resume as the access control 
mechanism for anonymous LDAP searches of the directory.

Disabling extended access removes all evidence of extended ACL settings, information that 
cannot be recovered unless you restore it from a recent backup or archive of the directory, or 
unless you write down the settings prior to disabling them and then reapply them manually 
later.
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Chapter 5. Project planning overview for 
performing server consolidation

This chapter is intended to help project managers and IT architects develop an overall 
consolidation project plan. It covers some standard project management topics, as well as 
very specific information about what will be needed to get the project running.

Since no two consolidation projects are alike, we strongly recommend that the information in 
this Redpaper be used as input for the project, but not as the final word on exactly how the 
project should be run.

We discuss several project scenarios and high level considerations for the project plan. The 
steps and activities described in this chapter will assist the project team in consolidating their 
Lotus Domino 7 environment.

5

Attention: This chapter is not meant to be a complete project management handbook, 
even for a consolidation project. Every organization, environment, and project is different, 
and expert project management skills are needed to manage the project successfully. The 
goal of this chapter is to increase your awareness of the topics you should consider and act 
on when planning and implementing the project.

For information about project management, refer to the Project Management Institute Web 
site at: 

http://www.pmi.org
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5.1  The key steps in a consolidation project

The following high-level steps are the keys to successfully planning and implementing a Lotus 
Domino domain or server consolidation project:

� Have a project sponsor that is involved in the project.

� Define the project vision.

� Assemble the right project team.

� Develop and maintain the project schedule.

� Project scope management.

� Document requirements.

� Establish a communication plan.

� Set project expectations.

� Document the current Lotus Domino infrastructure.

� Assessment of current administration model and service levels.

� Develop the training plan.

� Plan, design, and document the consolidated Domino and Notes environment.

� Develop a migration and coexistence plan during consolidation.

� Risk analysis.

� Change Management.

� Test and validation of consolidation approach, and run pilot.

� Run consolidation activities.

� Final phase - project closure.

An overview of each step follows; a thorough discussion of these topics is discussed later in 
this Redpaper.

Project sponsor involvement
The importance of high-level sponsorship must be strongly emphasized for a project, such as 
the consolidation of enterprise Lotus Domino infrastructures.

Project vision
The project vision is a high-level, unbound view of the future.

Assemble the right project team
Putting together the right project team is a critical factor in ensuring a successful 
consolidation. This type of project requires a group with the right technical and management 
skills to ensure an accurate, high-quality design and a realistic, manageable project schedule.

Develop and maintain the schedule
There is a lot at stake in any consolidation project. Things must occur in a certain order, within 
a set time frame, to ensure a successful consolidation. Therefore, realistic and achievable 
schedules must be established for the project.
102 Domino 7 Server Consolidation: Best Practices to Get the Most Out of Your Domino Infrastructure



Project scope management
The project scope defines the boundaries of the consolidation project. The scope statement 
should enumerate involved infrastructure parts, such as locations, domains, and servers, as 
well as organizational units.

Document the business requirements
The first task the consolidation project team must tackle is fully documenting the business 
requirements and the scope of the consolidation. This exercise involves tailoring the 
individual consolidation approaches and detailing any additional requirements. The result of 
this step is a set of clearly defined, realistic goals for the project.

The communication plan
The objective of a communication plan is to educate, inform, energize, and engage all parties 
of a project. Without adequate communication throughout the consolidation project, you run 
the risk of creating an excellent plan that never has the opportunity to be implemented. 
Developing a communications plan can be regarded as a internal marketing campaign.

You also need to have a user communication plan. This can include:

� A general pointer to a central Web site/database for "what is changing" information.

� A communication warning users 'x' days before their mail files are migrated.

� A communication warning users 'x' days before high profile applications are migrated.

� A central Web site/database where users can see when their application(s) will be 
migrated. This can even include details of the source and target servers to prevent 
unnecessary help desk calls.

� A central Web site/database where users can see information that tells them basic "how 
to" information in case they have problems. (This can prevent a lot of unnecessary calls to 
the help desk.)

Set project expectations
Setting expectations requires open, honest communication throughout the life of the project. 
From the top on down, all the people involved need to have a realistic picture of what they will 
receive and when they can reasonably expect to receive it. Everyone should understand the 
project and the progress being made on it. Unrealistic expectations and perceptions can be 
deadly, causing a successful project to be perceived as a failure. You can avoid this by 
keeping everyone's expectations in sync.

Document the current Lotus Domino infrastructure
This phase of the project involves gathering specific and detailed information about:

� The enterprise infrastructure

� e-mail metrics

� Applications

� Services

This information defines the current messaging environment. It includes such things as the 
network topology and the current delivery sites.

Note: Being very thorough here avoids unpleasant problems later, as forgotten or 
neglected functionality may escalate to be a showstopper.
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Document the current administration model and service levels
Since your consolidation project may impact your delivery organization, a detailed view of 
how it operates and interacts as-is will be important. Additionally, any service and availability 
commitments for your business should be present prior the consolidation starts.

Develop the training plan
New skills might be required when you are consolidating across locations, changing 
platforms, or impacting the administration model. Training everyone involved with and affected 
by this project will be a key factor in its success.

Training should be an ongoing activity throughout the course of the project. Communicating 
the reasons for the consolidation can be a part of the training, and developing the training 
plan can actually begin concurrently with the documentation of the current environment. The 
plan can then be updated during subsequent steps.

Plan, design, and document the consolidated Domino and Notes environment
In this step, the project team designs the future environment based on the chosen 
consolidation techniques, one that reflects the company’s strategic infrastructure plans and 
meets the current needs. The team must design a well researched and carefully conceived 
messaging infrastructure to support not only the users’ e-mail needs, but a variety of other 
messaging applications after consolidation.

The activities in this step of the project include:

� Planning the future environment

� Choosing the right consolidation approach

� Designing the consolidation processes

� Documenting the consolidation approach and the target environment

Develop a migration and coexistence strategy during consolidation
The coexistence and migration strategies are the plans that define how to migrate users and 
applications to target domains and servers and describe the functionalities to be supported 
until the consolidation process is finished. These strategies are dependent on:

� Business requirements and the scope of consolidation

� Setup of the source and target system or systems 

� The design and implementation of the target Domino and Notes environment 

Risk analysis
A proper risk analysis and management is an important factor for the project’s success. The 
more building blocks are affected by the consolidation approach, the more critical success 
factors impact the project.

Change management
In order to ensure that you run your project within time and budget, as well as meeting the 
technical requirements, you have to set up proper change management. From a technical 
perspective, the change management assures that all stakeholders and specialists know and 
approve the upcoming changes on the infrastructure. Fall back activities should also be 
defined within the change documentation.
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Test and validation of consolidation approach, and run pilot
Running several tests and initiating a pilot phase helps to prove the overall concept, its 
feasibility, and user acceptance, as well as helps to improve user or application migration 
processes.

Run consolidation activities
At this point, the consolidation approach has been validated, and the coexistence and 
migration strategies are defined. Now the actual migration / consolidation of users or 
applications to the target environment can take place. Key activities in this step are:

� Training

� Publishing the consolidation schedule

� Announcing the kickoff of the consolidation

� Starting the consolidation activities.

Close the project
When the consolidation is done, there are still a few tasks necessary to close out the project. 
They are discussed in a later section.

5.2  The sponsor

High-level sponsorship is crucial to a large-scale project like Lotus Domino consolidations.

In addition to making major changes to the IT infrastructure, the consolidation project can 
affect the way the company does business, as well as causing cultural changes within the 
company when consolidating Domino domains or across different sites affecting the 
administration model.

The sponsor should preferably be of executive level, have a clear and complete 
understanding of the business reasons for the project, and be committed to the vision. 

The sponsor’s full understanding of the business reasons helps both the sponsor and the 
project team to provide clear and precise communication about the project and its goals. This 
enables the sponsor to emphasize the importance of this project and help ensure the project 
team gets the cooperation they need from all areas of the company. We recommend that the 
project sponsor work with the project manager to hold an initial kickoff meeting for company 
management.

The goal of the kickoff meeting is to gain the needed management cooperation to build the 
project team and potentially initiate a steering committee. Further into the process, having the 
project sponsor acknowledge the work of the test users and participants in the pilot will foster 
a positive attitude about the consolidation throughout the company.

5.3  The project vision

The project vision is a high-level, unbound view of the future messaging and collaboration 
system that is to be created by consolidating the current Lotus Domino infrastructure. The 
project vision should be aligned with the overall business vision of the company. Such a vision 
helps to establish both long-term goals and short-term objectives to ensure the success of 
the consolidation project.
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Here is an example of a vision statement:

The vision of the consolidation project is to replace our multiple existing divisional-based 
messaging domains with an enterprise-wide messaging and collaboration domain that 
operates on fewer machines. This consolidation will enable all our business units to 
interoperate seamlessly while adding user functionality and reducing administrative and 
operational costs. Consolidation will commence within three months, and will be complete 
within nine months.

5.4  The project team

Assembling the right project team is the key factor in ensuring a successful consolidation 
project. It is mandatory to assemble a group with the right technical and management skills to 
ensure an accurate, high-quality design and a realistic, manageable project schedule.

The team will most likely consist of employees from your company along with subject matter 
experts and consultants from IBM or its business partners.

The team may consist of one or more persons in each of the following roles (and multiple 
roles may be filled by a single individual): 

� Project manager

� Sponsor (does not have to be a member of the team, but needs to be kept informed 
regularly)

� Domino architect

� Domino administrator

� Domino application developer

� Hardware/operating system specialist (critical if moving to a new platform)

� Storage specialist

� Network administrator

� IT/IS manager

� Site and data center manager

� Migration specialist

� Support team representative

� Specialists (these individuals may be on call)

� Users from key interest groups

Experienced users from the organizations being affected by the consolidation should be 
involved. They can help communicate the progress of the project and assist with choosing 
appropriate test users. They could also provide early feedback on plans and schedules, as 
well as ensuring any requirements unique to their areas are accounted for in the design of the 
consolidation processes.
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5.5  The schedule

A realistic, achievable schedule must be created for the project. This schedule should not only 
consist of a target date for completing the project, but should identify important milestones, 
deadlines, and the resources needed along the way.

To help you explain the basis of the established schedule to a sponsor or management team, 
be certain to:

� Educate management on the steps involved in this type of a project

� Explain the processes involved

� Lay out a reasonable, achievable high-level timeline

� Explain the risks involved in delays in any of the steps or processes

The goal is to gain acceptance from the project sponsor for a realistic, achievable timeline.

5.6  The scope

The project scope sets the boundaries for the consolidation project. The scope statement 
should define the organizational, geographical, and infrastructural scope as well as the 
technical consolidation targets within the time given and resources allocated. The scope 
should differentiate between what the consolidation must include and what is non-essential.

Example of a consolidation project scope:

When consolidation is completed, our new infrastructure will:

� Decrease the current maintained e-mail servers from 50 to 40 machines and the current 
application servers from five to four machines

� Decommission the existing Domino domain A by moving users and applications into 
Domino domain B on already existing servers

� Move all e-mail users and applications hosted on four machines at site C to two, newly 
built servers at site A

� Change the administration model to fulfill the requirements specified by the SLA of the 
company

5.7  Documenting requirements

There are many reasons why a company might want to consolidate their Domino 
infrastructure, as discussed in Chapter 2, “Reasons for consolidation” on page 7. 

Documenting the business reasons for the consolidation project and evaluating functional and 
non-functional requirements to the Lotus Domino infrastructure is one of the first tasks the 
consolidation project team must undertake. It has to ensure that the consolidation approach 
does not compromise business needs to the infrastructure.

The project team must also communicate the reasons, goals, and other project information to 
the user community. Open communication will facilitate cooperation and help ensure success.
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5.7.1  Non-functional requirements

Many of the basic requirements for consolidation may have already been presented at a high 
level during the identification of the consolidation approach. The team must now expand on 
those requirements and give detailed specifics on each, to ensure they are incorporated into 
the design and focus of the consolidated environment.

The non-functional requirements include such things as:

� Messaging server scalability, reliability, and manageability.

� Lower total cost of ownership (TCO). This refers to the company’s cost to run, support, 
and administer the new messaging environment. It does not refer to the one time costs 
associated with the consolidation project.

� Sustaining interoperability with third-party systems and interfaces.

� Improved throughput.

What is expected in each of these areas by the corporation should be detailed in the 
requirements. For example, the project sponsor might expect a minimum delivery time for a 
simple mail message after the consolidation across locations. The project team must ensure 
this is stated, and that the designers of the consolidation approach meet that goal. 
Additionally, if the sponsor has a requirement that is unrealistic, this is the time to modify the 
expectation to be within the boundaries of what is possible or feasible.

5.7.2  Functional requirements

In order to sustain former infrastructure functionality after the consolidation take place, these 
special requirements have to be defined. They include:

� Features and functions of e-mail related components, for example:

– Web access or POP3 or IMAP accessibility

– User authentication and management

– Languages supported

– Resource reservation

– Quota settings

– Encryption or other security features

– Archiving and e-mail retention

� Applications and their features and functions that have to be available after consolidation 
into the target environment

– Web access and load balancing

– Indexing and housekeeping functionalities

– Access regulations

These requirements definition can also be input to the training plan, to ensure administrators 
know how to deliver services within the target environment.

At this point, it is necessary to realign the expectations. After studying the current 
environment and making plans for what functionality will be available in the target 
environment, at a later stage, or not at all, the revised expectations should be communicated 
to the sponsors and the user community.
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5.8  The communication plan

The objective of a communication plan is to educate, inform, energize, and engage all parties 
of the project. Without adequate communication throughout the planning process, you run the 
risk of creating a fabulous plan that never has the opportunity to be implemented. The 
communication should begin at the beginning—at the point where you assemble your project 
team and begin the planning process. 

To create your communication plan:

� Identify who to inform about the project (key individuals, decision makers, and strategic 
groups).

� Decide who is responsible for reaching each person or group.

� Determine when, what, and how communication will take place. That is, try to identify each 
communication step.

� Identify the communication vehicles you have available and any communication vehicles 
you may want to create.

� Pay attention to any feedback you receive.

Reach everyone who will play a role in implementing the project. If you identify additional 
players part of the way through the planning process, do not hesitate to include them in your 
communication from that point forward, and be sure to catch them up and include them on the 
process.

Some of the topics you should consider communicating about:

� Consolidation project in general

� Goals set for the project

� Implementation schedule

� Pilot project

� Target environment

� Where and how the education is available

� How to contact support

� Progress of the project

5.9  Setting the expectations
Setting the correct expectations is crucial to the success of a consolidation project. If the 
expectations are not set correctly, you run the risk of having very low client satisfaction from 
the users. 

Just because one consolidation approach worked in one environment does not mean that it 
will be successful in another. By assuming that a new consolidation project is identical to a 
previous one, there is a danger that significant differences in stakeholder expectations and 
requirements will be ignored or actively suppressed. Project outcomes must support the 
specific structures, processes, people, and existing systems and locations in a particular 
organization, not some generic version. 

One of the most powerful strategies for keeping a project on track is to set the stage properly. 
This means more than distributing the project plan. Complement the plan by stating the 
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project vision and goals. Describe the final result and how the project team will conduct itself 
to get to that result. 

It is important to set the expectations early in your project management activities. Incorporate 
these concepts in kickoff meetings and initial meetings with specific project teams. 

Examples of expectations set for the consolidation:

� All mail present on servers will be moved to target environment.

� Mail will not be coexisted.

� Calendar and scheduling information be moved.

� Calendar and scheduling information will not be coexisted.

� Access to target infrastructure will be verified in advance.

� Delegation access and free time search during consolidation will be available.

Examples of expectations set for the target environment

� Delivery of messages internally: 90% < 5 sec, 5% < 20sec

� Open mailbox view: 90% < 5 sec, 8% < 20 sec

� Send file and store: 90% < 5 sec, 8% < 15 sec

� (Sums not equal to 100%; remainders are for special exceptions)

5.10  Document the current Lotus Domino infrastructure

This section is supposed to help you gather and document specific, detailed information 
about the current Lotus Domino infrastructure as an addition to the already introduced 
building block model (see 3.1, “Domino architecture topologies” on page 30).

In addition to the requirements definition, a detailed documentation about your current Lotus 
Domino infrastructure will be the foundation that will help you to build a complete and 
accurate design of the consolidation processes.

In this section, we describe the steps for documenting the following:

� Lotus Domino environment

� Network infrastructure

5.10.1  Documenting the Lotus Domino environment

Whether you have a small, medium, or large Domino environment, it is important that you 
gather all the data recommended here. Having all this information will ensure nothing is 
missed in the design of the consolidation processes. Many details may already be 
documented, so this phase of the project may be just verifying the existing information.

The documentation must be performed for both source and target system to identify the best 
consolidation approach.
110 Domino 7 Server Consolidation: Best Practices to Get the Most Out of Your Domino Infrastructure



Lotus Domino server topology
To document the Lotus Domino server topology, you need to know:

� The version of Domino servers running

If different versions are being used, then state why. There might be a very specific reason 
that a newer or older version is used.

� The operating system/version/SP level the servers are running on

If different versions are being used, then state why. There might be a very specific reason 
that a newer or older version is used. 

� Performance and utilization reporting (memory allocation, storage availability, and use)

� The current Domino topology

Based on the building block model document, visualize you current server topology by 
identifying:

– Site names

– Network segments (if applicable)

– Server’s host names

– Server’s Domino names

– Domino domain

– The organization’s names (per server or per domain)

� Connections to other internal/external systems

– SMTP servers and connections

– LDAP services

– POP3 and IMAP services

– Inter domain connections

• Replication connections (path, schedule, and options)

• Mail routing connections (protocol and domains)

� Calendaring and scheduling services

� Directory services (Directory Assistance and Directory Cataloger)

� Access and distribution lists

� Type of servers (hub, spoke, and pass through)

Lotus Notes client topology
To document the Lotus Notes client topology, we will need to know:

� Kind of clients are connecting these machines?

– Lotus Notes.

– Web mail.

– Domino Web Access (DWA).

– Third-party mail systems.

� Versions and language of clients

� Number of users accessing a particular server / domain

� Are there mobile users?

– Document type of service and amounts of mobile devices.
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– Users in replication mode having local replicas.

– How is access to mobile users provided?

– Detail the functionality used with the mobile devices (for example, Blackberry).

Be detailed; loosing functionality will act as a showstopper to the mobile workers.

� List of users per locations (include mobile)

Lotus Domino messaging and application services
Services, such as those in the following list, are also key elements of the messaging 
infrastructure and must not be overlooked when planning a consolidation. Be sure to 
document how each of these services is used in the existing environment and whether that 
use will change in the target environment. 

� Calendar and Scheduling

� Mail-in databases

� Holidays

� Resource databases

� Team calendars

� Performance and utilization reporting

– Existing active/concurrent users

– Peak times

If possible, try to obtain statistics that show the peak number of users on an hourly 
basis for a full month. There might be very big variations in different companies. This 
information will be used for the feasibility of consolidation or defining the right target 
system.

– How many mail items, on average, are sent per day (average per user)?

If there are variances in how the users act on different sites, then state this as well.

– Average size of a typical e-mail.

– Average size of the users’ mail file.

– Mail quota in use (If yes, state the limit).

� Attachment restrictions 

� Are there any procedures/applications using Lotus APIs?

These might be plug-ins, third-party software, or in-house developed software. Maintaining 
this kind of functionality might involve the developers or other separate handling.

� User Directory

– What types of customized fields are kept in the Domino directory?

� Event monitoring

� Other services:

– Instant messaging

– Is there an e-mail enabled fax solution?

Document functionality and dependencies to Domino

– Are there other applications running on the Domino Servers? If yes, list the 
applications and the servers those applications are available on.
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– Is antivirus software being used? If yes, gather details on the antivirus software and 
where it runs.

– Is backup software being used? If yes, gather detail on the backup software. Record 
the backup schedule for incremental and full backups.

– Is there a automated mechanism for software distribution (Tivoli® or SMS) affecting 
Domino?

Domino application inventory

We recommend creating an application inventory to record all applications running on servers 
that are in the scope of the consolidation. You should create such an inventory for both source 
and target servers by collecting:

� Application name

� Server and data path of location

� Replicas

� Replication settings (especially if selective replication is used)

� Application quotas

� Agent settings for applications in cases where there are multiple replicas of an application

� Any third-party software required by applications (like MQ series or LEI)

� Business relevance

– Financial business impact

– Security relevant

– Availability

� Special requirements, for example, specific platform needs or system files

� Business owner (to have a business related point of contact)

� Domino administrator (if available for special application)

Important: The project plan for backups needs to consider the minimum window of 
backups that is required for applications, mail files and specific business critical 
applications during the cutover/migration phase. The application and mail backups on the 
old systems should stay in place until the new system backups have reached the minimum 
level of backups before the old systems can be decommissioned.

Important: If you plan to consolidate servers hosting Domino applications, you must be 
aware of any application related impacts, for example:

� Already available replicas and replication topology across servers domains and 
locations

� Domino data path directory structure

� Hardcoded server names, links, and so on within the application

� DNS aliases for Web-enabled applications
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5.10.2  Documenting the network infrastructure

You need to have a complete description of the network and a overview of the actual network 
configuration. This should include:

� Central/distributed location with number of users

� Type of connections (leased lines and switched lines)

� Bandwidth of the lines

� Are lines shared with any other functionality (phone or other)?

� LAN configurations

� Available network protocols (TCP/IP, NetBIOS, IPX/SPX, and so on)

� Connection to a public network provider (Internet)

� Routers

� DNS host files

� Firewalls and their open ports

� Quality of service supported

� Other essential functionality

5.11  Assessment of current administration model and service 
levels

As already covered in Chapter 4, “Administration models” on page 53, there are different 
administration models to manage your Lotus Domino infrastructure. Depending on the size of 
your current infrastructure and organization as well as on the scope of your consolidation 
project, the administration model is more or less affected.

To determine any impact on the infrastructure administration, you will need to know how the 
administration and support model is built. It is essential to make sure that, as a minimum, you 
keep the service on the current level. If SLAs are in place, they might be considered as well 
when planning the consolidation.

5.11.1  Administration model

To identify those parts of your Lotus Domino Infrastructure administration that will be affected 
by the consolidation approach, you must have an overview of which part of the infrastructure 
is maintained by which unit, whether centralized or distributed.

You may use the topology model in “Lotus Domino server topology” on page 111 to map your 
delivery units to each infrastructure part. This will ease the identification of affected units as 
well as to identify the scope and amount of potential training necessities.

The following key data according to each delivery unit should be documented:

� Location

� Site responsibility

Tip: Capture the existing network load on each segment of the network. This will be useful 
in pinpointing network design problems if the consolidation does affect the network 
services.
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� Building blocks or systems supported

– Hardware and data center infrastructure

– Network back end

– Operating system

– Storage, backup, and system management

– Domino server

– Other applications or services

� Special application in place to provide service

� Number of resources

� Number of workstations

� Shift models and service times

� Skill level

� Responsible manager

� Contingency planning

5.11.2  Support model

To obtain your support services, such as User Help Desk (UHD), or downstream support 
levels during and after the consolidation project, it is important to identify in which manner 
these are operating. This will also be required to determine the consolidation impact to these 
units.

Analogous to the administration model assessment, you have to analyze your support 
organization.

5.11.3  Delivered services

To outline possible changes and improvements to the administration and support model due 
to the consolidation approach, the relevant Service Level Agreements (SLAs) must be known:

� Infrastructure availability metrics

� Response times

� Maintenance windows

Important: Your support organization especially must be included in the consolidation 
schedule and upcoming changes to fulfill their support functions and help users during the 
consolidation realization.
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Of course, all other services provided by these units are important, for example:

� User management

� Monitoring

� Backup and recovery

� User communication about service status

� Reporting

� Data maintenance

� Application deployment

5.12  Developing the training plan

There are three types of training to covered by the consolidation project:

� User training

� Support staff training

� Administration staff training

It depends on the scope and planning of the consolidation project which groups require 
training effort. You have to ensure that the right people get the necessary technical training to 
enable them to use, support, or maintain the consolidated infrastructure.

User training may be required if your consolidation approach is to migrate all components into 
a newly built infrastructure, as shown in 3.3.1, “Approach 3 - Domain consolidation by 
consolidating servers across domains” on page 44.

Support staff training seems to be necessary for each consolidation approach, but varies in 
its complexity. This is dependent on the amount of changes users have to face. The better 
your support staff is trained on consolidation related issues, the greater the user acceptance.

Training of your administration staff will be required if cross-location or cross domain 
consolidation will be applied. Any changes in the administration model will also require 
training effort for the administration staff to fulfill the Service Level Agreements.

Attention: The SLA needs to be very clearly defined. Most SLAs guarantees a percentage 
server availability, but the definitions are not clear enough as to what time slot this 
percentage is.

� Is the availability the OS level availability?

� Is the availability the Domino server availability?

� Is the availability a specific Domino application's availability?

� Does the percentage availability include or exclude the standard maintenance windows 
for the OS?

� Does the percentage availability include or exclude the standard maintenance windows 
for Domino?

Important: Determine all related Policies, Standards, Processes, and Guidelines (PSPG) 
whether enterprise wide or Domino related, to identify any constraints within the 
consolidation project.
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A training schedule must be included in your project plan to ensure in-time realization.

5.13  Plan, design, and document the consolidated Domino and 
Notes environment

Now that the project team knows what is required, how the as-is infrastructure is configured, 
and how it is maintained and supported, they must determine how to deliver it. This means 
establishing the planning and design of the consolidated Lotus Notes and Domino 
environment. The amount of effort spent on planning and designing directly correlates to the 
success of the consolidation project.

Based on the three given components (non-functional and functional requirements definition, 
current infrastructure documentation, and outlined administration and support model), the 
door to find the appropriate consolidation approach (Chapter 3, “Approaches to 
consolidation” on page 29) should be open (see Figure 5-1).

Figure 5-1   Finding the right consolidation approach

During this process, frequent review sessions should be scheduled to keep the project team 
up to date and provide feedback on the planned consolidation steps. By completing the 
planning and design work, a final review should be held and a sign-off on the consolidation 
approach received from all project team members and the sponsor.

As already mentioned, the proper consolidation approach for your individual conditions may 
be a mixture of the different techniques we discussed in Chapter 3, “Approaches to 
consolidation” on page 29. Based on your current infrastructure documentation (see 5.10, 
“Document the current Lotus Domino infrastructure” on page 110), reporting data, user 
analysis, and application inventory, you can identify the specific consolidation potentials. 

Once the different techniques are chosen, you will be able to start the detailed consolidation 
planning as well as the design of the future infrastructure. The technical references we 
covered with each consolidation technique as well as the considerations within this chapter 
should help in this task.

If multiple consolidation techniques are supposed to be applied, we recommend performing 
them step by step to minimize operational risks as well as to watch closely their impact on the 
overall infrastructure. Respective time slots should be reflected in the project plan. Document 
each consolidation step and define its acceptance criteria. If applicable to your infrastructure 
and consolidation plans, do not mix consolidation techniques within one implementation step.
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5.14  Develop a migration and coexistence plan during 
consolidation

For all server consolidation techniques, you may run into a migration and coexistence period 
once you start moving users or application between Domino servers, locations, and domains. 

The migration period is defined as the time you start moving users, applications, or servers 
during you consolidation process and is related to each item you move. That means the 
migration period for User A is finished once the user is within the target environment and all 
related tasks for this particular user are completed. But at the same time, User B is still in 
migration or has not yet migrated.

The coexistence period is defined by the time one consolidation cycle (consolidation by move, 
across locations, or domains) is ongoing. That means, users or applications already moved 
into their target environment may have dependencies or need access to the source 
environment and vice versa. We have to cover different needs of such overlapping 
requirements in order to assure uninterruptable services during consolidation.

5.14.1  Migration plan during consolidation

Based on the consolidation technique you have chosen and the research activities you 
performed as described in 5.10, “Document the current Lotus Domino infrastructure” on 
page 110, you should now plan how the migration for each cycle should be performed. This 
includes the definition of the following actions:

� User communication and information

� Continuous administrator and server access to data

� Technical order of consolidation steps (when to change)

� Preconditions, content, and exit criteria for each consolidation step (what to change)

� User interaction and how to handle this (e-mail with active content, on-site, and so on)

� Data migration strategy and technical realization

� Test and completion criteria for consolidation steps

� Tracking of consolidation progress

� Recovery planning

5.14.2  Coexistence plan during consolidation

Coexistence between the source and target environments plays one of the most critical roles 
in ensuring seamlessness of the consolidation process for both administrators and users. 
During that time, users in both environments must be able to continue communicating with 
one another as well as with users external to both environments. Failure to provide this ability 
to users will have an adverse effect on any consolidation project.

Depending on the type of consolidation you plan to perform, the coexistence period may vary 
in content, complexity, and duration.

Important: Coexistence between the source and target environments plays one of the 
most critical roles in ensuring seamlessness of the consolidation process for both 
administrators and users. 
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Consider the following when planning the coexistence:

� Continuous e-mail routing during consolidation

� Database replication

� User access to e-mail and applications

� System response times and maintenance windows

� Free time search functionality between users in source and target environment

� Delegation access from source environment to mail files in target environment

� Availability of resources and reservations

� Replication of data during coexistence period

� Exit criteria out of coexistence period

If domain consolidation is part of the consolidation project, you need to consider the effect of 
co-existence during migrations on the directory solutions. If you are using a directory catalog 
or an extended directory catalog, it is critical that you plan for all eventualities during the 
migration cutover process to ensure you do not have duplication of user entries or directory 
catalogs that get out of synchronization. The safest approach (if people are moved from one 
domain to another) would be:

� Disable replication of the target domain address book on the server that builds the 
directory catalog(s) in the target domain.

� Copy the person document(s) from the source (old) domain address book into the target 
domain address book (Note: Not into the address book on the server that builds the 
directory catalog).

� Update the servername (new target server), mail file name (mail directory and mail file), 
and domain name (to the new domain) in the person document(s).

� Delete the person document(s) from the source domain address book on the server where 
the directory catalogs are built (or change the person documents to not allow foreign 
directory synchronization.

� Rebuild the directory catalog(s) and replicate them into the source and target domains' 
servers. (This removes the person documents from the directory catalogs.)

� Enable replication of the source domain address book (on the server that builds the 
directory catalogs) and replicate all the changes into it.

� Rebuild the directory catalog(s) and replicate them into the source and target domains 
servers. (This adds the 'new' corrected copies of the person documents into the directory 
catalogs.)

5.14.3  Consolidation and migration tools

Migration tools provide a smooth and easy way to migrate the server and related data from an 
existing mail server to the target messaging environment. There are various tasks involved 
when migrating from an old mail server to a new one. These tasks include the conversion of 
users’ mail data and calendaring and scheduling information stored on the server, directory 
propagation and, in some cases, the client. A good migration tool should be able to perform 
these basic tasks successfully with the least amount of effort. In addition, migration tools 
should also support the most possible consolidation approaches. Depending on the size of 
your consolidation project, it may be valuable to invest in a tool to support your consolidation 
activities and to simplify migration tasks.
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There are a couple of IBM Business Partners providing such tools. You may find them via the 
IBM Partner World home page at:

http://www.ibm.com/partnerworld/pwhome.nsf/weblook/index.html

5.15  Risk analysis

Proper risk management during the complete project lifetime is strongly recommended. Since 
consolidation projects have a huge impact on the messaging and collaboration infrastructure, 
the impact on your business is not remote. Identifying risks, rating, tracking, and planning risk 
mitigation activities may lower this impact.

Risk management
Risk is a natural part of any IT related project and its proper management can determine the 
success or failure of the project. You should begin risk management during the proposal 
process by identifying foreseeable risks in the project and developing an associated Risk 
Management Plan, which quantifies the risk and includes your recommendations for handling 
it.

Here are some actions you can choose to take to deal with a certain risk:

� Avoidance: Eliminates the cause of the risk through clearly-defined actions/events/tasks.

� Mitigation: Acknowledges that the risk is not avoidable, but defines steps to mitigate the 
level of risk.

� Acceptance: Acknowledges the risk and documents the associated consequences.

If new or different risks are identified during the implementation of the project, they should be 
added to your risk management plan. The project manager utilizes this plan as an instrument 
to verify the progress against avoidance or mitigation plans, with the focus being to reduce the 
overall risk of the initiative.

5.16  Test and validation of consolidation approach
An original set of success criteria were defined for the pilot project, and you should review 
them now. Are they still appropriate, in light of lessons learned during the previous sections? 
If so, include them in your deployment planning. If not, discuss the success criteria and 
update the criteria so they continue to be relevant. The success criteria should also be 
included in the final deployment plan document.

Ensure that any consolidation project expectations are realigned and communicated. This 
type of communication is most crucial part, since these will be the expectations users are 
measuring the results against. Deviations from the expectations can impact your project in a 
negative way.

Tip: The tooling should also cater to the creation of replicas in clustered environments, the 
ability to maintain or transfer quotas between old and new replicas (re-applying it on the 
new replicas) and the ability to synchronize unread marks between source and target 
replicas.
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5.17  Run consolidation activities
Once your planning and design for the consolidation approaches are finished, you may start 
to execute the particular tasks. 

Depending on the consolidation approaches you utilize, the project execution schedule and 
its phases may vary. The important thing to remember is that the strategy’s success will 
depend on good planning more than the method you choose. As always, you should be 
prepared for unforeseen events.

Meeting the prerequisites
Before you can start your consolidation activities, you need to be certain that all prerequisites 
of the Domino consolidation approach have been completed. Be sure that target servers, 
network capacities, and other infrastructure elements are in place and prepared prior to 
starting consolidation.

It may be the case that parts of this is handled by another unit of the IT department, but it is 
critical the project manager understands what needs to happen, so that he or she can ensure 
it has been completed.

Staged consolidation realization
In this type of implementation, the consolidation team takes a step-by-step approach. This 
approach is quite common to smaller companies, where resources may be limited.

The staged consolidation is also used in larger companies, if the implementation can be 
subdivided neatly. This is supported by coexistence during the actual migration of users or 
applications.

The major advantage to this approach is that the risk if any given step goes wrong is minimal, 
since it is only a fraction of the total project. The biggest disadvantage is that the total 
migration project can take a long time. Be aware that there tends to be a short span of time 
left between steps to determine if the one step has been successfully implemented before 
performing the next step.

Especially when utilizing different consolidation approaches, we recommend executing them 
successively to avoid any cross-technique impacts.

Instantaneous rollout
This refers to a methodology where the entire consolidation scope is done all at once, in one 
major step. Several underlying or background steps may have been performed prior to the 
implementation, though.

The biggest advantage with this type of implementation is that there are shorter periods of 
coexistence or, when moving whole servers between domains, no coexistence at all. Be 
advised that for this type of rollout, your organization needs to be prepared for system 
downtimes. These downtimes are required to perform several steps all at once.

Most instantaneous projects are scheduled to run over a weekend or long weekend, and if 
there are problems, the rollout may run into Tuesday or even Wednesday. Your business must 
be aware of these circumstances. Consider performing tasks separately, in controllable steps, 
to minimize the risk.

Backup and disaster recovery
Backup schedules and disaster recovery plans must be observed during the consolidation to 
avoid any time frames where particular data will not be backed up.
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Recovery planning
In addition to an overall recovery planning for your Lotus Domino infrastructure, you should 
include rollback plans in the list of your deliverables, especially for consolidation approaches 
with a high impact on several systems, where rollback plans, in case of unforeseen failures, 
are mandatory.

5.18  Final phase: closure
This phase will close the consolidation project, transitioning the systems back to ongoing 
operations and support. This phase includes:

� Acceptance report from the sponsor

� Finalization of all project documentation

� Completion of all technical documentation updates for the target environment

� Completion of a post-migration review and analysis of lessons learned

� Decommission of the original environment.

� Disposal or reallocation of any hardware or software remaining from the replaced system
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Chapter 6. Performing server consolidation 
- step by step examples

This chapter builds on the concepts discussed throughout this Redpaper, and gives practical 
examples of two common consolidation models:

� Example 1: Server consolidation

� Example 2: Domain consolidation

Each consolidation example will be mapped to the approach discussed in this Redpaper, 
followed by a description of the technical instructions to implement the consolidation:

1. Reasons for consolidation

2. The consolidation approach

3. The administrative model - before and after the consolidation

4. Project overview

5. Steps to implement

The goal of this chapter is to show how the approach discussed throughout this Redpaper 
can be used to implement real practical consolidation project examples. It provides step by 
step instructions for the consolidation in the example scenarios.

6
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6.1  Example 1: Server consolidation

For the sake of a presenting a realistic scenario example, we present a fictional company 
named ITSOK Insurance. 

ITSOK Insurance is a company with many small offices and mobile users located throughout 
the US. 

Lotus Notes was implemented in this organization with Release 4 in the mid 1990s. At the 
time, the main business drivers for the implementation of Lotus Notes were:

� Project teams needed a place to store project deliverables and to discuss the projects.

� Support teams and business users needed a repository for documentation.

� ITSOK Insurance saw benefits to providing e-mail access for their business users to share 
information with each other.

At that time, the organization chose to implement a hub server, a mail server, and an 
application server at their main head office site, and a small workgroup server at each of their 
small regional offices. Each of these regional general servers was configured as a shared 
Notes (Domino) server and file and print server for the local users at the site. The servers 
were connected by modem in a hub and spoke topology back to the hub server at the head 
office site, as shown in Figure 6-1.

Figure 6-1   Before consolidation: regional servers connected via modem to central hub

Regional Site

Regional Site

Regional Site 
general server

Regional Site

Notes clients 

Mail dbs

App dbs

Regional Site 
general server

Regional Site

Notes clients 

Mail dbs

App dbs

Central Site 
hub server

App dbs

Central Site 
hub server

App dbs

Modem link
Repl/Routing

Modem link
Repl/Routing

Modem link
Repl/Routing

Modem link
Repl/Routing

Notes clients 

Regional Site 
general server

Mail dbs

App dbs

Notes clients 

Regional Site 
general server

Mail dbs

App dbs
124 Domino 7 Server Consolidation: Best Practices to Get the Most Out of Your Domino Infrastructure



The main reasons for this approach were:

� Bandwidth costs were prohibitive for connecting the servers directly to each other, and for 
connecting via WAN link. Modem connection to the main hub was cheap and easy to 
implement.

� ITSOK Insurance already had relatively new workgroup servers at the regional sites. The 
architects designing the Notes server topology concluded that these servers had 
adequate capacity to handle both Notes and the file and print services. Although not 
technically a “supported” configuration, this was the only practical way in which the 
organization could cost-effectively implement their Notes environment.

Over time, the distributed nature of the ITSOK Insurance has remained relatively static. The 
Lotus Notes and Domino environment has grown and evolved to include several applications 
that are now considered business critical, the Internet and intranet site servers, and mail-in 
databases for interaction with ITSOK Insurance’s clients.

For the sake of simplicity, we will assume that ITSOK Insurance is currently using Lotus Notes 
and Domino 6.5.x. 

6.1.1  Reasons for consolidation

The technical and cost barriers that existed when ITSOK Insurance originally planned their 
Notes environment are no longer relevant factors for the architectural planning of their current 
and future Lotus Notes and Domino environment. 

ITSOK Insurance has reviewed Chapter 2, “Reasons for consolidation” on page 7 of this 
Redpaper. The ITSOK Insurance Management was particularly interested in reducing TCO 
and increasing ROI.

Cost reduction - Total Cost of Ownership (TCO) benefits
The ITSOK Insurance Business Unit Owners are interested in the cost-saving (TCO) 
opportunities that the consolidation will provide, since the IT Department directly 
cross-charges each department for the IT services they use. 

ITSOK Insurance expects to realize real TCO benefits from the consolidation of their Domino 
servers. ITSOK Insurance has identified that the cost reduction opportunities associated with 
the consolidation of their Domino servers mean that server consolidation is now feasible and 
desirable for ITSOK Insurance. Some of the main tangible, short-term savings they identified 
were:

� Server hardware: Costs for server hardware has reduced in real terms, and processing 
power has increased relative to the power required by the Notes and Domino software.

� Communications: The cost of fast wide area network (WAN) links has reduced 
dramatically, making network links between sites a viable option.

� Server software: Consolidation will result in fewer software licenses required for the 
Domino servers, and possibly for the operating system and other third-party software 
(such as backup software, virus scanning, and so on). In addition, the newer Domino 
server versions allow for higher scalability per server.

Note: Domino server licensing and maintenance uses a per-CPU model for servers 
accessed by Notes users. As long as the server consolidation results in fewer server 
CPUs overall, cost savings will result in most situations.
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ITSOK Insurance’s Lotus Notes and Domino environment has grown and evolved over time, 
both in terms of the business use of the technology and the features available within the 
technology. The small, shared workgroup servers in a distributed architecture is no longer 
technically viable or cost effective to manage. 

ITSOK Insurance has decided to consolidate to the head office servers, consisting of:

� A Mail Cluster containing two clustered Domino mail servers

� An Application Cluster containing two clustered Domino application servers

The small workgroup Domino servers at the regional sites will be decommissioned after the 
consolidation process is complete. 

Business benefits - Return On Investment (ROI)
ITSOK Insurance’s Business Unit Owners are also focussed on ROI opportunities that the 
consolidation will provide.

The main business unit of ITSOK Insurance is the Customer Service Department. This 
department consists of 80% of the organization’s overall user population. Most of these users 
work directly with the organization’s clients (the people who purchase insurance from them) 
via telephone and e-mail contact. All client, relationship, and case tracking related to this 
contact is recorded in Domino databases, which are considered to be business critical. If 
these users cannot connect to Domino for e-mail access, or for access to the applications, 
they cannot do their work. The Customer Service Department has therefore developed a very 
clear model for calculating the cost associated with Domino server data loss or unavailability.

The Business Analyst for the Customer Service Department worked with the Domino 
architecture team and the Business Unit Owner to map specific consolidation opportunities to 
improved ROI for this business unit. These are two of the many ROI benefits they saw:

� Domino clustering: Recently, the older regional Domino servers have experienced some 
reliability issues. The new centralized mail and application servers are clustered using 
Domino clustering, to provide failover in the event of single server outage.

ROI benefit: With the consolidated architecture in place, users will be able to continue to 
work even when a single mail or application server is unavailable. As the Customer 
Service department has calculated the cost of outage per minute, per user, investing in the 
consolidated Domino environment is expected to provide huge returns.

� Centralized backup and maintenance: Currently, each regional server has its own backup 
tape unit. A local non-technical Notes user is tasked with changing the tape each day. The 
older tape drive technology, old tape media, and human interaction is prone to errors and 
problems. Several important database updates have been lost due to media failure or 
human error. The new centralized infrastructure will include high-speed backup 
technologies that are expected to back up the data more reliably and more quickly.

ROI benefit: For the Customer Service department, loss of data means rekeying, which 
has direct staff costs. Even worse, some critical Insurance data has been lost in the past, 
and this may have legal implications for ITSOK Insurance. The new consolidated backup 
and server maintenance routines will reduce rekeying, which will allow the staff to spend 
more time pursuing new clients and contacting existing ones. Ensuring data backup 
integrity and completeness could also reduce ITSOK Insurance’s legal liability if they are 
called on to produce data for an insurance assessment.
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6.1.2  The consolidation approach

For the sake of simplicity, the remainder of this example scenario uses the following 
assumptions:

� ITSOK Insurance would like to consolidate their Domino servers onto the central head 
office site.

� Each of the sites is now connected via WAN link to the others (no original modem links 
remain).

� ITSOK Insurance management and business representatives are satisfied that the critical 
factors of reliability, availability, and serviceability will not suffer, and that Service Level 
Agreements (SLAs) will still be met with the new environment. They are clear about the 
expected TCO and ROI opportunities that the project is expected to realize for the 
organization.

The ITSOK Insurance Domino Architect reviewed 3.2, “Server consolidation models and 
techniques” on page 32 of this Redpaper. The decision was made to use the model for 
consolidating servers across two or more locations, since this most closely matched their 
requirements. The ITSOK Insurance Domino topology after server consolidation is shown in 
Figure 6-2.

Figure 6-2   After consolidation: Regional users connect to central Domino clustered servers via WAN
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6.1.3  The administration model - before and after the consolidation

When undergoing a server consolidation it is important to also review the model of 
administration to see whether it will fit the consolidated infrastructure or will need to be 
modified.

The ITSOK Insurance Domino Architect and the Administration Team Manager reviewed the 
administration model together to determine whether the server consolidation would 
necessitate changes to the administration model. They reviewed Chapter 4, “Administration 
models” on page 53, and in particular 4.6, “How to select an administration model” on 
page 65.

The core ITSOK Insurance Domino administration function is already centralized. The server 
consolidation will not necessitate changes to this model. 

Some peripheral support tasks will move with the server consolidation from being distributed 
in each regional location to being centralized at the head office site. For example, the server 
backup process for the regional servers is currently the responsibility of a non-technical 
representative on each regional site. After the consolidation, this task will no longer be 
required. The head office Network Operations team will be responsible for backups on the 
Domino servers. 

6.1.4  Project overview

The Consolidation Project Team has reviewed Chapter 5, “Project planning overview for 
performing server consolidation” on page 101 of this Redpaper and plan to follow this general 
project approach. The following is a short, high level summary of the steps that ITSOK 
Insurance will perform:

� Have a project sponsor that is involved in the project.

Based on the TCO and ROI benefits discussed in 6.1.2, “The consolidation approach” on 
page 127, the Business Unit Owner of the Customer Service department has agreed to be 
the project sponsor. As the manager of the largest and most critical Business Unit, the 
project sponsor has a clear understanding of the overall business strategy, objectives, and 
requirements.

� Define the project vision.

The project vision for ITSOK Insurance’s consolidation project is:

To provide guaranteed access to data from a centralized, fast, and well maintained 
messaging and collaboration environment. This consolidation will improve the efficiency of 
our business processes by reducing rework, thus providing opportunities for our staff to 
spend more time pursuing new Insurance business. Consolidation will commence within 
three months, and will be complete within nine months.

� Assemble the right project team.

The principal members of the project team are the Project Sponsor, Project Manager, 
Domino Architect, Domino Administrator, Domino Developer, and pilot user group. The 
team will also seek support and assistance from the Server Administration team, Network 
Administration team, and Help Desk team.

� Develop and maintain the project schedule.

The Project Manager has completed the project schedule, which allows ITSO Insurance to 
complete the project well within the nine month time frame. Additional time has been 
allowed after completion of the project for contingencies.
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� Project scope management.

The project scope has been agreed to by the Project Sponsor and the business, the 
project team members, and the Help Desk. Scope changes will be submitted by the 
Project Manager on a Scope Change Request document, so that Project Sponsor can 
agree to the changes, and the project team made aware of the change in scope.

� Document requirements.

The business requirements of the ITSOK Insurance project are to consolidate the Domino 
servers, to reduce cost, and increase reliability. This will be done by migrating regional site 
Notes users and mail, and Domino applications to the head office Domino cluster servers, 
and then decommissioning the regional Domino servers.

� Establish a communication plan.

The communication plan involves informing the ITSOK Insurance users on regional sites 
of the upcoming changes and the expected impact on them during the migration. 
Communication among the project team and the other supporting teams will occur through 
twice-weekly project update meetings, and establishment of a Project Quickplace to store 
project documentation, issues, tasks, and discussions.

� Set project expectations.

The project communication plan is designed to set and maintain realistic project 
expectations among the project team, supporting teams, the ITSOK Insurance 
management, and the users involved in the change. This communication, along with the 
regular project team meetings, is designed to ensure that expectations are clear and that 
there are no surprises during the project.

� Document the current Lotus Domino infrastructure.

The current Lotus Domino infrastructure and metrics have been thoroughly documented 
by the Domino architect, with the assistance of the Domino administrator, Server 
Administration team, and Network Administration team.

� Assessment of current administration model and service levels.

The ITSOK Insurance Domino Architect and Domino Administration Team manager 
reviewed the current administration model and made minor adjustments, as discussed in 
6.1.3, “The administration model - before and after the consolidation” on page 128.

� Develop the training plan.

The server consolidation project does not involve upgrading the Notes client, so users do 
not require training in new functionality. The communication plan is designed to educate 
the users about what to expect during the server consolidation project, and will provide 
any steps required of the users to facilitate the transition to the new servers. It is also 
important that the communication includes instructions on how users can contact the help 
desk if they need assistance during the transition. No further separate training plan is 
required.

� Plan, design, and document the consolidated Domino and Notes environment.

The consolidated Lotus Domino infrastructure is already in place. It was designed with 
sufficient capacity for the current head office users and the users who will be added during 
the server consolidation project. The new environment is consistent with ITSOK 
Insurance’s strategy of providing high availability through Domino clustering and failover, 
and reliable backup and recovery on the central servers.
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� Develop a migration and coexistence plan during consolidation.

The server consolidation will be carried out one regional server at a time. The migration 
plan separates the actual migration process for each server into a number of discrete 
steps. The coexistence period is expected to be around six months, but this should be 
transparent to users and is not expected to cause disruption or necessitate changes in 
normal work practices for users.

� Risk analysis.

The server consolidation will take a staged approach, with the migration being subdivided 
by regional server. This is expected to minimize the risk associated with the consolidation. 
The built in administrative features of Domino (for example, the Administration Process, 
the Decommission Server Analysis Tool, and Dynamic Client Configuration on the Notes 
client) are being used to automate and simplify the consolidation process, and to reduce 
the chance of human error. 

With these factors in mind, ITSOK Insurance analyzes the risk of the consolidation project 
to be low.

� Test and validation of consolidation approach.

After the consolidation approach and technical steps were planned by the Domino 
architect, these were validated by testing the entire process in the ITSOK Insurance test 
environment. This provided validation of the process, and an understanding of the time 
that the real migration would be expected to take.

� Run consolidation activities.

Consolidation activities are described in 6.1.5, “Steps to implement the server 
consolidation” on page 130.

� Final phase - project closure.

Project closure consists of two components: technical and project management. The 
technical task is concerned with making sure that the ITSOK Insurance regional servers 
are successfully decommissioned after the consolidation, and checking that any remaining 
issues are addressed. The project management closure task will ensure that project 
documentation is completed, a post implementation review is completed, and the Project 
Sponsor agrees to sign off that the project is complete.

6.1.5  Steps to implement the server consolidation

This section details the technical implementation tasks required to perform the server 
consolidation. 

ITSOK Insurance has already implemented a large mail server cluster at the head office site. 
The plan is to migrate users from the regional Domino servers to this central mail cluster. In 
this example, we will discuss the migration of users’ mail from one such site server 
(SmlSvr1/ITSOKinsurance) onto the new mail cluster, in particular to 
BigMail/ITSOKinsurance server, as shown in Figure 6-3 on page 131.
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Figure 6-3   The server consolidation: moving one regional site to the central mail cluster

For the purpose of this example, we will assume that the non-technical project tasks have 
been addressed. They will only be discussed here in reference to the technical parts of the 
project. Of the high level steps described in 5.1, “The key steps in a consolidation project” on 
page 102, the technical tasks for the project are undertaken in the “Run Consolidation 
Activities” stage of the project. These are the tasks that are described below.

Meeting the prerequisites
The focus of this task is:

Be sure that target servers, network capacities and other infrastructure are prepared prior to 
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In this task, the ITSOK Insurance Domino administrator needs to ensure that all the 
prerequisites for the move are in place at the head office site. The simple checklist in 
Table 6-1 was used for this purpose.

Table 6-1   Checklist for meeting the prerequisites

Move methodology: staged or instantaneous
ITSOK Insurance has decided that a staged methodology will be used to migrate the users 
onto the BigMail/ITSOKinsurance server. They made this decision for the following reasons:

1. The small regional servers each have between five and 50 users on them. The migration 
can be neatly subdivided and contained by server unit.

2. Using a staged approach will reduce the risk involved in the move.

3. Spreading the move over a longer time period will reduce the burden on the WAN link of 
the mail file moves.

4. The help desk will be able to better cope with any user issues that arise, since each group 
of users is likely to have issues only shortly after their migration.

Completing the move

Prerequisite Team responsible Comments Done (Tick)

Destination servers � Domino Admin
� Server Admin

� Disk capacity 
checked.

� Change window 
agreed with teams.

Network Capacities Network Admin � Mail file moves 
across WAN link 
must be done 
outside business 
hours so 
interactive traffic is 
not impacted (for 
example, SAP).

� Change window 
agreed with team.

Other Infrastructure Operations team Backup window 
checked, backup 
capacity checked.

Important: The steps used to complete the SmlSvr1/ITSOKinsurance mail users move 
were tested in a test environment first. We recommend that all production system changes 
are thoroughly tested in a non-production environment prior to rollout.

The procedures covered in this section describe one way in which a Domino server 
consolidation may be undertaken. The purpose of this section is to give you some ideas 
and guidelines for consolidating servers. Domino server consolidation can be done in other 
ways as well. For example, different or additional steps may be required to accommodate 
your specific Domino environment, or you may choose to reorder the steps described 
below to fit your own requirements. 

The procedures described here are guidelines only, and are designed to help you with your 
Consolidation Project.
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To complete the move for the SmlSvr1/ITSOKinsurance server, the Domino Administrator 
completes these tasks:

� Step 1: Prepare the users’ Notes clients.

� Step 2: Prepare for the AdminP mail file moves.

� Step 3: Run the Decommission Server Analysis Tool.

� Step 4: Move Resource Reservations.

� Step 5: Run mail user move procedure.

� Step 6: Manually move shared mail files and mail-in databases.

� Step 7: Move application databases.

� Step 8: Validate the move.

� Step 9: Decommission the server.

Step 1: Prepare the users’ Notes clients
The ITSOK Insurance Domino Administrator plans to use the Domino Administration Process 
(AdminP) to move the mail users. The “Move to another server” Administration Process 
automates the tasks required to move a mail user from one server to another within a Domino 
domain, including the updating of users’ Location document fields.

It is important to ensure that the Dynamic Client Configuration (DCC) process is enabled on 
each user’s Notes client. This process is responsible for updating the Location document 
fields after AdminP has completed the other mail move tasks. If this task is not enabled, the 
user will continue to use their mail file on the old server. When the old server is 
decommissioned, they will receive an error when they try to use their mail.

Tip: This task is not time critical; it can be completed any time prior to the planned user 
migration. We recommend completing this task well in advance of the actual migration.

Tip: DCC is enabled by default on Notes clients (for all R5 and newer client versions). 
Therefore, DCC will be enabled in your environment unless it has specifically been 
disabled for some other purpose.
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Checking that DCC is enabled
To check that DCC was enabled on the ITSOK Insurance Notes clients, do the following:

1. On a Notes client, open the local Address Book (names.nsf).

2. Open the Advanced → Locations view.

3. Highlight the Location document currently in use on the client (usually “Office”).

4. From the menu, select File → Document Properties.

5. Go to the Fields tab in the Document Properties dialog, highlight the AcceptUpdates 
field, and check the value of the field, as shown in Figure 6-4.

Figure 6-4   Checking whether DCC is enabled on the Notes client

6. The value of the AcceptUpdates field will be either:

– 0: DCC is disabled.

– 1: DCC is enabled.

Checking that DCC is actually running
If DCC is enabled, check that it is actually running on the PC:

1. On the Notes client, open the local log file (log.nsf).

2. Open the Miscellaneous Events view.

3. Open a recent log document and search for “Dynamic”.

4. If DCC is running on the client, you will see log entries similar to those shown in 
Figure 6-5.

Figure 6-5   Client log.nsf showing DCC has run

Tip: It may be easiest to search for “Dynamic” in the view. DCC usually runs shortly 
after the Notes client is started, but if other background tasks are running or the users 
closes the client almost immediately, DCC may not get a chance to run (or may show 
further down in the log document).
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If DCC is enabled but not running, or you require further information, refer to Technote 
#1212699 “Frequently Asked Questions About Dynamic Client Configuration (DCC)” at: 

http://www.ibm.com/support/docview.wss?rs=899&uid=swg21212699

How to enable DCC if it is not currently running
To enable DCC if it is not running on a single Notes client:

1. On the Notes client, edit the current Location document by clicking the Location in the 
Location Status Bar (bottom right corner of the client) and selecting Edit Current....

2. From the menu, select Options → Advanced → Set Update Flag.

3. In the Location Update Settings dialog, select Yes to enable DCC, as shown in Figure 6-6.

Figure 6-6   Location Update Settings dialog: select Yes to enable DCC

4. Check the Document Properties to ensure that the AcceptUpdates field is now set to “1”.

Step 2: Prepare for the AdminP mail file moves
For the Administration Process to successfully complete the Move to Another Server AdminP 
tasks, the source server (SmlSvr1/ITSOKinsurance) for the moves must have the authority to 
be create new replicas on the destination server (BigMail/ITSOKinsurance).

To enable SmlSvr1 to create the mail file replicas on the BigMail server, the ITSOK Insurance 
Administrator did the following:

1. In the Domino Administrator client, go to the Configuration tab and open the 
Administration server (AdminSvr/ITSOKinsurance).

2. Select the Server -> All Server Documents view.

3. Highlight the destination server for the mail move (BigMail/ITSOKinsurance) and click the 
Edit Server button. 

Note: Choosing this option does not actually tell you what the flag is currently set to 
(that is, you cannot discover whether DCC is already enabled using this procedure). To 
determine whether DCC is already enabled, use the procedure described in “Checking 
that DCC is enabled” on page 134.

Note: If you find that all you users currently have DCC disabled, it may be possible to 
enable it for all users using a PostOpen script or similar on a database that every user 
opens (such as the mail files or bookmark.nsf), to update the AcceptUpdates field. 

For further information and sample code to do this function, refer to Technote 1092794 
“How to use LotusScript to change fields in all Location documents” at:

http://www.ibm.com/support/docview.wss?rs=899&uid=swg21092794
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4. Go to the Security tab, and in the Server Access section, in the Create new replicas field, 
fill in the name of the server, or the server group, as shown in Figure 6-7.

Figure 6-7   Setting the Server Access fields to enable Adminp mail file moves

5. Save and close the Server document.

6. Replicate the Domino Directory from the Administration server 
(AdminSvr/ITSOKinsurance) to the source (SmlSvr1/ITSOKinsurance) and destination 
(BigMail/ITSOKinsurance) servers.

Step 3: Run the Decommission Server Analysis Tool
The Decommission Server Analysis Tool (introduced in Domino R5) produces a report that 
contains an analysis of the differences between the source and destination servers, and 
potential areas requiring attention. It allows experienced Domino administrators to quickly see 
where to focus their manual and automatic move tasks.

The tool produces a report that contains the categories shown in Figure 6-8.

Figure 6-8   Decommission Server Analysis - results categories

Tip: In most cases, it is safe to fill in both the Create databases & templates field and 
the Create new replicas field with the LocalDomainServers and LocalDomainAdmins 
groups. This will ensure that future database and replica creation processes will work. 
The example shown in Figure 6-7 has both these fields populated.
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Each comparison area that resulted in a difference or indicates that attention is required is 
shown with the eyeglasses icon (refer to Figure 6-8 on page 136).

For additional information about the Decommission Server Analysis Tool, refer to the topic 
“Decommissioning a Server” in the Lotus Domino Administrator 7 Help database.

How to produce a Decommission Server Analysis report
The ITSOKinsurance Domino administrator wants to run the Decommission Server Analysis 
Tool prior to moving any of the databases or users from the SmlSvr1 server. The 
administrator knows that the mail files will need to be moved to the destination BigMail server, 
but wants to ensure that other areas such as local Teamrooms and mail-in databases are 
included in the move.

To create a Decommission Server Analysis report, the ITSOK Insurance Administrator did the 
following:

1. In the Domino Administrator client, open the BigMail/ITSOKinsurance server.

2. Select Server and then the Analysis tab.

3. From the menu, select Analyze → Decommission Server....

4. In the Decommission Server Analysis dialog:

a. In the Source Server field, select the server to be decommissioned (SmlSvr1).

b. In the Target Server field, select the consolidation server (BigMail).

c. Click Results Database to choose a server location and database name for the results 
database.

d. Select a radio button to Append to the database or Overwrite the database.

e. The completed dialog box is shown in Figure 6-9 on page 138. Click OK to create the 
report and open the Results database.

Tip: If this is the first report you have created, select Overwrite the database. This 
will automatically create the database using the location and database name 
specified in the “Results database” setting (Step c of this procedure). Selecting 
Append to this database will result in an error indicating that the database does 
not exist.
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Figure 6-9   Decommission Server Analysis dialog

How to Use the Decommission Server Analysis report

Figure 6-10   Reports categorized by source server

Tip: If you are using the Decommission Server Analysis Tool to analyze many servers, 
create a view to categorize the reports by Source Server (categorize based on the 
SourceServer field). An example of such a view is shown in Figure 6-10.
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Not all of the categories in the report are of interest to the ITSOK Insurance Administrator, as 
some are more relevant for domain merges, SMTP servers, clustered servers, and so on. The 
main areas of interest for the SmlSvr1 are shown in Table 6-2.

Table 6-2   Server Analysis Tool - areas of interest for small Domino server migration

Step 4: Move Resource Reservations
Each regional Domino server at ITSOK Insurance has its own Resource Reservations 
database. There are three ways in which the move of Resource Reservations can be handled 
during the consolidation. The options and advantages of each are described in Table 6-3.

Table 6-3   Advantages and disadvantages of Resource Reservation move options

Category What to check

Connections Check that Connection Documents exist between 
the source and destination server, for replication 
and mail routing during the co-existence period. 
Create Connection documents if they do not 
exist.

Databases This shows where there are mismatches in 
several areas. Of interest are:
� No matching replicas: Non-mail databases 

that exist on the source but not the 
destination. This will help the Administrator 
manage the move of non-mail databases

� Mail-in databases: Shows where they exist 
on the source but not the destination. It is 
important to manage the move of these 
databases and the associated configuration 
manually

� Rooms and Resources: The organization will 
need to decide how rooms and resources will 
be migrated. For example, will they be 
recreated on the destination server? Will 
future reservations be lost?

� Mail users: Provides a list of users with their 
Mail server set as the source server. This is a 
useful list to use for the mail move process

Note: Different categories in the Decommission Server Analysis Tool report may be of 
interest to your organization. The areas of interest will depend on the size and purpose of 
the source server. Check the report carefully to understand your own server’s areas of 
interest.

Option Advantages Disadvantages

1. Move existing source 
server’s Resource 
Reservation database to 
the destination server, and 
retain it on the destination 
server.

� This is relatively simple to 
implement; it requires only 
replication of the database 
and update of the Mail-in 
Database documents for 
the Rooms and Resources 
(to reflect the new server 
location).

� Existing reservations are 
retained.

This is the most difficult option 
to administer ongoing; it 
requires management of many 
separate Resource 
Reservation databases instead 
of just one.
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The ITSOK Insurance project team has decided to choose option 1, so the Domino 
Administrator needs to migrate the existing Resource Reservations database from the source 
server to the destination server.

To complete the Resource Reservations migration, do the following:

1. Replicate the SvrSvr1 Resource Reservations database to the BigMail server, giving it a 
new file name (so it does not clash with the Resource Reservations database already on 
the destination server).

2. Update the Mail-in Database documents in the Domino Directory for the Rooms and 
Resources that have been moved:

a. Open the Domino Directory on the destination server (BigMail) and go to the Mail-in 
databases and resources view.

b. Edit each Mail-in Database document for the Rooms and Resources that have been 
moved.

2. Migrate the resources and 
reservations in the source 
server’s Resource 
Reservations database to 
the existing Resource 
Reservations database on 
the destination server.

� Easy to administer ongoing; 
it requires management of 
only one Resource 
Reservations database.

� Existing reservations are 
retained.

� This is the most difficult 
option to implement; it 
requires careful planning, 
and several implementation 
steps to ensure that Sites, 
Resources, Rooms, and 
Reservations are properly 
moved and that 
autoprocessing works after 
the move.

3. Create new Site, Room, 
and Resource documents 
in the existing destination 
server’s Resource 
Reservations database. 
Decommission the source 
server database without 
migrating the existing 
reservations.

� Simplest option to 
implement; it requires only 
the creation of the new 
Sites, Rooms, and 
Resources in the 
destination server’s 
Resource Reservations 
database

� Produces a “clean start” 
result; this may be desirable 
for organizations where 
users have created 
repeating meetings years 
into the future, or otherwise 
booked up meeting rooms 
inappropriately.

� Requires communication to 
users so they understand 
that they will need to 
recreate reservations.

� Is likely to be the most 
disruptive option for users.

Tip: This task is not time critical; it can be completed any time prior to the planned user 
migration. It should, however, be done outside of normal office hours so that the complete 
migration occurs without users attempting to make reservations. 

We recommend completing this task well in advance of the actual migration.

Option Advantages Disadvantages
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c. Update the “Server” field to the destination server name, as shown in Figure 6-11.

Figure 6-11   Changing the Server and file name fields when moving the Resource Reservations database to a new server

d. Save and close the document.

Figure 6-12   Sample agent to modify Server field in Mail-in Database documents

3. Replicate the Domino Directory from the destination server (BigMail) to the source server 
(SmlSvr1).

4. Servers may need to be restarted (or type tell sched val at the server consoles to reload 
the scheduler configuration).

Step 5: Run mail user move procedure

How to Initiate the user and mail file moves
To complete the move of mail users and files from the source server (SmlSvr1) to the 
destination server (BigMail), the ITSOK Insurance Domino administrator used the “Move to 
another server” tool. The administrator did the following:

1. In the Domino Administrator client, open the source server (SmlSvr1), and go to the 
People & Groups tab.

Note: If there are many Mail-in Database documents to update, you may choose to 
write a simple agent to change them all. The agent could use the Simple Action 
“Modify Field” to replace the MailServer field and the MailFile field on selected 
documents. A sample of such an agent (showing the MailServer field change) is 
shown in Figure 6-12. Notice that the new value has the full hierarchical name of the 
server (that is, CN=<CommonName>/O=<OrgName>).

Note: This procedure should be completed outside of normal business hours. This will 
minimize the impact of the mail file moves on the WAN links, and ensure that the process is 
ready for user interaction when users next log on to their Domino Home/mail server.
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2. Open the People view.

3. In the view, select the users to move, as shown in Figure 6-13.

Figure 6-13   Selecting users to move

4. From the Tools panel, select People → Move to another server....

5. The Move User(s) to Another Server dialog will be displayed (shown in Figure 6-14).

Figure 6-14   Move User(s) to Another Server dialog

6. Click OK to submit the request to AdminP. A dialog will display to indicate that the request 
has been submitted.

Note: The ITSOK Insurance Domino administrator has selected to create a replica of 
the mail files on the other server in mail cluster.

Verify number of users selected
to move.

Select the destination Mail server.

Verify or change the new
subdirectory for the mail files.

If the destination server is a
cluster-member, you will see the
option to create a replica of the 
mail file on the cluster member.
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7. Ensure that replication of the Domino Directory and Administration Requests databases is 
occurring between the source and destination servers (replicate these two databases 
manually if desired).

How AdminP processes the move
The Administration Requests database contains a record of all the requests generated for 
each Move to Another Server request. Check the Administration Requests database to 
ensure the tasks have completed successfully for your users, and that no requests are in error 
or are continually in a pending state. 

Figure 6-15 shows a successfully completed Move to Another Server request for a single 
user. Each request should be present and have an action with a either tick icon next to it, or 
an eyeglasses icon to indicate that the request is completed with comments. For further 
information about the Administration Requests involved in the Move to Another Server 
request, refer to the topic “Move a Mail File from one server to another” in the Lotus Domino 
Administrator 7 Help database.

Figure 6-15   Administration Requests associated with a successfully completed Move to Another 
Server request

If a request has failed, a red cross will show in the view, and subsequent dependent requests 
may not be created. Open the response document for the failed request and check the error 
text in the document for clues about the problem.

Completing the move
To complete the Move to Another Server process, the Domino administrator must approve the 
“Approve mailfile deletion” request. Do this in the Administration Requests database, in the 
Pending → Pending By Server view, as shown in Figure 6-16 on page 144. 
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Figure 6-16   Approving a Mail File deletion request in the Administration Requests database

What happens on the Notes client
During the Move to Another Server process, AdminP updates the fields in the Notes user’s 
Person Document in the Domino Directory relating to the mail file location. When the Notes 
user next opens their Notes client and Dynamic Client Configuration (DCC) runs, the following 
events take place on the Notes client:

1. The Location documents in the Local Address Book (names.nsf) that have DCC enabled 
are updated with the new server name in the Home/mail server field.

2. The Bookmark Bar mail icon and the Workspace icon are updated to point to the 
destination server.

3. If the user already has their mail file open on the source server, they will continue to use 
the mail file on the source server until they close the file. When the file is closed, the 
Workspace icon for the source server is removed.

4. The next time the user opens their mail file on the server, the replica on the new mail 
server (the destination server) will be opened.

This process occurs in the background, so is basically transparent to the user (the status bar 
does indicate that the client is connecting to the destination server).

To check whether the process has occurred on the Notes client, check any (or all) of the 
following:

� The Status Bar on the Notes client will indicate the initial connection to the source server, 
then a second connection, to the destination server, as shown in Figure 6-17.

Figure 6-17   Status bar while Move to Another Server process in occurring on the client

Note: A single request cannot be approved from within the view. To approve a single 
request only, edit the Approve Mail File Deletion document and use the Approve Mail File 
Deletion button in the document.

Note: All Location documents that have DCC enabled will be updated, not just the 
current Location document.
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� The local log file on the Notes client (log.nsf) will indicate that DCC has run and has 
updated the Location document fields, as shown in Figure 6-18.

Figure 6-18   Log messages for DCC updating Home/mail server in Location documents

� The Location documents that have a connection to a Home/mail server (usually “Office”, 
“Travel”, “Home”, and so on) will have the Home/mail server field populated with the 
destination server. 

Step 6: Manually move shared mail files and mail-in databases
Shared mail files that are accessed by a group of people need to be moved manually by the 
Domino administrator. In addition, unlike personal mail files, the Bookmark and Workspace 
icons for shared mail files need to be manually updated on the Notes client.

The two most common shared mail file configurations are:

1. Mail-in databases that are accessed by a group of users.

2. Mail databases that are accessed by a group of users, and have a Person document 
associated with them that specifies the shared mail file in the Mail File field.

The SmlSvr1/ITSOKinsurance server has several mail-in databases that are accessed by a 
group of users. Here is how one such database, the Customer Service Feedback database, 
was moved by the Domino administrator:

1. In the Domino Administrator client, open the source server (SmlSvr1), and go to the Files 
tab.

2. Highlight the Customer Service Feedback database in the view.

3. From the Tools window, select Database → Move....

4. Replicate the Administration Requests database between the source and destination 
servers

5. Check the Administration Requests database for the “Approve Deletion of Moved Replica” 
request in the Pending Administrator Approval → Individual Approval Required view. 
Existence of this request shows that the new replica has been created and the old replica 
is ready to be deleted

Tip: This section has described the procedure for updating standard Notes (non-roaming) 
users. For information about moving Roaming Notes users to a new server, refer to 
Technote 1099795 “How To Move a User's Roaming Files to Another Domino Server” at:

http://www.ibm.com/support/docview.wss?rs=899&uid=swg21099795
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6. Edit the Approve Deletion of Moved Replica document and click the Approve Mail File 
Deletion button.

7. Check that Administration Request database to ensure that the entire move process 
completed with no errors. The result of a successful Move Database process is shown in 
Figure 6-19.

Figure 6-19   Move Database Administration Request documents

8. While still in the Domino Administrator client, open the People & Groups tab.

9. Go to the Mail-in Databases & Resources view.

10.Edit the Mail-in Database document for the database that has been moved (the Customer 
Service Feedback database).

11.Update the Server field to the destination server name.

12.Save and close the document

13.Replicate the Domino Directory between the source and destination servers.

The procedure above will ensure that any new mail sent to the database will be successfully 
delivered. Users who try to access the database on the old (source) server will, however, be 
prompted with the dialog shown in Figure 6-20.

Figure 6-20   Database not found dialog

Tip: Replica deletion is a “Timed” type Administration request. To initiate the deletion 
immediately, at the server console of the source server, type: 

tell adminp process timed

Tip: To move a shared mail database that has a Person document associated with it, use 
the same procedure as described above, but in steps 9 to 12, instead of updating the 
Mail-in Database document, update the Person document associated with the shared mail 
file.
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Users will need to choose the name of the new (destination) server in this dialog to enable 
them to open the database on the new server. This procedure only needs to be completed 
once by each user for each database that is moved.

Step 7: Move application databases
Prior to moving application databases, analyze the database to search for hardcoded server 
references. Have the developer of the database update the code to remove the hardcoded 
server references (or update them for the new server). Also, make a list of agents that are 
currently set to run on the source server.

Application databases may be moved using the “Move database” Administration Tool, as 
described in the previous procedure (“Step 6: Manually move shared mail files and mail-in 
databases” on page 145), omitting Steps 8 to 13.

After the database has been moved, change the agents to run on the new (destination) 
server.

Tip: It may be possible to use a tool to automatically update database icons or redirect 
users to the replica on the new server. For one example of such a tool, refer to Technote 
#1094781 “Is there a way to automatically update Db icon/bookmark to point to different 
Domino server if database has been moved?” at: 

http://www.ibm.com/support/docview.wss?rs=899&uid=swg21094781

Third-party tools for this purpose also exist.

Attention: It is beyond the scope of this Redpaper to describe the full database testing that 
may be required for a server move. Be aware that each custom database in your Domino 
environment may have specific testing and validation requirements. Work with your 
Domino Application Development team to develop and implement a full test plan for 
business critical applications.

Tip: Use the Decommission Server Analysis report created in “Step 3: Run the 
Decommission Server Analysis Tool” on page 136 to determine which application 
databases exist on the source server but not the destination server. These will be listed in 
the “Databases - No matching replica” document.
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Step 8: Validate the move
It is important to validate that all users, mail files, resources, application databases, and other 
documents have been moved to the destination server prior to server decommissioning. 

To validate that the SmlSvr1 server is ready for decommissioning, the ITSOK Insurance 
Domino Administrator used the simple checklist shown in Table 6-4.

Table 6-4   Checklist for server decommissioning

Step 9: Decommission the server
If possible, it is worthwhile retaining the old (source) server for a short while after it has been 
officially decommissioned. Once all tasks in the “Step 8: Validate the move” on page 148 have 
been completed, the server can safely be decommissioned.

We recommend that the server be switched off outside of normal business hours in case a 
problem does result.

After the server has been switched off:

� Disable any Connection documents in the Domino Directory with a Source or Destination 
server set as the decommissioned server.

� Check the log or server console on the new (destination) server and any other servers that 
previously interacted with the decommissioned servers. Look for errors trying to route or 
replicate with the decommission server. Fix the cause of these problems.

� Check on the destination server for errors relating to the decommissioned server, such as 
agents that are not running.

Area to check Comments Complete (tick)

Decommission Server Analysis 
report

Check all the documents in the 
report that show the eyeglass 
icon in the view. Ensure that all 
noted differences and potential 
problems have been addressed 
during the move.
You may choose to run another 
report, to check whether any 
differences or problems are still 
noted.

Administration Requests 
database

Check the Administration 
Request documents for:
� Move database requests
� Move To Another Server 

requests (moving mail files)
� Any other Administration 

requests you generated for 
the migration

Help desk records Check for recurring problems 
logged by users to your 
organization’s help desk. Meet 
with the Help Desk Manager to 
discuss any outstanding issues 
they are aware of (and tell them 
you plan to decommission the 
source server soon).
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� Monitor the Help Desk problem queue and work with the Help Desk team to resolve any 
remaining issues.

6.2  Example 2: Domain consolidation

For the sake of a presenting a realistic scenario example, we present a fictional company 
ITSObig, a large retail organization. 

ITSObig is a large retail organization that has invested heavily in both Notes and Domino 
technologies, and in business expansion. They recently purchased a smaller retailer, 
ITSOsmall, which also uses Notes and Domino for e-mail and collaboration.

After the acquisition, ITSObig’s administrators cross-certified the two Domino domains, so 
that direct Notes to Notes mail routing could occur, and some simple discussion databases 
could be shared. ITSOsmall’s users and existing servers are now physically co-located with 
ITSObig’s, at the head office site. The current topology is shown in Figure 6-21.

Figure 6-21   Topology prior to domain consolidation

For the sake of simplicity, we will assume that both these organizations are currently using 
Lotus Notes and Domino 6.5.x. 

Domino app servers

MailSvr/ITSOsmall

ITSOsmall Domino Domain

HubSvr/ITSObig

ITSObig Domino Domain
ITSObig Head Office

Domino app servers Repl/Routing

Mail dbs

App dbs

dbs
Mail dbs
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6.2.1  Reasons for consolidation

With the acquisition of ITSOsmall, the extra Domino domain has added complexity and 
overhead to the Domino environment. ITSObig has reviewed Chapter 2, “Reasons for 
consolidation” on page 7 of this Redpaper. 

ITSObig considered the main reasons for domain consolidation to include:

� Reduction or control of IT costs

Support staff: The ITSOsmall Domino administrator and other ITSOsmall support staff will 
be redeployed into other positions after the domain consolidation, as the current ITSObig 
Administration team will be able to manage the consolidated domain with current resource 
levels.

� Improved data access and protection

Improved enterprise data security: The Domino security model will be consistent across all 
servers and all applications, reducing administration complexity while improving overall 
security.

� Reduced technical complexity

Consolidation will help to reduce the technical complexity of the environment by reducing 
the number of groups, domains, certifiers, cross certificates, and other components 
required to manage a multi-domain environment.

6.2.2  The consolidation approach

For the sake of simplicity, the remainder of this example scenario uses the following 
assumptions:

� The steps described in this procedure represent those required to merge the users in the 
MailSvr/ITSOsmall Domino server in the ITSOsmall domain into the ITSObig Domino 
domain.

� All users are currently co-located on the same physical site, and the servers in the two 
domains have already been cross-certified. Connection documents for mail routing and 
replication are in place for connection between MailSvr/ITSOsmall and HubSvr/ITSObig, 
and the Resource Reservations database in the ITSObig domain is being used by users in 
both domains.

The ITSObig Domino Architect reviewed 3.3, “Domino domain consolidation models and 
techniques” on page 43 of this Redpaper. The decision was made to use model for 
consolidating Domino domains by moving whole servers. The ITSObig domain after 
consolidation is shown in Figure 6-22 on page 151.
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Figure 6-22   ITSObig Domino domain after consolidation

The ITSObig management was comfortable with this approach because they considered it 
less risky to merge the ITSOsmall domain without moving users onto different servers at the 
same time. They have decided to separate the server consolidation into a separate project 
phase (where they will use the procedures described in 6.1, “Example 1: Server 
consolidation” on page 124).

6.2.3  The administrative model before and after the consolidation

When undergoing a domain consolidation, it is important to also review the model of 
administration to see whether it will fit the consolidated infrastructure or will need to be 
modified.

The ITSObig Domino Architect and the Administration Team Manager reviewed the 
administration model together to determine whether the domain consolidation would 
necessitate changes to the administration model. They reviewed Chapter 4, “Administration 
models” on page 53, and in particular 4.6, “How to select an administration model” on 
page 65.

The ITSOsmall Domino domain was originally administered by the Domino administrator from 
the ITSOsmall company. Prior to the domain consolidation, this administrator has continued 
to administer the ITSOsmall domain. When the two domains were cross certified and began 
sharing databases, the ITSObig Administrators were added to the administration groups in 
the ITSOsmall Domino Directory to enable them to help manage the domain until 
consolidation occurred.

The domain consolidation is an opportunity for ITSObig to streamline the administration 
process. The merged domain can be managed by the same number of administrators as 
were already used to manage the ITSObig domain, so the ITSOsmall administrator will most 
likely be retrained and relocated to another role within the ITSObig IT department. 

MailSvr/ITSOsmall

ITSOsmall Domino Domain

HubSvr/ITSObig

ITSObig Domino Domain

ITSObig Head Office
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6.2.4  Project overview

The Consolidation Project Team has reviewed Chapter 5, “Project planning overview for 
performing server consolidation” on page 101 of this Redpaper and plan to follow this general 
project approach. The following is a short, high level summary of the steps that ITSObig will 
perform:

� Have a project sponsor that is involved in the project.

The CIO has agreed to sponsor the domain consolidation project, as the cost savings and 
benefits of the consolidation are considered significant. The CIO will work to emphasize 
the importance of this project and help ensure the project team gets the cooperation they 
need from all areas of the company.

� Define the project vision.

The project vision for ITSObig’s consolidation project is:

To streamline and simplify the Domino environment, and to provide a consistent, secure 
and easily manageable collaboration environment for all ITSObig staff. Consolidation will 
commence within two months, and will be complete within seven months.

� Assemble the right project team.

The principal members of the project team are the Project Sponsor, Project Manager, 
Domino Architect, Domino Administrators (one from ITSObig domain and one from 
ITSOsmall domain), Domino Developer, and pilot user group. The team will also seek 
support and assistance from the Server Administration team, Network Administration 
team, and Help Desk team.

� Develop and maintain the project schedule.

The Project Manager has completed the project schedule, which allows ITSObig to 
complete the project well within the five month time frame. Additional time has been 
allowed after completion of the project for contingencies.

� Project scope management.

The project scope has been agreed to by the Project Sponsor and the business, the 
project team members, and the Help Desk. Scope changes will be submitted by the 
Project Manager on a Scope Change Request document, so that Project Sponsor can 
agree to the changes, and the project team made aware of the change in scope.

� Document requirements.

The requirements of the ITSObig project are to consolidate the Domino domains, to 
reduce cost, streamline administration, and improve Domino security. This will be done by 
migrating the ITSOsmall Domino servers and users into the ITSObig Domino domain and 
into the ITSObig Domino Organizational Certificate structure. Consolidating the actual 
servers will be done at a later date as a separate project.

� Establish a communication plan.

The communication plan involves informing the ITSOsmall users of the upcoming changes 
and the expected impact on them during the migration. Communication among the project 
team and the other supporting teams will occur through twice-weekly project update 
meetings, and establishment of a Project Quickplace to store project documentation, 
issues, tasks, and discussions.

� Set project expectations

The project communication plan is designed to set and maintain realistic project 
expectations among the project team, supporting teams, the ITSObig management, and 
the users involved in the change. This communication, along with the regular project team 
152 Domino 7 Server Consolidation: Best Practices to Get the Most Out of Your Domino Infrastructure



meetings, is designed to ensure that expectations are clear and that there are no 
surprises during the project.

� Document the current Lotus Domino infrastructure.

The current Lotus Domino infrastructure and metrics have been thoroughly documented 
by the Domino architect, with the assistance of the Domino administrator, Server 
Administration team, and Network Administration team.

� Assessment of current administration model and service levels.

The ITSObig Domino Architect and Domino Administration Team manager reviewed the 
current administration model and plan to make some adjustments after the consolidation, 
as discussed in 6.2.3, “The administrative model before and after the consolidation” on 
page 151.

� Develop the training plan.

The domain consolidation project does not involve upgrading the Notes client, so users do 
not require training in new functionality. The communication plan is designed to educate 
the users about what to expect during the domain consolidation project, and will provide 
any steps required of the users to facilitate the transition to the new domain. It is also 
important that the communication includes instructions on how users can contact the help 
desk if they need assistance during the transition. No further separate training plan is 
required.

� Plan, design, and document the consolidated Domino and Notes environment.

The consolidated Lotus Domino infrastructure is already in place. No physical server 
hardware will be added or removed from the Domino environment as part of the domain 
consolidation project. The areas of change in the consolidated environment have been 
documented. These changes include the security model, cross domain administration, 
certificates and certifier IDs, management of user IDs, and groups and group 
management. The ITSObig Domino policies, procedures, and standards documentation 
was reviewed and either validated or updated as needed, as part of this process.

� Develop a migration and coexistence plan during consolidation.

The migration plan separates the migration process into a number of discrete steps. The 
coexistence period is expected to be less than five months, but this should be transparent 
to users and is not expected to cause disruption or necessitate changes in normal work 
practices for users.

� Risk analysis.

The approach of breaking down the consolidation into discrete steps allows a minimization 
of the risk associated with this project. The project is broken into discrete steps that can 
each be completed without dependencies on preceding or subsequent steps. This 
minimizes the risk associated with the consolidation project, and allows each step to be 
completed within a reasonable time frame, in a planned outage period (outside of normal 
business hours) where backout time is available. 

The built in administrative features of Domino (for example, the Administration Process, 
Policies, and Dynamic Client Configuration on the Notes client) are being used to 
automate and simplify the consolidation process, and to reduce the chance of human 
error. 

With these factors in mind, ITSObig analyzes the risk of the consolidation project to be 
low.
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� Test and validation of consolidation approach.

After the consolidation approach and technical steps were planned by the Domino 
architect, these were validated by testing the entire process in the ITSObig test 
environment. This provided validation of the process, and an understanding of the time 
that the real consolidation would be expected to take.

� Run consolidation activities.

Consolidation activities are described in 6.2.5, “Steps to implement the server 
consolidation” on page 154.

� Final phase - project closure.

Project closure consists of two components: technical and project management. The 
technical task is concerned with making sure that the ITSOsmall Domino domain servers 
and users are successfully integrated into the ITSObig Domino domain (including the 
ITSObig Organizational Certificate structure), and checking that any remaining issues are 
addressed. The project management closure task will ensure that project documentation 
is completed, a post implementation review is completed, and the Project Sponsor agrees 
to sign off that the project is complete.

6.2.5  Steps to implement the server consolidation

This section details the technical implementation tasks required to perform the server 
consolidation. 

For the purpose of this example, we will assume that the non-technical project tasks have 
been addressed. They will only be discussed here in reference to the technical parts of the 
project. Of the high level steps described in 5.1, “The key steps in a consolidation project” on 
page 102, the technical tasks for the project are undertaken in the “Run Consolidation 
Activities” stage of the project. These are the tasks that are described below.

Meeting the prerequisites
The focus of this task is:

Be sure that target servers, network capacities and other infrastructure are prepared prior to 
starting consolidation.

In this task, the ITSObig Domino administrator needs to ensure that all the prerequisites for 
the Domain merge are in place. The simple checklist in Table 6-5 on page 155 was used for 
this purpose.
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Table 6-5   Checklist for meeting the prerequisites

Completing the move

In this example, The ITSObig administrator will be merging a single server, 
MailSvr/ITSOsmall@ITSOsmall, into the ITSObig Domino domain. All users on the 
ITSOsmall server will also be merged into the ITSObig domain, and both the server and users 
will be renamed under the /ITSObig certifier. 

Prerequisite Team responsible Comments Done (Tick)

Destination servers � Domino Admin
� Server Admin

Destination servers 
are not being changed 
for this project. 
Change window for the 
Domain merge has 
been agreed with 
teams.

Network Capacities Network Admin Databases are not 
being moved for this 
project. Replication of 
the Domino Directory 
and Administration 
Requests database 
will be required. 
Change window has 
been agreed with 
team.

Other Infrastructure Network Changes to DNS and 
mail (MX) records 
need to be arranged (if 
Internet mail domains 
are also being 
changed).

Important: The steps used to merge the ITSOsmall Domino domain were tested in a test 
environment first. We recommend that all production system changes are thoroughly 
tested in a non-production environment prior to rollout.

The procedures covered in this section describe one way in which a Domino domain 
merge may be undertaken. The purpose of this section is to give you some ideas and 
guidelines for merging domains. Domino domain merging can be done in other ways as 
well. For example, different or additional steps may be required to accommodate your 
specific Domino environment, or you may choose to reorder the steps described below to 
fit your own requirements. 

Use the procedures described here guidelines to help you with your Consolidation Project.
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To complete the domain merge for the ITSOsmall Domino domain, the Domino Administrator 
completed these tasks:

� Step 1: Prepare the users’ Notes clients

� Step 2: Change the ITSOsmall domain to ITSObig

� Step 3: Create a cluster for the servers

� Step 4: Rename the Domino server and add it to the cluster

� Step 5: Ensure that users can connect to the new server name

� Step 6: Rename the users with the ITSObig certifier

� Step 7: Validate the changes

Step 1: Prepare the users’ Notes clients
The ITSObig Domino Administrator plans to utilize the Dynamic Client Configuration (DCC) 
background task on the Notes clients to update the user’s Location document fields during 
the domain merge.

It is important to ensure that the Dynamic Client Configuration (DCC) process is enabled on 
each user’s Notes client. This process is responsible for synchronizing the Location document 
fields in the local Address Book (names.nsf) with those in the user’s Person document on the 
Domino server. If the DCC task is not enabled, the user may have difficulty addressing mail 
properly after the merge has taken place.

Checking that DCC is enabled
To check that DCC was enabled on the ITSOsmall Notes clients, do the following:

1. On a Notes client, open the local Address Book (names.nsf).

2. Open the Advanced → Locations view.

3. Highlight the Location document currently in use on the client (usually “Office”).

4. From the menu, select File → Document Properties.

5. Go to the Fields tab in the Document Properties dialog, highlight the AcceptUpdates 
field, and check the value of the field, as shown in Figure 6-23 on page 157.

Tip: This task is not time critical; it can be completed any time prior to the planned domain 
merge. We recommend completing this task well in advance of the actual merge.

Tip: DCC is enabled by default on Notes clients (for all R5 and newer client versions). 
Therefore, DCC will be enabled in your environment unless it has specifically been 
disabled for some other purpose.
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Figure 6-23   Checking whether DCC is enabled on the Notes client

6. The value of the AcceptUpdates field will be either:

– 0: DCC is disabled.

– 1: DCC is enabled.

Checking that DCC is actually running
If DCC is enabled, check that it is actually running on the PC:

1. On the Notes client, open the local log file (log.nsf).

2. Open the Miscellaneous Events view.

3. Open a recent log document and search for “Dynamic”.

4. If DCC is running on the client, you will see log entries similar to those seen in Figure 6-24.

Figure 6-24   Client log.nsf showing DCC has run

If DCC is enabled but not running, or you require further information, refer to Technote 
#1212699 “Frequently Asked Questions About Dynamic Client Configuration (DCC)” at: 

http://www.ibm.com/support/docview.wss?rs=899&uid=swg21212699

How to enable DCC if it is not currently running
To enable DCC if it is not running on a single Notes client:

1. On the Notes client, edit the current Location document by clicking on the Location in the 
Location Status Bar (bottom right corner of the client) and selecting Edit Current....

2. From the menu, select Options → Advanced → Set Update Flag.

Tip: It may be easiest to search for “Dynamic” in the view. DCC usually runs shortly 
after the Notes client is started, but if other background tasks are running or the users 
closes the client almost immediately, DCC may not get a chance to run (or may show 
further down in the log document.

AcceptUpdates
field highlighted

Value of field is “0”,
indicating that DCC
is disabled on this 
client

Fields tab
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3. In the Location Update Settings dialog, select Yes to enable DCC, as shown in 
Figure 6-25.

Figure 6-25   Location Update Settings dialog: select Yes to enable DCC

4. Check the Document Properties to ensure that the AcceptUpdates field is now set to “1”.

Step 2: Change the ITSOsmall domain to ITSObig
The purpose of this procedure is to move the ITSOsmall documents into the ITSObig 
domain’s Domino Directory, and to update the Domain to ITSObig. At the end of this step, the 
ITSOsmall server will be using the ITSObig’s Domino Directory as its primary directory 
(names.nsf), and the server and users will be in the ITSObig domain.

Copy ITSOsmall documents into the ITSObig Domino Directory
To copy the ITSOsmall documents into the ITSObig Domino Directory, the ITSObig Domino 
administrator completed the following steps:

1. On the MailSvr/ITSOsmall server:

a. Open the mail.box file and ensure there is no mail pending. 

b. If there is mail pending, force it to send by typing route <destinationSvrname> at the 
server console.

c. Shut down the router process, by typing tell router quit at the server console.

2. On the HubSvr/ITSObig server, complete the steps in step 1 above.

Note: Choosing this option does not actually tell you what the flag is currently set to 
(that is, you cannot discover whether DCC is already enabled using this procedure). To 
determine whether DCC is already enabled, use the procedure described in “Checking 
that DCC is enabled” on page 156.

Note: If you find that all you users currently have DCC disabled, it may be possible to 
enable it for all users using a PostOpen or similar script on a database that every user 
opens (such as the mail files or bookmark.nsf) to update the AcceptUpdates field. 

For further information and sample code to do this function, refer to Technote 1092794 
“How to use LotusScript to change fields in all Location documents” at:

http://www.ibm.com/support/docview.wss?rs=899&uid=swg21092794

Important: This procedure should be completed outside of normal business hours, after a 
system backup has been performed on both Domino servers. The change should take 
place in an agreed change window that provides enough time for backout if required.
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3. In a Notes client (logged on as the ITSObig administrator), copy all required documents 
from the ITSOsmall Domino Directory to the ITSObig Domino Directory:

a. Open the ITSOsmall Domino Directory, and go to the People view.

b. Select all the Person documents in the view and copy them to the clipboard.

c. Open the ITSObig Domino Directory and go to the People view.

d. Paste the documents into the People view.

e. Go back to the ITSOsmall Domino Directory and go to the Groups view.

f. Select the groups that you wish to copy into the ITSObig Domino Directory, and copy 
those documents to the clipboard.

g. Complete the copy-paste process described above for all Server documents, 
Configurations (except for the * - [Default] Configuration document), Connections, 
Domains (except for the adjacent Domain document for ITSObig), Mail-in Databases, 
and Cross certificates. 

h. In the destination Domino Directory, delete the Adjacent Domain document for the old 
(ITSOsmall) domain.

i. Check through the remaining views (for example, Policies) to determine whether other 
documents need to be copied across in your environment.

4. When all required documents have been copied across, replicate the ITSObig Domino 
Directory between MailSvr/ITSOsmall and HubSvr/ITSObig.

5. Shut down MailSvr/ITSOsmall.

6. On the MailSvr machine, in Windows Explorer (or equivalent):

a. Rename the current Domino Directory (\Domino\Data\names.nsf) file name to 
oldnames.nsf, and move the file outside of the \Domino\Data directory.

b. Rename the ITSObignames.nsf (ITSObig’s Domino Directory) to names.nsf.

7. Restart MailSvr/ITSOsmall, and check the server console during startup for any obvious 
errors.

8. Shut down the router process by typing tell router quit at the MailSvr server console.

Important: Be selective with the groups that are copied across. For example, do not 
choose groups with conflicting names in each directory. Do not copy over the 
standard LocalDomainServers, LocalDomainAdmins, and OtherDomainServers 
groups, as they will cause duplicate group document names in the destination 
Directory. You may need to plan this step prior to completing this process, if there 
are many groups involved.
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Change the Domain from ITSOsmall to ITSObig
To change the Domain from ITSOsmall to ITSObig for the documents that were just copied 
into the Domino Directory, the ITSObig Domino administrator did the following:

1. Update the domain fields in the ITSOsmall documents in the ITSObig Domino Directory. 
Table 6-6 contains a list of the document types and the relevant Domain field name to 
change in each one. These may be used in agents (if there are many documents to 
change) or the documents may be updated manually.

Table 6-6   Domain fields to change to merge one domain into another

2. Shut down the MailSvr Domino server by typing quit at the Domino server console.

3. Open the Domino\notes.ini file on the MailSvr.

4. Search for the Domain= parameter, and update it with the new domain name (that is, 
Domain=ITSObig).

5. Restart the MailSvr/ITSOsmall Domino server.

6. Restart the router on HubSvr/ITSObig by typing load router at the server console.

7. Test sending a mail message from a ITSOsmall user to a ITSObig user, and from an 
ITSObig user to an ITSOsmall user. Ensure that the e-mails are both successfully 
received.

(Optional) If Directory Catalog is in use, reconfigure and rebuild it
If Directory Catalog is in use, additional tasks need to be completed at this point to ensure 
that duplicate, obsolete entries from the old (ITSOsmall) Domino Directory are no longer 
listed in the Directory Catalog. To do this, complete these steps:

1. If the dircat task is configured to run on one of the old domain’s servers, disable the task:

a. Open the Domino Directory on the old domain server.

b. Open the Configuration → Servers → All Server Documents view.

c. Select the Server Document for the server that runs the dircat task and click Edit 
Server.

d. Go to the Server Tasks → Directory Cataloger tab.

e. Delete the entry in the Directory Catalog Filenames field.

f. Set the Schedule field to DISABLED.

g. Save and close the document.

2. Delete the Directory Catalog database from any servers in the old domain that contain a 
replica of it.

3. Update the Directory Catalog Configuration on the new domain (ITSObig):

a. Open the Directory Catalog database on the ITSObig Directory Cataloger server.

Document type Field display name Field name (for use in Agent)

People Domain MailDomain

Groups Mail Domain MailDomain

Servers Domain name Domain

Connections Destination domain
Source domain

DestinationDomain
SourceDomain

Mail-in databases Domain MailDomain
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b. Open the Configuration view.

c. Open the Dircat Configuration document and click Edit Configuration.

d. In the Directories To Include field, find and delete the name of the old domain’s Domino 
Directory (for example, ITSOsmallnames.nsf).

e. Save and close the Dircat Configuration document.

4. Rebuild the Directory Catalog on the new domain (ITSObig) by typing at the server 
console:

load dircat dircat.nsf -r 

where dircat.nsf is the file name for the Directory Catalog to be rebuilt.

5. Replicate the updated Directory Catalog to the old domain (ITSOsmall) servers.

Update the Domain in users’ Location documents
In this part of the procedure, we will create a Desktop Settings document and Policy to 
change the domain in Location documents for ITSOsmall users to ITSObig. This will be done 
by first adding extra fields to the design of the Desktop Settings document to change the 
Domain field in the Location document.

1. Open the Domino Directory in Domino Designer® client and go to the Forms view.

2. Open the Policy Settings\Desktop Settings form.

3. On the Basics tab, add an extra row to table in the Server Settings section.

Tip: If there are users from the old domain who replicate the Directory Catalog and use it 
locally, these users will need to delete the old Directory Catalog, take a new replica of the 
Directory Catalog from the new domain, and update their Preferences to use the new 
Directory Catalog for addressing (if the new file name is different from the old). 

It may be easiest to use Policies (Desktop Settings) to help make these changes, or send a 
button out to the users to automate the procedure.

Restriction: This part of the procedure involves making design changes to the Domino 
Directory system database. It is important to note that making changes to the design of 
system databases is officially unsupported. This means that if you have a problem with this 
database, Support may ask you to return to using the standard template design before 
providing additional help with your issue.
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4. In the extra row, create fields, as shown in Figure 6-26. Note the field names and field 
types. These must be exactly as shown (“LocAll” indicates Location document, “Domain” 
is the field name in the Location document, $IP indicates inherit setting from parent, and 
$PO indicates enforce in child).

Figure 6-26   Creating fields to change the Domain field in Location documents via a Policy

5. Save and close the Desktop Settings form.

6. In the Domino Administrator client, open HubSvr/ITSObig and go to the People & Groups 
tab

7. Open the ITSObig’s Directory → Settings view and click Add settings → Desktop to 
create a new Desktop Settings document.

8. On the Basics tab, in the Name field, type “ChangeDomain” (without the quotes).

9. Page down to the Server Settings section and find the Mail Domain row you created in 
Step 4.

10.Fill in the name of the new mail domain you want to push out to users (ITSObig), as shown 
in Figure 6-27.

Figure 6-27   Mail Domain field in Desktop Settings document

11.Save and close the Desktop Settings document.

12.Go to the Configuration → Policies view.

13.Click Add Policy.

14.In the Policy name field, fill in the Organization name (ITSOsmall). Change the Policy type 
to Organizational.

15.In the Desktop Setting field, select the Desktop Settings document (ChangeDomain).

New row
Label for
the row Text field 

“LocAllDomain”
Checkbox field
“LocAllDomain$IP”

Checkbox field
“LocAllDomain$PO”
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16.Save and close the Policy document. The completed document is shown in Figure 6-28 on 
page 163.

Figure 6-28   Policy document to change Domain in Location documents

17.Replicate the Domino Directory between MailSvr/ITSOsmall and HubSvr/ITSObig.

The next time the ITSOsmall users authenticate with their Home/mail server, all Location 
documents that have DCC enabled in the local Address Book (names.nsf) will be updated 
with the new domain name.

Step 3: Create a cluster for the servers
In this procedure, we will create a cluster for MailSvr/ITSOsmall and HubSvr/ITSObig. 

The purpose of this procedure is so that when the /ITSOsmall server is renamed into the 
/ITSObig certifier, users can fail over to the HubSvr, have DCC update the Home/Mail server 
name in their Location documents, and then they will fail over to the new server name.

To create the cluster:

1. In the Domino Administrator client, open HubSvr/ITSObig.

2. Go to the Configuration tab and select the Server → All Server Documents view.

3. In the view, select the servers to include in the new cluster: HubSvr/ITSObig and 
MailSvr/ITSOsmall.

Tip: After completing the above procedures, allow some time (perhaps a couple of weeks) 
for users to log in and update their domain, before going on to the remainder of the Domain 
merge. 

Organizations who do not want to change the Organizational Certifier of the users they 
have merged (that is, /ITSOsmall) may choose to stop after the above steps are 
completed. The remainder of this scenario describes the procedure for recertifying users 
into the new Organizational Certifier (/ITSObig).
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4. Click the Add to Cluster button, and then Yes to continue.

5. In the Cluster Name dialog, click OK to create a new cluster.

Figure 6-29   Create new cluster dialog

6. Type in the name of the new cluster, DomainMerge, and then click OK.

Figure 6-30   Typing a name for the new cluster

7. Select Yes to create the cluster immediately, then OK to the Request Successful dialog.

8. Replicate the names.nsf and admin4.nsf between MailSvr and HubSvr.

Step 4: Rename the Domino server and add it to the cluster
This is the second part of the renaming and cluster failover procedure. The purpose of this 
part of the procedure is to create the new identity for the ITSOsmall server and update the 
cluster so that Notes clients can find their mail server at its new identity.

In this procedure, we will do the following tasks:

� Create a new server ID for the MailSvr using the /ITSObig certifier.

� Swap to the new server ID on the server.

� Add the new server to the DomainMerge cluster.

� Update the Domino Directory documents to reflect the server’s new identity.

� Update the Home/mail server field in the users’ Location documents.

� Update the user mail file ACLs with new server name.

Important: After this procedure has been completed, wait for some time (perhaps a couple 
of weeks) to ensure that users have authenticated with their home server. This is required 
for the Notes client to be aware of the new cluster. At first authentication after the new 
cluster has been created, cluster information will be cached on the Notes client. At the next 
Notes client exit, this information will be written to a cluster.ncf file created on the 
workstation in the notes\data directory. This file contains the information required for the 
Notes client to fail over to cluster member servers in the event of a home server outage.

Important: This procedure should be completed outside of normal business hours, after a 
system backup has been performed on both Domino servers. The change should take 
place in an agreed change window that provides enough time for backout if required.
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Create a new server ID for the MailSvr using the /ITSObig certifier

To create the new server ID, the ITSObig Domino administrator did the following:

1. In the Domino Administrator client, open the HubSvr/ITSObig server.

2. Go to the Configuration tab, and in the Tools panel, select Registration → Server.

3. In the Choose a Certifier dialog, select the Registration Server and Organizational 
Certifier ID (for ITSObig), as shown in Figure 6-31.

Figure 6-31   Choose a certifier dialog

4. Enter the certifier password.

5. In the Register Servers dialog, check that the Registration server (HubSvr/ITSObig) and 
certifier (/ITSObig) are correct, then click Continue.

6. In the Register New Server(s) dialog, fill in the Server name for the new server, and select 
to store the ID file in a file, as shown in Figure 6-32.

Figure 6-32   Register new server(s) dialog

7. Click Register to create the new server, and then Done to close the dialog box.

Important: Prior to completing this step, it is important to have a new IP address available 
for the new server identity. If you keep the old IP address for the new identity, this 
procedure will not work, as users will not be able to fail over to the HubSvr server.

Request a new IP address from your Network Administration team, and ensure that they 
update the DNS and other relevant configurations for your organization before you 
complete the steps below.
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8. Update the Server document for the new server:

a. While still in the Domino Administrator client, on the Configuration tab, select the 
NewMail/ITSObig Server document and click Edit Server.

b. On the Basics tab, fill in the Full Qualified Internet host name field with the host name 
of the server.

c. On the Security tab, fill in the required security settings for your organization, for 
example, fill in the Create new databases & templates field and the Create new 
replicas field with “LocalDomainServers” and “LocalDomainAdmins”.

d. On the Ports tab, fill in the Port, Notes Network, and Net address details for the new 
server, and change the port to Enabled, as shown in the example in Figure 6-33.

Figure 6-33   Port details in Server document for new server

e. Save and close the Server document.

Swap to the new server ID on the server
Prior to completing this procedure, analyze the databases on the server to search for 
hardcoded server references. Have the developer of the database update the code to remove 
the hardcoded server references (or update them for the new server). Also, make a list of 
agents that are currently set to run on the current server name (MailSvr/ITSOsmall). This 
includes Out Of Office Agents in users’ mail files.

To swap the old MailSvr/ITSOsmall to its new identity, NewSvr/ITSObig, the ITSObig 
Administrator completed these steps:

1. Shut down the MailSvr server by typing quit at the server console.

2. In Windows Explorer (or equivalent):

a. Copy the ID file for the new server from the location you saved it (on the Domino 
Administrator client workstation’s file system) into the Domino\Data directory on the 
MailSvr machine.

b. Copy admin4.nsf file from the Domino\Data directory on the HubSvr to the same 
location on the MailSvr.

3. Open the Domino\notes.ini file on the MailSvr.

4. Search for the KeyFileName parameter and ServerKeyFileName parameter, and update 
the lines to the new ID file name, as shown in Figure 6-34 on page 167.

Attention: It is beyond the scope of this Redpaper to describe full database testing that 
may be required for a Domain merge and Organizational recertification. Be aware that 
each custom database in your Domino environment may have specific testing and 
validation requirements. Work with your Domino Application Development team to develop 
and implement a full test plan for business critical applications.
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Figure 6-34   Changing Server ID file name in notes.ini

5. Save and close the notes.ini file.

6. Change the IP address for the server, in the operating system’s network configuration (or 
have your Network or Server Administrator complete this step).

7. Start the Domino server. Check the Title Bar of the server console to ensure that the new 
server name is shown (NewMail/ITSObig). Check the console messages for any obvious 
errors.

Add the new server to the DomainMerge cluster
To add the NewMail server to the existing DomainMerge cluster, the ITSObig Domino 
administrator did the following:

1. In the Domino Administrator client, go to the Configuration tab.

2. Go to the Server → All Server Documents view.

3. Select the NewMail server in the view, then select Add to Cluster.

4. Select Yes to continue, then in the Cluster name dialog, select the DomainMerge cluster, 
as shown in Figure 6-35.

Figure 6-35   Adding new server to existing cluster

5. Click OK and then Yes to update the cluster immediately.

6. Delete or disable any Connection documents with the old server listed 
(MailSvr/ITSOsmall).

7. Delete the Server document for the old server (MailSvr/ITSOsmall).

8. Create a Connection document for scheduled replication between the two clustered 
servers: NewMail/ITSObig and HubSvr/ITSObig.

9. Open the Cluster Directory database (cldbdir.nsf) and ensure that the NewMail server’s 
databases have been added (use the Databases by Server view).

Update the Domino Directory documents to reflect the server’s new identity
In this part of the procedure, Domino Directory documents pointing to the old server name are 
updated to the new server name (NewMail/ITSObig).

To do this procedure:

Update the Server name fields in Domino Directory documents that point to the old server 
name (MailSvr/ITSOsmall), so they point to the new server name (NewMail/ITSObig). 
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Table 6-7 contains a list of the document types and the relevant Server Name field to change 
in each. These may be used in agents (if there are many documents to change) or the 
documents may be updated manually.

Table 6-7   Server name fields to change in the Domino Directory to reflect the server’s new identity

Figure 6-36   Agent to change MailServer field in Person documents

Update the Home/mail server field in the users’ Location documents
In this part of the procedure, we will update the Desktop Settings document created in the 
“Update the Domain in users’ Location documents” on page 161 to change the Home/mail 
server field to “NewMail/ITSObig” in users’ Location documents. This will be done by first 
adding extra fields to the design of the Desktop Settings document to change the Home/mail 
server field in the Location document.

1. Open the Domino Directory in Domino Designer client and go to the Forms view.

2. Open the Policy Settings\Desktop Settings form.

3. On the Basics tab, add an extra row to table in the Server Settings section.

Document type Field display name Field name (for use in Agent)

People Mail server MailServer

Configurations Group or Server name ServerName

Connections Destination Server
Source Server

Destination
Source

Programs Server to run on Source

Mail-in Databases Server MailServer

Important: If there are many of one document type to update, you may choose to write a 
simple agent to change them all. If you do this, make sure that the new value is the full 
hierarchical name of the server (that is, CN=<CommonName>/O=<OrgName>).

The agent could use the Simple Action “Modify Field” to replace the server name field on 
selected documents. A sample of such an agent (showing the MailServer field change in 
Person documents) is shown in Figure 6-36. 

Restriction: This part of the procedure involves making design changes to the Domino 
Directory system database. It is important to note that making changes to the design of 
system databases is officially unsupported. This means that if you have a problem with this 
database, Support may ask you to return to using the standard template design before 
providing additional help with your issue.
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4. In the extra row, create fields, as shown in Figure 6-37. Note the field names and field 
types. These must be exactly as shown (“LocAll” indicates Location document, 
“MailServer” is the field name in the Location document, $IP indicates inherit setting from 
parent, and $PO indicates enforce in child).

Figure 6-37   Creating fields to change the Home/mail Server field in Location documents via a Policy

5. Save and close the Desktop Settings form.

6. In the Domino Administrator client, open HubSvr/ITSObig and go to the People & Groups 
tab.

7. Open the ITSObig’s Directory → Settings view.

8. Select the ChangeDomain Desktop Settings document in the view, and click Edit 
Settings.

9. On the Basics tab, page down to the Server Settings section and find the Mail Server row 
you created in Step 4.

10.Fill in the name of the new mail server you want to push out to users (NewMail/ITSObig), 
as shown in Figure 6-38.

Figure 6-38   Home/mail server field in Desktop Settings document

11.Save and close the Desktop Settings document.

New row
Label for
the row Text field 

“LocAllMailServer”
Checkbox field
“LocAllMailServer$IP”

Checkbox field
“LocAllMailServer$PO”
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Update the user mail file ACLs with new server name
This part of the procedure adds the new mail server as the Administration Server of the 
ITSOsmall users’ mail files. 

In the Domino Administrator client:

1. Open the mail server for the users (NewMail/ITSObig).

2. Go to the Files tab and open the \mail subdirectory.

3. Highlight all the mail files in the view.

4. In the Tools panel, select Database → Manage ACL.

5. In the Manage Multiple ACLs dialog, go to the Advanced tab.

6. Select the check box for the Modify Administration Server setting.

7. In the Server field, select or type in the name of the new server (NewMail/ITSObig), as 
shown in Figure 6-39.

Figure 6-39   Adding the new mail server to mail file ACLs

8. Click OK.

Step 5: Ensure that users can connect to the new server name
When users next open their Notes client and click their mail icon on the old mail server, the 
following changes will occur in the background of the Notes client:

� The Notes client will search for the user’s old mail server, as specified in the Home/mail 
field of their Location document.

� The Notes client will be unable to connect to the old server, and will check the cluster.ncf 
file to find other cluster members.

� The Notes client will find the HubSvr/ITSObig server and connect to it.

� The Notes client will check the Cluster Directory database for alternative locations for their 
mail file, find it on the NewMail/ITSObig server, and open that replica.

� Dynamic Client Configuration (DCC) will run, and will copy down the updated 
ChangeDomain Desktop Settings document to the local Address Book (names.nsf).

� The Home/mail server field in Location documents will be updated from the Desktop 
Settings document with the NewMail/ITSObig mail server.

� Thereafter, whenever the user opens their mail file, it will open the replica on the NewMail 
server (because this is the one now specified in the Location document).

Tip: If there are other non-mail databases on the server, we recommend that the above 
procedure by completed for those databases as well. This will add the new server name to 
the ACL of those databases, and also set the new server as the Administration Server for 
each database, allowing any future Administration Requests affecting the databases to be 
processed by the new server.
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� When the user next exits the Notes client, the cluster.ncf file will be updated with the 
NewMail/ITSObig server details. 

To check whether this process has occurred, on the Notes client, check any or all of the 
following:

� The Log file (log.nsf) shows the mail file fail over and the DCC updates, as shown in 
Figure 6-40.

Figure 6-40   Checking in the local log.nsf that the user has successfully failed over to the new server identity

� The Location documents have been updated to the new value for the Home/mail server 
field.

� If you hover with the mouse pointer over the mail file icon on the Bookmark bar, the status 
bar at the bottom of the client indicates that the mail is on the new server: “Mail is on 
NewMail/ITSObig”.

� The notes\data\cluster.ncf file has the new server name listed (after you have exited the 
Notes client).

Step 6: Rename the users with the ITSObig certifier
Before starting this procedure, ensure you have these prerequisites items:

� The Certifier ID files and passwords for the old and new certifier.

� The Certifier document for the old certifier copied into the new domain’s Domino Directory 
(that is, in our example, the Certifier document for /ITSOsmall has been copied into the 
ITSObig domain’s Domino Directory).

To rename the ITSOsmall users with the ITSObig certifier, the ITSObig Domino administrator 
did the following:

1. In the Domino Administrator client, open HubSvr/ITSObig and go to the People & Groups 
tab.

2. Open the ITSObig’s Directory → People view

3. In the view, select the users that you want to rename.

4. From the Tools panel, select Rename.

5. In the Rename Selected Notes People dialog, click Request Move to New Certifier.

6. In the Choose a Certifier dialog:

a. Click Server to change the server to HubSvr/ITSObig.

b. Click Certifier ID to select the location of the current certifier (that is, the /ITSOsmall 
Certifier ID).

c. Click OK to continue.

7. Enter the Certifier ID password and click OK.

Fail over of mail
DCC copying the updated

Policy applying the new

Desktop Settings document

Home/mail server field
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8. In the Request Move for Selected People dialog, select the new certifier (/ITSObig) from 
the drop-down list, then OK to complete the move.

9. Open the Administration Requests database on HubSvr/ITSObig, and go to the Requests 
→ Name Move requests view.

10.In the view, select the names you just processed.

11.Click Complete Move for the selected entries.

12.In the Choose a Certifier dialog:

a. Check that the correct server (HubSvr) is selected.

b. Click Certifier ID to select the location of the new certifier (that is, the /ITSObig 
Certifier ID).

c. Click OK to continue.

13.Enter the Certifier ID password and click OK.

14.In the Certificate Expiration Date dialog, accept or change the new expiration date, then 
click OK to complete.

Step 7: Validate the changes
It is important to validate that all users, mail files, application databases, and other documents 
have been correctly migrated to the new domain and certifier prior to closing off the Domain 
Merge project. 

Tip: The move is completed by the Administration Process (adminP), so some parts of the 
request will not occur instantly. To check the progress of the rename, open the 
Administration Requests database and check the person’s name in the Requests → All 
Requests by Name view.

In the Notes client 6.x and later, name changes are automatically accepted without 
prompting the user, unless this option has been changed by the individual user in their 
Notes client.

For further information about the rename process described above, refer to the topic 
“Moving a user name in the name hierarchy” in the Domino Administrator 7 Help database.
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To validate that the domain merge is complete, the ITSObig Domino Administrator used the 
simple checklist shown in Table 6-8.

Table 6-8   Checklist for Domain Merge project closure

Area to check Comments Complete (tick)

Domino Directory Check the following documents:
� People: Check the People 

→ By Organization view to 
check for anyone still using 
the /ITSOsmall certifier. 
These people may have 
been missed in the move, 
may not have logged on 
since the rename was 
initiated, or there may by an 
adminP error with the 
move.

� Check these other views to 
ensure that all documents 
are pointing to the new 
server and domain name: 
Groups, Configurations, 
Connections, Programs, 
and Mail-in Databases.

� Check all views to ensure 
documents are all still valid 
and required. Delete any 
obsolete documents.

Administration Requests 
database

Check the Administration 
Request documents for Name 
move requests. Ensure that no 
errors show for the users who 
have been renamed to the 
/ITSObig certifier.

Help desk records Check for recurring problems 
logged by users to your 
organization’s help desk. Meet 
with the Help Desk Manager to 
discuss any outstanding issues 
they are aware of.
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Related publications

The publications listed in this section are considered particularly suitable for a more detailed 
discussion of the topics covered in this Redpaper.

IBM Redbooks
For information about ordering these publications, see “How to get IBM Redbooks” on 
page 175. Note that some of the documents referenced here may be available in softcopy 
only. 

� Domino 7 Performance Tuning: Best Practices to Get the Most Out of Your Domino 
Infrastructure, REDP-4182

� Domino for IBM eServer xSeries and BladeCenter Sizing and Performance Tuning, 
REDP-3851

� Lotus Domino for S/390 Release 5: Performance Tuning and Capacity Planning, 
SG24-5149

Online resources
These Web sites and URLs are also relevant as further information sources:

� Lotus Notes and Domino white papers

http://www-10.lotus.com/ldd/notesua.nsf/White%20Papers?OpenView

� Lotus Documentation and Release Notes

http://www-10.lotus.com/ldd/notesua.nsf/RN?OpenView

� Domino performance

http://www-128.ibm.com/developerworks/lotus/performance/

How to get IBM Redbooks
You can search for, view, or download Redbooks, Redpapers, Hints and Tips, draft 
publications and Additional materials, as well as order hardcopy Redbooks or CD-ROMs, at 
this Web site: 

ibm.com/redbooks

Help from IBM
IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
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the Total Cost of Ownership (TCO). For many companies however, the key issue 
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